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1 What�s New in This Release
What�s New in Siebel Analytics Web Administration Guide, Version 
7.7.1, Rev. B
Table 2 lists changes described in this version of the documentation to support release 7.7.1 of the 
software. 

NOTE: Siebel Analytics Web, Version 7.7.1, is compatible with Siebel operational applications, 
Version 7.7.

Table 1. New Product Features in Siebel Analytics Web Administration Guide, Version 7.7.1, Rev. B

Topic Description

Using the SA System subject area 
with Siebel Delivers

See �About the SA System Subject 
Area and Scheduling iBot Deliveries� 
on page 48

New topic, for users of Siebel Analytics operational 
applications and the SA System subject area. It explains why 
iBot content cannot be delivered to users that are defined 
only in the Siebel Analytics repository.

SOAP API for extracting and 
delivering results from Siebel 
Analytics Web and managing 
content in the Web Catalog

See Chapter 10, �Working with Data 
and Managing the Web Catalog 
Using Siebel Analytics Web SOAP 
API�

Updated this chapter to add more information about 
structures, classes, methods, and fields.
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What�s New in This Release ■  
What�s New in Siebel Analytics Web Administration Guide, Version 
7.7.1, Rev. A
Table 2 lists changes described in this version of the documentation to support release 7.7.1 of the 
software. 

NOTE: Siebel Analytics Web, Version 7.7.1, is compatible with Siebel operational applications, 
Version 7.7.

Table 2. New Product Features in Siebel Analytics Web Administration Guide, Version 7.7.1, Rev. A

Topic Description

Configuration settings for the 
PopChart Image Server

�Managing Settings for the Siebel 
Analytics Web Chart Image Server� 
on page 34

New settings are available to specify the download source 
when Flash is used as the default image type. 

Making folders in the selection 
pane appear as though they are 
nested

�Nesting Folders in the Selection 
Pane in Siebel Answers� on page 41

To make selections easy for users to discern in the selection 
pane, you can set up the presentation layer in the Siebel 
Analytics Server Administration Tool to give the appearance 
of nested folders.

Setting permissions for Siebel 
Delivers and iBots

�About Permission Settings for 
Siebel Delivers and iBots� on 
page 47

This topic clarifies the iBot object permission settings that 
users need to have when they are granted access to the 
Publish for Subscription privilege.

Creating a drop-down list from 
which users can select dashboards

�Setting the Number of Siebel 
Intelligence Dashboard Names to 
Appear on a Screen� on page 53

When there are more than 15 dashboard names to display, 
Siebel Analytics creates a drop-down list from which users 
can choose the dashboard to view. A new setting is available 
that allows you to specify how many dashboard names to 
display before a drop-down list is created.

Setting options for the Download 
link that appears with requests

�Downloading Siebel Analytics 
Results in Non-UNICODE Format� 
on page 54

By default, the Download Data option downloads results in a 
UNICODE, tab-separated text file. For organizations that 
require a non-UNICODE, comma-separated file for use with 
certain applications, you can override behavior of the 
Download Data option or add another download option.
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What�s New in This Release ■
What�s New in Siebel Analytics Web Administration Guide, Version 
7.7.1
Table 3 lists changes described in this version of the documentation to support release 7.7.1 of the 
software. 

NOTE: Siebel Analytics Web, Version 7.7.1, is compatible with Siebel operational applications, 
Version 7.7.

Table 3. New Product Features in Siebel Analytics Web Administration Guide, Version 7.7.1

Topic Description

Siebel Delivers integration with 
Siebel Workflow7.7

See �Integrating Siebel Delivers 
with Siebel Workflow 7.7� on 
page 46

This new feature lets you use Advanced tab in Siebel Delivers 
to set up iBots to trigger workflows in the Siebel Workflow 7.7 
application. 

Option to set the number of Siebel 
Analytics Briefing Book links that 
users can follow

See �Setting the Number of Siebel 
Analytics Briefing Book Links to 
Follow� on page 53

You can modify the Windows registry or the Siebel Analytics 
Web configuration file instanceconfig.xml to set the number 
of Siebel Analytics Web Briefing Book links that users can 
follow.

Updated procedure to localize Web 
Catalog text strings

See �Localizing Siebel Analytics 
Web Catalog Text Strings� on 
page 74

The procedure to export text strings for translation and then 
expose them when translation is complete has changed in 
Version 7.7.1.

Use of Analytics Catalog Manager 
to rename items in the Web 
Catalog

See �Using Analytics Catalog 
Manager to Rename Items in the 
Siebel Analytics Web Catalog� on 
page 77

You can use Analytics Catalog Manager to rename items in 
the Web Catalog. This can be useful when you are migrating 
from a development environment to a production 
environment.
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What�s New in This Release ■  
SOAP API available for extracting 
results from Siebel Analytics Web 
and managing content in the Web 
Catalog

See Chapter 10, �Working with Data 
and Managing the Web Catalog 
Using Siebel Analytics Web SOAP 
API�

The Siebel Analytics Web SOAP API allows J2EE and .NET 
external applications to use Siebel Analytics as an analytical 
calculation and data integration engine. It provides a set of 
Web services that allow external applications to communicate 
with the Analytics Web Server. 

Removed the chapter Siebel 
Analytics Third-Party SQL Tool 
Integration Example�

The content that was in Chapter 10 was moved into Chapter 
9 �Using the Siebel Analytics Web Integration API.�

Table 3. New Product Features in Siebel Analytics Web Administration Guide, Version 7.7.1

Topic Description
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2 Administering Siebel Analytics 
Web
This chapter provides general post-installation configuration and administration procedures that are 
not specific to Siebel Answers, Siebel Delivers, Siebel Intelligence Dashboards, or Siebel Analytics 
Web Catalog. Directions for configuring these components of Siebel Analytics Web are given in 
subsequent chapters.

This chapter contains the following topics:

■ �Making Siebel Analytics Web Configuration Changes� on page 14

■ �Changing the Siebel Analytics Web ODBC DSN� on page 17

■ �Setting the Siebel Analytics Web Configuration File Path� on page 17

■ �Disabling the Siebel Analytics Web Feature to Remember Users� Names and Passwords� on page 18

■ �Setting the Time to Expire for Siebel Analytics Web Client Connections� on page 19

■ �Administering Sessions in Siebel Analytics Web� on page 19

■ �Setting the Time to Keep an Unsaved Siebel Analytics Request� on page 22

■ �Setting the Time to Cancel an Unattended Siebel Analytics Request� on page 23

■ �Setting the Time to Log Users Off Siebel Analytics Web Automatically� on page 23

■ �Managing the Siebel Analytics Web Cache Settings� on page 24

■ �Configuring the Siebel Analytics Web Cookie Domain� on page 26

■ �Configuring the Siebel Analytics Web Cookie Domain� on page 26

■ �Managing Siebel Analytics Web URL Generation and Resource File Location� on page 27

■ �Specifying the Default Language for the Siebel Analytics Web Login Screen� on page 31
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Administering Siebel Analytics Web ■  Making Siebel Analytics Web Configuration 
Changes
Making Siebel Analytics Web 
Configuration Changes
This section provides procedures for making configuration changes in Windows and UNIX 
environments. You need to make changes only if you want to change default parameters, such as 
the name of the Siebel Analytics Web Catalog, or override internal default settings, such as the time 
for client connections to expire.

You can make configuration changes by modifying the Windows registry or the Siebel Analytics Web 
XML message file instanceconfig.xml:

■ Sites running Siebel Analytics Web under UNIX must modify instanceconfig.xml.

■ Sites running Siebel Analytics Web under Windows can modify either the Windows registry or 
instanceconfig.xml.

NOTE: In Windows, Siebel Analytics Web reads the file instanceconfig.xml first and then reads the 
Windows registry. Entries you make in the file instanceconfig.xml override equivalent entries in the 
Windows registry. If you made entries in the Windows registry for a previous version of Siebel 
Analytics Web, those entries continue to function unless you override them in the file 
instanceconfig.xml.

For information about working in the Windows registry, see �Making Siebel Analytics Web Configuration 
Changes in the Windows Registry.�

For information about working in the file instanceconfig.xml, see �Making Siebel Analytics Web 
Configuration Changes in the Configuration File instanceconfig.xml� on page 16.

Making Siebel Analytics Web Configuration Changes in 
the Windows Registry
For sites running Siebel Analytics Web under Windows, the Windows registry contains information 
about the configuration of a computer, including the settings of programs installed on it. The 
operating system continually references the registry while the machine is running.

Several Siebel Analytics Web registry entries are created during the installation process. You can 
customize Siebel Analytics Web by modifying these entries and adding new entries to override 
internal default settings.

CAUTION: Use extreme care when you modify the registry. Always back up the entire registry, or 
the registry keys that you plan to work on, before you make any changes.

To start the Windows Registry Editor

1 From the Start Menu, select Run.

2 In the text box, type regedit.

3 Navigate to the registry entries for Siebel Analytics:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics
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Administering Siebel Analytics Web ■  Making Siebel Analytics Web Configuration
Changes
4 In the right pane, right-click and select New, and then select the appropriate key or value.

You can make your changes using the keys and values given elsewhere in this chapter.

NOTE: Enter data values as string values. The type should be REG_SZ.

5 Exit the registry editor.

Your changes take effect when the Analytics Web Server service is restarted.

Figure 1 shows several registry keys for Siebel Analytics in the left pane of the Windows Registry 
Editor.

In this book, the registry keys and entries for Siebel Analytics Web are described as the path to the 
key followed by the entry name. The example key in Figure 1 is for version 7.5, which has three 
values:

■ Default, the entry for the key itself.

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5

(Default) (value not set)

■ CatalogPath, the path for the Siebel Analytics Web Catalog.

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5

CatalogPath D:\SiebelAnalyticsData\Web\Catalog\default.webcat

■ DSN, the name of the Siebel Analytics Server data source name used by Siebel Analytics Web to 
access Siebel Analytics Server.

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Systems, Inc.\Siebel 
Analytics\Web\7.5

DSN Analytics Web

NOTE: Make sure that you work with the keys that apply to the currently installed version.

Figure 1. Example Registry Keys and Entries Created During Installation
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Administering Siebel Analytics Web ■  Making Siebel Analytics Web Configuration 
Changes
Making Siebel Analytics Web Configuration Changes in 
the Configuration File instanceconfig.xml
The file instanceconfig.xml is used to hold configuration settings for Siebel Analytics Web. If you run 
Siebel Analytics Web under Windows or UNIX, you can customize Siebel Analytics Web by modifying 
these entries and adding new entries to override internal default settings.

NOTE: For general background information about customizing the Siebel Analytics Web XML files, 
see �Customizing the Siebel Analytics Web User Interface Using XML Message Files� on page 113.

To make changes to the configuration file instanceconfig.xml

1 Navigate to Siebel Analytics data directory at the following location:

\SiebelAnalyticsData\Web\Config

CAUTION: Always make a backup copy of the file instanceconfig.xml before you make any 
changes.

2 Locate the file instanceconfig.xml and make a backup copy.

3 Use a text editor to open the file instanceconfig.xml.

4 Place your entries between the tags <ServerInstance> and </ServerInstance>, using the values 
given elsewhere in this chapter.

5 Save the file when you are done.

Your changes take effect when the Analytics Web Server service is restarted.

The following is an example instanceconfig.xml file.

<?xml version="1.0" ?>
<!-- Siebel Analytics Web Configuration File -->
<!-- The following example shows initialization settings for a server instance. -->

<WebConfig>
<ServerInstance>

<CatalogPath>/SiebelAnalyticsData/web/catalog/default.webcat<CatalogPath>
<DSN>AnalyticsWeb</DSN>

</ServerInstance>
</WebConfig>

Several entries are present in the file instanceconfig.xml by default, including the path to the Siebel 
Analytics Web Catalog, and the name of the Siebel Analytics Server data source name used by Siebel 
Analytics Web to access Siebel Analytics Server. 
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Administering Siebel Analytics Web ■  Changing the Siebel Analytics Web ODBC DSN
For example, the path to the Siebel Analytics Web Catalog is shown between the <CatalogPath> and 
</CatalogPath> tags.

■ In Windows, an example path might be the following:

<CatalogPath>c:\SiebelAnalyticsData\Web\Catalog\default.webcat</CatalogPath>

■ In UNIX, an example path might be the following:

<CatalogPath>/usr/local/SiebelAnalyticsData/web/catalog/default.webcat</CatalogPath>

Changing the Siebel Analytics Web ODBC 
DSN
Siebel Analytics Web accesses a Siebel Analytics Server repository with a single Siebel Analytics 
Server data source name (DSN). The installation process configures a DSN named Analytics Web for 
this purpose. For information on configuring a new or existing DSN, see Siebel Analytics Server 
Administration Guide.

If you change the name of the DSN, you need to update the Windows registry or the Siebel Analytics 
Web configuration file instanceconfig.xml to use the new name.

Siebel Answers must use a single DSN.

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

DSN Analytics Web Production

■ instanceconfig.xml example:

<DSN>Analytics Web Production</DSN>

Setting the Siebel Analytics Web 
Configuration File Path
You can override the path that Siebel Analytics Web searches for configuration files upon startup. 
The internal default location is $(DataDir)\Web\Config, where $(DataDir) is the resolved entry of one 
of the following specifications:

■ In Windows:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel 
Analytics\Common\7.7\DataDir

■ In UNIX, this is configured by an environment variable defined in initialization scripts. For more 
information, see Siebel Analytics Installation and Configuration Guide.
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Administering Siebel Analytics Web ■  Disabling the Siebel Analytics Web Feature to 
Remember Users� Names and Passwords
Siebel Analytics Web must have read permission to this path. The default data directory is 
SiebelAnalyticsData.

You can override the internal default by adding the following entry to the Windows registry or the 
Siebel Analytics Web configuration file instanceconfig.xml.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web

ConfigDir SiebelAnalyticsTest

■ instanceconfig.xml example:

<ConfigDir>SiebelAnalyticsTest</ConfigDir>

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

Disabling the Siebel Analytics Web 
Feature to Remember Users� Names and 
Passwords
By default, users are asked if they want to have their user names and passwords remembered when 
logging on to Siebel Analytics Web. You can disable this by modifying the Windows registry or the 
Siebel Analytics Web configuration file instanceconfig.xml to add the following entry. When the value 
is set to No, users always have to type their user names and passwords.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

AllowRememberPassword �No�

■ instanceconfig.xml example:

<AllowRememberPassword>No</AllowRememberPassword>

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.
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Administering Siebel Analytics Web ■  Setting the Time to Expire for Siebel Analytics Web
Client Connections
Setting the Time to Expire for Siebel 
Analytics Web Client Connections
You can override the number of minutes to elapse before Siebel Analytics Web client sessions are 
closed by modifying the Windows registry or the Siebel Analytics Web configuration file 
instanceconfig.xml to add the following entry. The internal default is 3.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

ConnectionExpireMinutes �3�

■ instanceconfig.xml example:

<ConnectionExpireMinutes>3</ConnectionExpireMinutes>

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

Administering Sessions in Siebel 
Analytics Web
To perform session administration, you must have the Manage Sessions privilege. For more 
information, see �Default Siebel Analytics Web Privilege Assignments� on page 100.

To view information about logged on users and running requests

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.
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2 Click the Manage Sessions link.

The Sessions table of the Sessions area gives information about users who are logged on, 
including the unique Session ID which is based on the IP address of the connected computer.

The Cursor Cache table shows the status of requests made by users.

To cancel all running requests

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the Manage Sessions link.

3 Click the Cancel Running Requests link.

4 Click Finished.

Field Description

User The name of the user who ran the request and last placed it into the cache. If 
two IDs are shown, the second ID is impersonating the first. For example, the 
entry lhurley/administrator means that the Administrator account logged on 
and impersonated lhurley. This can happen when the Scheduler starts an iBot 
on someone's behalf. The Scheduler logs on and impersonates that user so 
security and content filters still apply.

Refs The number of references to this entry since it was placed into the cache.

Status The status of the request using this cache entry.

■ Running. The request is currently running. 

■ Finished. The request has finished. 

■ Queued. The system is waiting for a thread to become available so the 
request can be processed.

■ Canceling. The system is in the process of canceling the request. 

■ Error. An error was encountered during the processing or running of the 
request. Look in the Statement column for information about the error.

Time The time taken to process and run the request, displayed in one second 
increments. A value of 0s (zero seconds) indicates that the request took under 
1 second to complete.

Statement The SQL issued for the request, or if the request resulted in an error, 
information about the nature of the error.
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To cancel one running request

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the Manage Sessions link.

3 In the Cursor Cache table, identify the request and click the Cancel link in the Action column.

The user receives a message indicating that the request was canceled by a Siebel administrator.

To clear the Web cache

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the Manage Sessions link.

3 In the Cursor Cache table, identify the request and click the link Close All Cursors.

4 Click Finished.

To clear the cache entry associated with a request

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the Manage Sessions link.

3 In the Cursor Cache table, identify the request and click the Close link in the Action column.

To view the query file for information about a request

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the Manage Sessions link.

3 In the Cursor Cache table, identify the request and click the View Log link.

NOTE: Query logging must be turned on for data to be saved in this log file. For more information 
about query logging, see Siebel Analytics Server Administration Guide.
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Setting the Time to Expire for Siebel Analytics Web Client Sessions
You can override the number of minutes to elapse before browser client sessions are removed by 
modifying the Windows registry or the Siebel Analytics Web configuration file instanceconfig.xml to 
add the following entry. The internal default is 1440 (24 hours).

NOTE: The value must be greater than or equal to the value specified for the setting 
SearchIDExpireMinutes, described in �Setting the Time to Keep an Unsaved Siebel Analytics Request� 
on page 22.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

ClientSessionExpireMinutes �1440�

■ instanceconfig.xml example:

<ClientSessionExpireMinutes>1440</ClientSessionExpireMinutes>

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

Setting the Time to Keep an Unsaved 
Siebel Analytics Request
You can override the time, in minutes, that an unsaved request remains valid by modifying the 
Windows registry or the Siebel Analytics Web configuration file instanceconfig.xml to add the 
following entry. This entry applies to unsaved requests only. The internal default is 180 (three hours).

NOTE: The value must be less than or equal to the value specified for the setting 
ClientSessionExpireMinutes, described in �Setting the Time to Expire for Siebel Analytics Web Client 
Sessions� on page 22.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

SearchIDExpireMinutes �180�

■ instanceconfig.xml example:

<SearchIDExpireMinutes>1440</SearchIDExpireMinutes>

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.
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Setting the Time to Cancel an 
Unattended Siebel Analytics Request
You can override the time to elapse, in minutes, before an unattended request is cancelled by 
modifying the Windows registry or the Siebel Analytics Web configuration file instanceconfig.xml to 
add the following entry. An unattended request is one that has not been accessed in the number of 
minutes specified by this setting. The internal default is 5. The minimum value is 2.

This handles the case where a user is at the Request screen in Siebel Answers and browses 
elsewhere, abandoning the request, at least temporarily. Do not set the value too small, however, as 
the user may return to the request.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

UnaccessedRunningTimeoutMinutes �5�

■ instanceconfig.xml example:

<UnaccessedRunningTimeoutMinutes>5</UnaccessedRunningTimeoutMinutes>

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

Setting the Time to Log Users Off Siebel 
Analytics Web Automatically
You can override the time to elapse, in minutes, before a user is automatically logged off. This applies 
only to users who do not have the following option selected at the Log In screen:

Remember my ID and password 

The default is 180 (three hours). You can change the number of minutes by modifying the Windows 
registry or the Siebel Analytics Web configuration file instanceconfig.xml to add the following entry.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

LogonExpireMinutes �180�

■ instanceconfig.xml example:

<LogonExpireMinutes>180</LogonExpireMinutes>

NOTE: You can disable this setting by setting it to a value greater than the value for the setting 
ClientSessionExpireMinutes, described in �Setting the Time to Expire for Siebel Analytics Web Client 
Sessions� on page 22.

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.
Siebel Analytics Web Administration Guide Version 7.7.1, Rev. B ■ 23



Administering Siebel Analytics Web ■  Managing the Siebel Analytics Web Cache Settings
Managing the Siebel Analytics Web 
Cache Settings 
The entries described in this section are available for managing the Siebel Analytics Web cache:

■ �Specifying The Maximum Amount of Time an Entry Can Exist in the Siebel Analytics Web Cache� on 
page 24

■ �Specifying the Least Amount of Time an Entry Can Exist in the Siebel Analytics Web Cache� on 
page 25

■ �Specifying the Least Amount of Time an Entry Can Exist in the Siebel Analytics Web Cache After 
Use� on page 25

■ �Specifying the Maximum Number of Siebel Analytics Web Open Record Sets� on page 25

The cache is accessed when users make requests in Siebel Answers. This is not the same cache that 
is accessed by the Analytics server. You can change the internal defaults by modifying the Windows 
registry or the Siebel Analytics Web configuration file instanceconfig.xml to add the following entries. 

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

Specifying The Maximum Amount of Time an Entry Can Exist in the 
Siebel Analytics Web Cache
You can override the maximum amount of time, in minutes, that an entry in the cache can exist 
before it is removed. The internal default is 60 (one hour). 

Depending on (the number of requests being run, an entry may be removed before the time limit 
expires.

NOTE: The setting for CacheMinUserExpireMinutes, described in �Specifying The Maximum Amount of 
Time an Entry Can Exist in the Siebel Analytics Web Cache,� can force an entry for a particular user to 
exist for a longer time than that specified by CacheMaxExpireMinutes.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

CacheMaxExpireMinutes �60�

■ instanceconfig.xml example:

<CacheMaxExpireMinutes>60</CacheMaxExpireMinutes>
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Specifying the Least Amount of Time an Entry Can Exist in the Siebel 
Analytics Web Cache
You can override the minimum amount of time, in minutes, that an entry in the cache can exist before 
it is removed. The internal default is 10.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

CacheMinExpireMinutes �10�

■ instanceconfig.xml example:

<CacheMinExpireMinutes>10</CacheMinExpireMinutes>

Specifying the Least Amount of Time an Entry Can Exist in the Siebel 
Analytics Web Cache After Use
You can override the minimum amount of time, in minutes, that an entry in the cache can exist after 
it has been viewed by a user. The internal default is 10. 

For example, suppose CacheMaxExpireMinutes is set to 60 minutes. If a user views the entry during 
the 59th minute, the entry exists for that user for an additional 10 minutes. This allows the user to 
continue paging through the data without requiring a new request to be run.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

CacheMinUserExpireMinutes �10�

■ instanceconfig.xml example:

<CacheMinUserExpireMinutes>10</CacheMinUserExpireMinutes>

Specifying the Maximum Number of Siebel Analytics Web Open Record 
Sets
You can override the maximum number of open record sets that Siebel Analytics Web keeps open at 
any one time. The internal default is 10. The minimum value is 3. For systems under significant loads, 
you can increase this value to 500 or 1000.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

CacheMaxEntries �100�

■ instanceconfig.xml example:

<CacheMaxEntries>100</CacheMaxEntries>
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Configuring the Siebel Analytics Web 
Cookie Domain
You can configure the cookie domain by modifying the Windows registry or the Siebel Analytics Web 
configuration file instanceconfig.xml to add the following entries:

■ �Specifying Siebel Analytics Web Cookie Domain Information� on page 26

■ �Overriding the Siebel Analytics Web Cookie Domain Path� on page 26

■ �Specifying the Expiration Date for Persisted Siebel Analytics Web Cookies� on page 26

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

Specifying Siebel Analytics Web Cookie Domain Information
You can specify domain information for a cookie sent to the browser. There is no default value.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

CookieDomain value

■ instanceconfig.xml example:

<CookieDomain>value</CookieDomain>

Overriding the Siebel Analytics Web Cookie Domain Path
You can override the domain path that cookies apply to. The internal default is �/�.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

CookiePath c:\Test\Cookies

■ instanceconfig.xml example:

<CookiePath>/usr/local/test/cookies</CookiePath>

Specifying the Expiration Date for Persisted Siebel Analytics Web 
Cookies
You can override the date on which persisted cookies expire by modifying the Windows registry or 
the Siebel Analytics Web configuration file instanceconfig.xml to add the following entry. For 
example, remembered passwords expire on this date (see �Disabling the Siebel Analytics Web Feature 
to Remember Users� Names and Passwords� on page 18). The default value is �Tue, 31 Dec 2030 
23:59:59 GMT�.
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The format for the date is �day, dd mon year hh:mm:ss GMT�, where:

You should not change this entry.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

CookieExpire �Tue, 31 Dec 2040 23:59:59 GMT�

■ instanceconfig.xml example:

<CookieExpire>Tue, 31 Dec 2040 23:59:59 GMT<\CookieExpire>

Managing Siebel Analytics Web URL 
Generation and Resource File Location
You can override how Siebel Analytics Web generates URLs and where resource files are located by 
modifying the Windows registry or the Siebel Analytics Web configuration file instanceconfig.xml to 
add the following entries:

■ �Specifying How Siebel Analytics Web Command URLs Are Generated� on page 28

■ �Specifying How Siebel Analytics Web Static URLs Are Generated� on page 28

■ �Specifying the Location of Siebel Analytics Web Primary Resource Files� on page 29

■ �Specifying the Path to Siebel Analytics Web Primary Resource Files� on page 29

■ �Specifying the Location of Siebel Analytics Web Nonprimary Resource Files� on page 30

■ �Specifying the Path to Siebel Analytics Web Nonprimary Resource Files� on page 30

■ �Specifying Whether Siebel Analytics Web Generates Fully Qualified URLs� on page 30

If you are modifying the Windows registry, you need to create a URL under 
KEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7, and create the 
registry entries in the URL key.

If you are modifying instanceconfig.xml, you need to create the tags <URL> and </URL> after the 
<ServerInstance> tag, and place your entries between the <URL> and </URL> tags.

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

NOTE: Most of the URL entries are interrelated.

day The standard three-letter abbreviation for the day of the 
week.

dd The 2-digit day of the month.

mon The standard three-character abbreviation for the month.

year The 4-digit year.

hh:mm:ss The hour, minutes and seconds.

GMT The time zone, Greenwich Mean Time.
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Specifying How Siebel Analytics Web Command URLs Are Generated
You can specify how Siebel Analytics Web generates command URLs.

If you explicitly specify an entry, it must be of this form:

protocol://server/virtualpath

where virtualpath is the complete virtual path to Siebel Analytics Web. The default is determined 
separately for each client, based on the URL sent by the client to the Siebel Analytics Web server.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7\URL

AbsoluteCommandURLPrefix value

■ instanceconfig.xml example:

<URL>
<AbsoluteCommandURLPrefix>value</AbsoluteCommandURLPrefix>

</URL>

Specifying How Siebel Analytics Web Static URLs Are Generated
You can specify how Siebel Analytics Web generates URLs for static resources such as images, script 
files, style sheets, and other user-specified files. The default is protocol://server from the 
URL\AbsoluteCommandURLPrefix setting, described in �Specifying How Siebel Analytics Web 
Command URLs Are Generated� on page 28.

If you explicitly specify an entry, it must be of this form:

protocol://server

If you specify a virtual path, it is stripped off.

This entry also allows you to designate a separate Web server for delivering static resources, thereby 
reducing the load on the main Web server. This prefix will be used for the resources that have a fully 
qualified virtual path of the form �/Path/file�. If a resource file has a relative virtual path of the form 
�Path/file�, the prefix used is the same used for commands to the Siebel Analytics Web server 
extension.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7\URL

ResourceServerPrefix value

■ instanceconfig.xml example:

<URL>
<ResourceServerPrefix>value</ResourceServerPrefix>

</URL>
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Specifying the Location of Siebel Analytics Web Primary Resource 
Files
You can override the physical location of Siebel Analytics Web�s primary resource files (these are the 
resource files distributed with Siebel Analytics Web, not user-customized files such as custom styles 
or skins). The internal default is $(INSTALL_DIR)\Web\App\Res.

You must provide a full path. Siebel Analytics Web must have read permission to this path. For 
example, if this is a shared network resource, the Siebel Analytics Web administrator needs to make 
sure that the user under which Siebel Analytics Web is running has read access to the share, as well 
as read access to the file system the share is exported from. 

NOTE: If the value for this entry is different from the physical location of the Siebel Analytics Web 
DLLs, you must specify a setting for URL\ResourceVirtualPath, described in �Specifying the Path to 
Siebel Analytics Web Primary Resource Files� on page 29.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7\URL

ResourcePhysicalPath value

■ instanceconfig.xml example:

<URL>
<ResourcePhysicalPath>value</ResourcePhysicalPath>

</URL>

Specifying the Path to Siebel Analytics Web Primary Resource Files
You can override the virtual path used for Siebel Analytics Web�s primary resource files as specified 
by the setting URL\ResourcePhysicalPath, described in �Specifying the Location of Siebel Analytics Web 
Nonprimary Resource Files� on page 30. These resource files and customer-defined resource files 
must be served from the same Web server.

■ For generating relative URLs, the virtual path defaults to Res, assuming that the resource folder 
is present under the same virtual directory as the Siebel Analytics Web DLLs. 

■ For generating absolute URLs, the entry of the value URL\AbsoluteCommandURLPrefix is used as 
the default.

The value must be a fully qualified virtual path of this form:

�/VirtualPath�

If you omit the leading slash, one will be added.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7\URL

ResourceVirtualPath value

■ instanceconfig.xml example:
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<URL>
<ResourceVirtualPath>value</ResourceVirtualPath>

</URL>

Specifying the Location of Siebel Analytics Web Nonprimary Resource 
Files
You can override the physical location of resource files that are not part of a default installation. Such 
resource files include customized styles and skins. The internal default is $(DataDir)\Web\App\Res, 
where $(DataDir) is the resolved entry of HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, 
Inc.\Siebel Analytics\Common\7.7\DataDir. 

You must provide a full path. Siebel Analytics Web must have read permission to this path. For 
example, if this is a shared network resource, you need to make sure that the user under which 
Siebel Analytics Web is running has read access to the share, as well as read access to the file system 
the share is exported from. 

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7\URL

CustomerResourcePhysicalPath value

■ instanceconfig.xml example:

<URL>
<CustomerResourcePhysicalPath>value</CustomerResourcePhysicalPath>

</URL>

Specifying the Path to Siebel Analytics Web Nonprimary Resource 
Files
You can override the virtual path used for resource files that are not part of a default installation as 
specified in the setting URL\CustomerResourcePhysicalPath, described in �Specifying the Location of 
Siebel Analytics Web Nonprimary Resource Files� on page 30. The internal default is Res.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7\URL

CustomerResourceVirtualPath value

■ instanceconfig.xml example:

<URL>
<CustomerResourceVirtualPath>value</CustomerResourceVirtualPath>

</URL>

Specifying Whether Siebel Analytics Web Generates Fully Qualified 
URLs
You can override whether Siebel Analytics Web always generates fully qualified URLs for resource 
files that have fully qualified virtual paths. The internal default is No.
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When set to No, resources and the Siebel Analytics Web server extension are served from one server. 
When set to Yes, default resources are served from the same server as the Siebel Analytics Web 
server extension, and customer resources are served from another server. Depending on the value 
of the other settings described in this section, you could also set it up to have default and customer 
resources served from one server, and the Siebel Analytics Web server extension served from 
another server.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7\URL

ForceAbsoluteResourceURL value

■ instanceconfig.xml example:

<URL>
<ForceAbsoluteResourceURL>value</ForceAbsoluteResourceURL>

</URL>

Specifying the Default Language for the 
Siebel Analytics Web Login Screen
The default language in which the Siebel Analytics Web login screen appears is obtained from the 
user�s client browser settings. The following procedure explains how to change the language.

NOTE: The following procedure uses Internet Explorer 6.0 as an example. If you are using a different 
browser, make the necessary substitutions.

To change the default language on a user�s login screen

1 In Internet Explorer, choose Tools > Internet Options.

2 The Internet Options dialog box appears.

3 Click the Languages button.

4 The Language Preference dialog box appears.

Installed languages appear in the Languages list. The language at the top of the list is used as 
the default language.

5 If the desired language is not installed on the browser, add it.

6 Use the Move Up and Move Down buttons to position the desired language at the top of the list.

7 Restart the browser and log into Siebel Analytics Web.

The default language should match the language in the browser�s Language list.

NOTE: If a user does not select a different language from the drop-down list on the login screen, 
the setting for the User Interface Language at the user�s My Account screen determines the 
language in which the user interface is displayed.
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3 Administering Siebel Answers
This chapter describes procedures that are used to administer Siebel Answers. For an introduction 
to Siebel Answers, see Siebel Analytics User Guide.

This chapter contains the following topics:

■ �Managing Settings for the Siebel Analytics Web Chart Image Server� on page 34

■ �Managing the Siebel Analytics Web Charting Settings� on page 36

■ �Configuring Siebel Answers Pivot Table Settings� on page 38

■ �Configuring the Maximum Number of Rows in a Siebel Answers Table View� on page 39

■ �Adding Support for Navigation and Drill Down in Siebel Answers� on page 39

■ �Changing the Default Currency in Siebel Answers� on page 40

■ �Nesting Folders in the Selection Pane in Siebel Answers� on page 41
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Managing Settings for the Siebel 
Analytics Web Chart Image Server
Siebel Analytics Web uses a third-party charting engine to render charts (PopChart Image Server 
from CORDA Technologies, Inc.). You can override the default image type and browser client 
connection type by modifying the Windows registry or the Siebel Analytics Web configuration file 
instanceconfig.xml to add the following entries:

■ �Specifying the Siebel Analytics Chart Image Type� on page 34

■ �About Downloading and Using Flash as the Default Image Type in Siebel Analytics� on page 35

■ �Specifying How the Siebel Analytics Web Server Connects to the PopChart Image Server� on 
page 36

If you are modifying the Windows registry, you need to create a POP key in the Chart key, and create 
the registry entries in the POP key.

If you are modifying instanceconfig.xml, you need to create the tags <POP> and </POP> after the 
<ServerInstance> tag, and place your entries between the <POP> and </POP> tags.

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

Specifying the Siebel Analytics Chart Image Type
You can override the image type generated by the PopChart Image Server. The internal default is 
Flash.

The other choices are SVG (W3C Scalable Vector Graphics), PNG (W3C Portable Network Graphics), 
and JPEG. Flash and SVG images provide the greatest degree of interaction because they support 
mouseover behaviors (such as pop-up data labels), navigation, and drilling.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel 
Analytics\Web\7.7\Charts\POP

DefaultImageType PNG

■ instanceconfig.xml example:

<POP>
<DefaultImageType>PNG</DefaultImageType>

</POP>
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About Downloading and Using Flash as the Default Image Type in 
Siebel Analytics
In some organizations, users are instructed to download the latest Flash software from a corporate 
location instead of the vendor�s Web site. The default download source for Siebel Analytics Web is 
the vendor�s Web site. You can modify the default download source to point to another location. Then, 
when users view a chart in Siebel Analytics and a newer version of the Flash software is available on 
the corporate server, they can be prompted to download the newer version. This section contains the 
following topics:

■ �Modifying the Default Flash Download Source� on page 35

■ �Enabling a Download Prompt for New Flash Versions� on page 35

Modifying the Default Flash Download Source

The default download source for the Flash plug-in is the vendor�s Web site. You can change this to 
another location by modifying the Windows registry or the Siebel Analytics Web configuration file 
instanceconfig.xml to point to the location that holds the Flash code base.

NOTE: If you are modifying the Windows registry, you need to create a FlashCodeBase key in the 
Charts key, and create the registry entries in the FlashCodeBase key. If you are modifying 
instanceconfig.xml, you need to create the tags <FlashCodeBase> and </FlashCodeBase> after the 
<Charts> tag, and place your entries between the <FlashCodeBase> and </FlashCodeBase> tags.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel 
Analytics\Web\7.7\Charts\FlashCodeBase

FlashCodeBase \\CORPORATE\Download\Flash

■ instanceconfig.xml example:

<Charts>
<FlashCodeBase>\\CORPORATE\Download\Flash</FlashCodeBase>

</Charts>

Enabling a Download Prompt for New Flash Versions

After modifying the default Flash download source, you can enable a download prompt by creating 
a new classID for the Flash ActiveX control to add a custom global identifier (clsid) property. You can 
obtain the current global identifier property from any machine where Siebel Analytics Web charting 
is being used. (For version 7.7.1, the global identifier property used by Siebel Analytics is 
D27CDB6E-AE6D-11CF-96B8-444553540000.) The custom global identifier property must contain 
the same number of characters and dashes as the global identifier used in the default Flash ActiveX 
control.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel 
Analytics\Web\7.7\Charts\FlashCLSID

FlashCLSID E38CDB6E-BA6D-21CF-96B8-432553540000
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■ instanceconfig.xml example:

<Charts>
<FlashCLSID>E38CDB6E-BA6D-21CF-96B8-432553540000</FlashCLSID>

</Charts>

You should test flash charts independent of Siebel Analytics to make sure that they function with the 
custom global identifier property.

Specifying How the Siebel Analytics Web Server Connects to the 
PopChart Image Server
You can override how the Siebel Analytics Web server connects to the PopChart Image Server. The 
default is http://AnalyticsWeb_machine:2001/?, where AnalyticsWeb_machine is the machine name 
where Siebel Analytics Web is running, and 2001 is the port number. 

This setting must be fully qualified with the port number (if other than 80) using the notation as 
shown.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel 
Analytics\Web\7.7\Charts\POP

ServerPrefix http://AnalyticsWeb_machine:85/?

■ instanceconfig.xml example:

<POP>
<ServerPrefix>http://AnalyticsWeb_machine:85/?</ServerPrefix>

</POP>

Managing the Siebel Analytics Web 
Charting Settings 
You can change certain Siebel Analytics Web charting settings from their internal default settings by 
adding entries to the Windows registry or the Siebel Analytics Web configuration file 
instanceconfig.xml:

■ �Specifying the Location of Temporary Storage for Chart Cache in Siebel Analytics Web� on page 37

■ �Specifying the Interactive Behavior of Charts in Siebel Analytics Web� on page 37

■ �Specifying the URL for Chart Navigation in Siebel Analytics Web� on page 37

In Windows, the installation process creates the following registry key for the charting function:

\Siebel Systems, Inc.\Siebel Analytics\Web\7.7\Charts

If you are modifying the Windows registry, you can place the entries described in this section in the 
Chart key.

If you are modifying the file instanceconfig.xml, you need to create the tags <Chart> and </Chart> 
after the <ServerInstance> tag, and place your entries between the <Chart> and </Chart> tags.
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For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

Specifying the Location of Temporary Storage for Chart Cache in 
Siebel Analytics Web
You can override the internal default entry for the location used by Siebel Analytics Web as temporary 
storage for chart cache. The internal default is dirletter:\SiebelAnalyticsData\Temp\nQWCharts, 
where dirletter is the drive where the Siebel Analytics Web software is installed.

The location should be a fully-qualified path name, such as d:\SiebelWebChartCache. The folder or 
directory structure must exist before you start the Analytics Web Server service again.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7\Charts

CacheDirectory c:\SiebelAnalyticsData\Temp\ChartCache

■ instanceconfig.xml example:

<Charts>
<CacheDirectory>/usr/local/SiebelAnalytics/Data/temp/chartcache</CacheDirectory>

</Charts>

Specifying the Interactive Behavior of Charts in Siebel Analytics Web
You can override the default interactive behavior of Siebel Analytics Web charts. Valid entries are 
Drill, Navigate and None. The default is Drill. This means that charts are created drillable by default.

If you specify Navigate, charts navigate to the URL described in �Specifying the URL for Chart 
Navigation in Siebel Analytics Web� on page 37. If you specify None, charts are not interactive; for 
example, clicking on a chart or chart region does nothing.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7\Charts

DefaultInteraction Navigate

■ instanceconfig.xml example:

<Charts>
<DefaultInteraction>Navigate</DefaultInteraction>

</Charts>

Specifying the URL for Chart Navigation in Siebel Analytics Web
If you specify Navigate as the interactive behavior of charts (described in �Specifying the Interactive 
Behavior of Charts in Siebel Analytics Web� on page 37), you can override the default URL to which 
charts navigate. The internal default URL is http://www.siebel.com/.

If the interactive behavior is not Navigate, this entry is ignored.
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■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7\Charts

DefaultNavigationPath http://www.intranet.com/

■ instanceconfig.xml example:

<Charts>
<DefaultNavigationPath>http://www.intranet.com/</DefaultNavigationPath>

</Charts>

Configuring Siebel Answers Pivot Table 
Settings
You can change certain pivot table settings from their internal defaults by adding entries to the 
Windows registry or the Siebel Analytics Web configuration file instanceconfig.xml:

■ �Specifying the Maximum Number of Records To Process in a Siebel Analytics Pivot Table�

■ �Specifying the Maximum Number of Populated Cells in a Siebel Analytics Pivot Table�

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

Specifying the Maximum Number of Records To Process in a Siebel 
Analytics Pivot Table
You can override the maximum number of records that can be processed by a pivot table. The 
internal default is 20000.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

CubeMaxRecords 30000

■ instanceconfig.xml example:

<CubeMaxRecords>30000</CubeMaxRecords>

Specifying the Maximum Number of Populated Cells in a Siebel 
Analytics Pivot Table
You can override the maximum number of populated cells that Siebel Analytics Web allows in a pivot 
table. The internal default is 150000. If the user exceeds this value, the server returns an error 
message when the pivot table is rendered.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

CubeMaxPopulatedCells 160000
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■ instanceconfig.xml example:

<CubeMaxPopulatedCells>160000</CubeMaxPopulatedCells>

Configuring the Maximum Number of 
Rows in a Siebel Answers Table View
You can override the maximum number of rows that can appear in a Table view by modifying the 
Windows registry or the Siebel Analytics Web configuration file instanceconfig.xml to add the 
following entry. The internal default is 10000. If the user exceeds this value, the server returns an 
error message when the table view is rendered.

NOTE: This entry applies to the Table view, not the Pivot Table view.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

ResultRowLimit 12000

■ instanceconfig.xml example:

<ResultRowLimit>12000</ResultRowLimit>

Adding Support for Navigation and Drill 
Down in Siebel Answers
When you create a request, you can allow users to navigate to related requests and content. If the 
Siebel Analytics Server administrator set up dimensions and dimensional hierarchies for the subject 
area, users can drill down on data results presented in charts, tables and pivot tables to obtain more 
detailed information.

There are no specific privilege settings that impact access to Siebel Analytics Web Navigation and 
drill down features, which are available to all users.

Dimensional hierarchies are a system of levels in a dimension that are related to each other by one-
to-many relationships. For example, a region hierarchy might be defined as a postal code rolling up 
to a city, rolling up to a region. There is exactly one city and one region corresponding to a single 
postal code, but there might be many postal codes corresponding to a single city, and there might 
be many cities corresponding to a single region.

Drill down allows users to move through the dimensional hierarchies associated with the subject area 
to obtain more detailed results. For example, if the results contain a total sales column, the user 
might be able to click total sales to drill down for sales by region, and then click a region to see sales 
by city in that region. The information available to Siebel Analytics Web users through drill down is 
constrained by the dimensional hierarchies configured by the Siebel Analytics Server administrator 
for the specific subject area.

For information about setting up dimensions and hierarchies, see Siebel Analytics Server 
Administration Guide.
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Changing the Default Currency in Siebel 
Answers
You can change the default currency displayed in the Siebel Answers user interface, for example, 
from French Francs to Euros. 

If you are using Siebel Analytics applications, with no customizations, you only need to set the 
default data warehouse currency.

If you have created additional subject areas, the currency column data is in the number format, and 
you need to specify the currency for the customized subject area as described in the second 
procedure.

For more information about using formatting functions in Siebel Answers, see Siebel Analytics User 
Guide.

To set the default data warehouse currency

1 Open the currencies.xml file in the directory \\SiebelAnalyticsData\Web\Config.

2 Search for the currency that you want to make the default, for example USD, CAD, PEN, or MAD.

3 Copy the entire currency element.

For example, copy the currency tag for the Euro:

- <Currency tag="int:euro-l" type="international" symbol="_" 
displayMessage="kmsgCurrencyEuroLeft" digits="2" format="$ #"> 

<negative tag="minus" format="-$ #" /> 

</Currency>

4 Search for the text string int:wrhs, located towards the top of the file.

5 Select the entire element and replace it by pasting the copied element over it.

6 Replace the tag attribute so it reads int:wrhs.

For example, replace tag="int:euro-l" with tag="int:wrhs".

7 Restart the Analytics Web Server service.

To specify the currency for customized subject areas

1 In Siebel Answers, modify the request that uses the subject area.

2 Click the Format Column icon for the currency column.

The Column Properties dialog box appears.

3 At the Value Format tab, in the Data Format area, click the following option:

Override Default Data Format

4 In the Treat Numbers As drop-down list, select Currency.
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5 In the Currency Symbol drop-down list, select the currency symbol.

6 To save this as the system-wide default for this data type, click the Save button and then select 
the appropriate option.

7 Click OK when you are done, and then repeat the preceding steps for any other columns you want 
to change.

Nesting Folders in the Selection Pane in 
Siebel Answers
To make selections easy for users to discern in the selection pane, you can set up the presentation 
layer in the Analytics Server Administration Tool to give the appearance of nested folders. For 
example, you can make the Sales Facts folder appear as a subfolder in the Facts folder. You can 
accomplish this during the construction of the presentation layer by prefixing the name of a folder 
to appear as a subfolder with a hyphen ( - ) and a space. 

The preconfigured Siebel Analytics repository for Siebel operational applications provides examples 
of this construction. For more information, see Siebel Analytics Server Administration Guide.
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4 Administering Siebel Delivers
This chapter describes procedures used to administer Siebel Delivers. For information about using 
Siebel Delivers, see Siebel Analytics User Guide.

This chapter contains the following topics:

■ �About Siebel Delivers iBots and Impersonation� on page 43

■ �About Siebel Delivers iBots and AntiVirus Software� on page 44

■ �Viewing Entries in the Siebel Delivers iBot Log Directory� on page 44

■ �Disabling Siebel Delivers� on page 45

■ �Specifying the Machine Running Siebel Analytics Scheduler� on page 45

■ �Changing the Directory in Which Siebel Delivers iBot Deliveries Are Stored� on page 46

■ �Integrating Siebel Delivers with Siebel Workflow 7.7� on page 46

■ �Using Siebel Delivers to Seed the Siebel Analytics Server Cache� on page 47

■ �About the SA System Subject Area and Scheduling iBot Deliveries� on page 48

About Siebel Delivers iBots and 
Impersonation
Siebel Delivers makes use of intelligence agents or Bots (called iBots). iBots are software-based 
agents driven by schedule or events that access, filter, and perform analytics on data based upon 
defined criteria. Users receive information from iBots in the form of alerts that appear on their 
designated delivery devices or dashboards.

To create an iBot, Siebel Analytics Web administrators and users use Siebel Delivers to define the 
actions the iBot is to perform. Siebel Analytics Web gathers information about the priority, delivery 
devices, user, and other characteristics; packages that information into a job; and tells Siebel 
Analytics Scheduler when it wants the job to execute.

Because the Scheduler runs these jobs on behalf of users without accessing or storing their 
passwords, Siebel Analytics Server allows the Scheduler and Siebel Analytics Web to impersonate 
users. This is done by configuring the Scheduler to use a user ID and password with administrator 
privileges that can act on behalf of other users. An iBot logs on to the system using this user ID and 
password, and then the Scheduler executes the job on behalf of the user.

NOTE: If Siebel Analytics Server is configured to authenticate users through database logons, then 
impersonation is not allowed. Siebel Delivers works with database authentication provided that only 
the initialization block set up for authentication in the Siebel Analytics Server Administration Tool 
uses a connection pool with pass-through authentication. That connection pool cannot be used for 
any other initialization block or request.
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For information about user authentication options, see Siebel Analytics Server Administration Guide. 
For information about the Scheduler, see Siebel Analytics Scheduler Guide.

About Siebel Delivers iBots and 
AntiVirus Software
Some antivirus software programs, such as Norton AntiVirus, enable a script-blocking feature, which 
tries to block all calls made by scripts to system objects (such as the Windows file system object) 
that the antivirus software deems unsafe.

If you launch a script as part of post-iBot processing, this antivirus feature may cause unexpected 
results. If you are running antivirus software with a script-blocking feature on the machine where 
Siebel Analytics Scheduler is installed, you should disable the script-blocking feature to prevent the 
software from unexpectedly blocking iBot script calls.

Viewing Entries in the Siebel Delivers 
iBot Log Directory
If an iBot fails to execute fully or if debugging is turned on in Siebel Analytics Scheduler, a log file is 
generated for the iBot.

The location for iBot log files is specified on the iBots tab of the Job Manager Configuration dialog 
box in Siebel Analytics Scheduler. The default location is the Log directory in the Siebel Analytics 
installation directory on the machine where Siebel Analytics Scheduler is installed.

The log file name has the following format:

NQiBot-JobID-InstanceID.xxx

where:

The iBot error and debug log files are written as separate files for each iBot instance. You can use a 
text editor to view the files. Entries are generally self-explanatory. Exit codes are generic and do not 
indicate any particular condition.

The presence of an error log does not necessarily mean that an iBot failed completely. For example, 
suppose an iBot delivers content to multiple email addresses. If some of the addresses are invalid or 
the mail server is down, an error log is generated for the iBot.

For more information about the Scheduler, see Siebel Analytics Scheduler Guide.

NQibot The preface for all iBot log files.

JobID The Scheduler job ID for the iBot.

InstanceID The Scheduler instance ID for the iBot.

xxx The file extension:

■ .err for iBot error log files.

■ .log for debug log files.
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Disabling Siebel Delivers
Siebel Delivers is an optional component of Siebel Analytics Web that is enabled by default for 
organizations that have purchased the appropriate license. To disable Siebel Delivers, you can edit 
the Windows registry or the Siebel Analytics Web configuration file instanceconfig.xml to add the 
following entry. The default value is Y (Siebel Delivers is enabled). To disable Siebel Delivers, set this 
to N.

If you are modifying the Windows registry, you need to create the registry entries in the Alerts key.

If you are modifying instanceconfig.xml, you need to create the tags <Alerts> and </Alerts> after 
the <ServerInstance> tag, and place your entries between the <Alerts> and </Alerts> tags.

■ Windows registry example:

HKEY LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7\Alerts

Enabled N

■ instanceconfig.xml example:

<Alerts>
<Enabled>No</Enabled>

</Alerts>

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

Specifying the Machine Running Siebel 
Analytics Scheduler
You can identify the machine running Siebel Analytics Scheduler by editing the Windows registry or 
the Siebel Analytics Web configuration file instanceconfig.xml to add the following entry. If Siebel 
Analytics Scheduler is running on the local machine, this is populated with the name of the local 
machine.

If you are modifying the Windows registry, you need to create the registry entries in the Alerts key.

If you are modifying instanceconfig.xml, you need to create the tags <Alerts> and </Alerts> after 
the <ServerInstance> tag, and place your entries between the <Alerts> and </Alerts> tags.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7\Alerts

ScheduleServer Server02

■ instanceconfig.xml example:

<Alerts>
<ScheduleServer>Server02</ScheduleServer>

</Alerts>
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For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

NOTE: If you are migrating a Siebel Analytics environment to a new system, make sure you also 
migrate the Siebel Analytics Server repository file and the Scheduler tables. The Scheduler tables 
are required for iBots.

Changing the Directory in Which Siebel 
Delivers iBot Deliveries Are Stored
You can specify the directory in which iBot deliveries are stored by editing the Windows registry or 
the Siebel Analytics Web configuration file instanceconfig.xml to add the following entry. The 
deliveries directory is, by default, stored in the same location as the Web Catalog. (The value 
described in �Changing the Name and Location of the Siebel Analytics Web Catalog� on page 60 defines 
where the Web Catalog is stored.) At startup, Siebel Analytics Web attempts to create the deliveries 
directory. 

If you are modifying the Windows registry, you need to create the registry entries in the Web key.

If you are modifying instanceconfig.xml, you need to create the tags <Web> and </Web> after the 
<ServerInstance> tag, and place your entries between the <Web> and </Web> tags.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web

PersistentStorageDirectory c:\SiebelAnalytics\Data\Web\Catalog\TestDelivery

■ instanceconfig.xml example:

<PersistentStorageDirectory>/usr/local/SiebelAnalytics/Data/web/catalog/
TestDelivery</PersistentStorageDirectory>

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

Integrating Siebel Delivers with Siebel 
Workflow 7.7
You can use the Advanced tab in Siebel Delivers to set up iBots to trigger workflows in the Siebel 
Workflow 7.7 application. The procedures to configure this capability are given in Siebel Analytics 
Scheduler Guide.

By default, only Siebel Analytics Web administrators have the necessary privileges to set up iBots to 
trigger workflows.

For information about the Advanced tab in Siebel Delivers, see Analytics Web Online Help.
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Using Siebel Delivers to Seed the Siebel 
Analytics Server Cache
You can use the Advanced tab in Siebel Delivers to set up iBots to seed the Siebel Analytics Server 
cache. Seeding the cache can improve response times for users when they run requests in Siebel 
Answers or view requests that are embedded on their dashboards. Do this by scheduling iBots to 
execute requests that refresh this data.

For more information about Siebel Analytics Server cache, see Siebel Analytics Server Administration 
Guide.

For information about the Advanced tab in Siebel Delivers, see Analytics Web Online Help.

About Permission Settings for Siebel 
Delivers and iBots
The permission settings for Siebel Delivers and iBots are available in the Siebel Delivers section on 
the Privilege Administration page in Siebel Analytics Administration.

When users are granted access to the Publish for Subscription privilege, they also need to have 
Change/Delete permission to the shared iBots object and child objects in the Siebel Analytics Web 
Catalog. 

You can grant the Change/Delete permission by using the Manage Catalog feature. For information 
about using the Manage Catalog feature, see �Administering Items in the Siebel Analytics Web Catalog� 
on page 78.
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About the SA System Subject Area and 
Scheduling iBot Deliveries
This section applies only to organizations using Siebel Analytics operational applications.

When the SA System subject area is being used, iBot deliveries cannot be made to user IDs that are 
defined only in the Siebel Analytics repository. Such internally defined user IDs include the 
Administrator user ID.

The SA System subject must return rows for any acceptable user of Siebel Analytics. In all Siebel 
Analytics operational applications, the Administrator user ID is not defined in the Siebel OLTP, and 
therefore is not returned from queries to the SA System subject area. You should test alerts with a 
valid Siebel OLTP user.
Siebel Analytics Web Administration Guide Version 7.7.1, Rev. B48 ■



5 Administering Siebel 
Intelligence Dashboards
End users with appropriate privileges can modify personal and shared Siebel Intelligence 
Dashboards, including the addition of pages and content. End users cannot create dashboards.

Siebel Analytics Web administrators can create and manage dashboards, using the procedures in this 
chapter. For an introduction to dashboards and end-user procedures for modifying them, see Siebel 
Analytics User Guide and Analytics Web Online Help.

This chapter contains the following topics:

■ �Creating and Deleting Shared Siebel Intelligence Dashboards� on page 49

■ �Changing Siebel Intelligence Dashboards Properties� on page 51

■ �Creating Siebel Intelligence Dashboards Action Links� on page 52

■ �Setting the Number of Siebel Intelligence Dashboard Names to Appear on a Screen� on page 53

■ �Setting the Number of Siebel Analytics Briefing Book Links to Follow� on page 53

■ �Downloading Siebel Analytics Results in Non-UNICODE Format� on page 54

■ �Integrating Siebel Answers Into Other Portals or Intranets� on page 55

Creating and Deleting Shared Siebel 
Intelligence Dashboards
Before you create shared dashboards, make sure you have planned your Web Catalog directory or 
folder structure and security strategy. Guidelines for creating a shared dashboard, within the broader 
context of Web Catalog structure and security framework, are given in �Guidelines for Configuring 
Siebel Analytics Web Security for the Web Catalog and Dashboards� on page 102.

For more information about shared folder structures in the Web Catalog see Chapter 6, �Administering 
the Siebel Analytics Web Catalog.� 

For more information about permissions, see Chapter 7, �Managing Siebel Analytics Web Security.�

Overall, to create a shared dashboard, you first create the dashboard and then add content using 
the Dashboard Editor. You can also assign Web Groups permissions to access the dashboard. Users 
who are members of more than one Web Group can select the dashboard they see by default from 
all of the dashboards to which they have permissions.

NOTE: When you use a Siebel operational application, dashboard integration is done using Siebel 
applications. For information, see Siebel Analytics Installation and Configuration Guide.

This section describes, from an administrator�s perspective, how to create and delete dashboards, 
and add sections. For more information about adding pages, sections, and content from an end-
user�s perspective, see Siebel Analytics User Guide.
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To create a shared dashboard

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the link Manage Intelligence Dashboards.

3 Scroll down if necessary, and click the following link:

Create a new Intelligence Dashboard

The Create Dashboard screen appears.

4 Specify entries for the following fields:

a Select the appropriate Group Folder from the drop-down list.

The members of this Web group (and other groups and users with appropriate permissions) 
will have Read access to the shared dashboard.

b Type a name for the dashboard in the Dashboard Name text box.

c In the Dashboard Builder text box, type the name of the user or Web Group that can make 
changes to the dashboard.

For information about creating Web Groups, see �About Siebel Analytics Web Groups and Siebel 
Analytics Session Variables� on page 90.

5 Click Finished when you are done.

6 In Siebel Answers, click the Dashboards tab in the selection pane, and then click the Refresh 
Display link near the bottom of the selection pane.

The newly created dashboard appears in the list of dashboards.

7 In Siebel Intelligence Dashboards, navigate to the dashboard and click the Edit Dashboard link.

The Dashboard Editor screen opens, where you can add content to the dashboard. For 
information, see Analytics Web Online Help.

To delete a dashboard

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the link Manage Intelligence Dashboards.

3 Locate the dashboard you want to delete and click the Delete icon.

The Confirm Deletion screen appears.

4 Click Yes, and then click Finished.
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Changing Siebel Intelligence 
Dashboards Properties
You can change dashboard properties at the Dashboard Properties screen.

To change dashboard properties

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the link Manage Intelligence Dashboards.

3 Locate the dashboard you want to change and click the Properties icon.

The Dashboard Properties screen appears.

4 Follow directions in the table to change the property, and then click Finished when you are done.

NOTE: Clicking the Cancel button does not undo changes in the Dashboard Pages area.

Dashboard Property 
Change Directions

Style In the General Properties area, select the style from the Style 
drop-down list. For more information about styles, see 
Chapter 8, �Customizing the Siebel Analytics Web User Interface.�

Hide Dashboard Click this option to hide the dashboard from users. This is useful 
while you are setting up a dashboard.

Description Type a description for the dashboard. The description does not 
appear on the dashboard.

Name of a page In the Pages table, identify the page and click the Rename icon.

Deletion of a page In the Pages table, identify the page and click the Delete icon.

Permissions for a page In the Pages table, identify the page and click the Security icon. 
For information about changing dashboard permissions, see 
�About Setting Siebel Analytics Web Permissions� on page 94.

Order in which the page 
tabs appear

In the Pages table, identify the page and click the Move Up or 
Move Down arrow to change the order in which the page appears
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Creating Siebel Intelligence Dashboards 
Action Links
Siebel Analytics action links allow end users to navigate from their analytic dashboards to a record 
in a Siebel operational application. Siebel Analytics applications contain prebuilt action links in 
requests and dashboards. For example, a user can drill down directly from a Siebel Sales Analytics 
dashboard to a specific record in a Siebel Sales view. Drilldown is based on the row identifier column 
contained in a request.

NOTE: End users must have the appropriate permissions and responsibilities to access the view, and 
any drilldown links.

To create an action link

1 Identify the target Siebel operational application view.

2 Select the Siebel operational application view or applet that you want to drill down to, and select 
Help > About View.

A pop-up window shows the names of the view and applet. Note the view and list applet names. 
You need these names in Step 5.

3 Using a Subject Area that is appropriate for the target applet, use Siebel Answers to create a 
new Analytics request with the row identifier column in it, for example, Account_Row_ID.

4 Click the Properties icon for the column.

The Edit Column Format screen appears.

5 Make the following changes:

a Clear the option Default Data Format.

b Select the option Treat Text as Custom Text Format.

c Enter the following HTML, substituting the appropriate view name and list applet names. The 
following example HTML shown uses All Account List View as the View Name, and Account List 
Applet as the target applet.

"<a href=\"javascript:NQSWENav('All Account List View','Account List 
Applet','"@"'); \">"@" </a>"

6 Click Finished, and then view the request on the dashboard.

After the request is saved and placed on a dashboard, the row identifier column automatically 
produces an action link to the Siebel operational application.

Optionally, the row identifier column can be replaced with icons in the column, using the following 
sample HTML. This provides an image source for the action links, such as ActionLink.gif as shown in 
the sample. Substitute the name of the image that you want to use. The image must be located on 
the Web server machine.

[HTML] "<a href=\"javascript:NQSWENav('All Account List View','Account List 
Applet','"@"'); \" title=\""@"\"><img src=\"Res/s_Siebel7/Views/ActionLink.gif\" 
border=0></a>"
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Setting the Number of Siebel 
Intelligence Dashboard Names to 
Appear on a Screen
Siebel Analytics typically displays the names of individual dashboards across the top of the screen. 
To minimize the amount of screen space used for this, when there are more than 15 dashboard 
names to display, Siebel Analytics creates a drop-down list from which users can choose the 
dashboard to view. A drop-down list shows individual dashboards as grouped under the name of the 
folder that contains them, and replaces the dashboard names at the top of the screen with that folder 
name. Together with the entry described in this section, you can create and manipulate folders 
containing dashboards within the Web Catalog to create the desired dashboard presentation. 

You can change the number of dashboard names to show before a drop-down list appears by 
modifying the Windows registry or the Siebel Analytics Web configuration file instanceconfig.xml to 
add the following entry. The minimum value is 1.

NOTE: This entry takes effect for all folders that contain dashboards if any folder contains more than 
the value you specify. For example, if dashboard folder A contains 8 dashboards and dashboard folder 
B contains 11 dashboards, and you specify a value of 10, drop-down lists will appear for both folders.

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

DashboardMaxBeforeMenu 10

■ instanceconfig.xml example:

<DashboardMaxBeforeMenu>10</DashboardMaxBeforeMenu>

Setting the Number of Siebel Analytics 
Briefing Book Links to Follow
A Briefing Book navigation link is a special type of link that can be added to a dashboard using the 
Dashboard Editor. The default value for the maximum number of links to follow is 5.

You can change the default by modifying the Windows registry or the Siebel Analytics Web 
configuration file instanceconfig.xml to add the following entry. The minimum value is 1. The 
maximum value is 10.

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

MaxFollowLinks 10
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■ instanceconfig.xml example:

<MaxFollowLinks>10</MaxFollowLinks>

Downloading Siebel Analytics Results in 
Non-UNICODE Format
Siebel Analytics provides options for downloading results that appear in Siebel Answers as options 
for the Download link. The Download link can also appear with a request in a dashboard.

By default, the Download Data option downloads results in a UNICODE, tab-separated text file. For 
organizations that require a non-UNICODE, comma-separated file for use with certain applications, 
you can override behavior of the Download Data option or add another download option by modifying 
the message kmsgEVCDownloadLinks in the XML messages file viewscontrolmessages.xml.

If you change the behavior of the Download Data option or add a new option that retrieves comma-
separated data, the Windows registry or instanceconfig.xml entry described in this section is used to 
determine the character set to use. You can view supported character sets by examining the message 
file charactersetdefinitions.xml located in the SiebelAnalyticsData\Web\Config directory.

For example, adding the following XML code to the message kmsgEVCDownloadLinks in the file 
viewscontrolmessages.xml file adds the option Download CSV to the Download link:

<a class="NQWMenuItem" name="SectionElements"
href="javascript:void(null);" onclick="NQWClearActiveMenu();
Download('@{command}&amp;Format=csv&amp;Extension=.csv')">Download CSV</a>

The Download CSV option will download a comma-separated file that uses the following entry to 
determine the character set.

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

CSVCharset us-ascii

■ instanceconfig.xml example:

<CSVCharset>us-ascii</CSVCharset>

For information about making changes to the XML messages files, see �Customizing the Siebel 
Analytics Web User Interface Using XML Message Files� on page 113.
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Integrating Siebel Answers Into Other 
Portals or Intranets
The following customization settings are available for integrating Siebel Answers into other portals 
and intranets without requiring the use of Siebel Intelligence Dashboards. These settings are 
configured in XML message files. 

You can perform the following actions:

■ Change the text of the Dashboards link.

■ Change the URL to which users are directed when they click that link.

NOTE: Make sure that you first review the information in �Customizing the Siebel Analytics Web User 
Interface Using XML Message Files� on page 113 before making any integration changes.

To change the text of the dashboards link

1 Navigate to the file UIMessages.xml.

This file is located in the folder Web\App\Res\l_xx\Messages in the Siebel Analytics Web 
installation directory, where xx is the language identifier of the selected locale.

CAUTION: Always make a backup copy of the file UIMessages.xml before you make any 
changes.

2 Use a text editor to open the file UIMessages.xml.

3 Locate the message �kmsgUIPortal.�

The message has the following form:

<WebMessage name="kmsgUIPortal">

<TEXT>Dashboards</TEXT>

</WebMessage>

The default text is Dashboards.

4 Change the default text to text of your choosing.

For example, to change the text to be your company�s intranet, you might change it to the 
following:

<WebMessage name="kmsgUIPortal"> 

<TEXT>Intranet</TEXT> 

</WebMessage>

5 Save the file when you are done.

Your changes take effect when the Analytics Web Server service is restarted.
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To change the destination of the dashboards link

1 Navigate to the file ControlMessages.xml.

This file is located in the folder Web\App\Res\l_xx\Messages in the Siebel Analytics Web 
installation directory, where xx is the language identifier of the selected locale.

CAUTION: Always make a backup copy of the file ControlMessages.xml before you make any 
changes.

2 Use a text editor to open the file ControlMessages.xml.

3 Locate the message �kmsgPortalLink.�

The message has the following form:

<WebMessage name="kmsgPortalLink">

<HTML>

<A insert="1">

<MessageRef name="kmsgUIPortal" /> 

</A>

</HTML>

</WebMessage>

The default location is Siebel Intelligence Dashboards (indicated by the reference to insert=�1�, 
which is an internal reference).

4 Change the default location to a location of your choosing.

NOTE: If no location is specified, no link appears in Siebel Answers.

For example, to change this to your company�s intranet, you can include the appropriate 
attributes and change it to point to that location instead:

<WebMessage name="kmsgPortalLink">

<HTML>

<A href="http://intranet" target="_top" title="Click here for your intranet">

<MessageRef name="kmsgUIPortal" /> 

</A>

</HTML>

</WebMessage>

5 Save the file when you are done.

Your changes take effect when the Analytics Web Server service is restarted.
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For more information about controlling the default appearance and behavior of the Siebel Analytics 
Web user interface, see �Customizing the Siebel Analytics Web User Interface Using XML Message Files� 
on page 113. 
Siebel Analytics Web Administration Guide Version 7.7.1, Rev. B ■ 57



Administering Siebel Intelligence Dashboards ■  Integrating Siebel Answers Into Other 
Portals or Intranets
Siebel Analytics Web Administration Guide Version 7.7.1, Rev. B58 ■



6 Administering the Siebel 
Analytics Web Catalog
This chapter describes how to administer the Siebel Analytics Web Catalog and provides information 
about basic maintenance procedures. For organizations that have Siebel Analytics applications, this 
chapter also explains how to use Analytics Catalog Manager to locate the names and descriptions of 
the requests delivered with preconfigured dashboards.

This chapter contains the following topics:

■ �Changing the Name and Location of the Siebel Analytics Web Catalog� on page 60

■ �How the Siebel Analytics Web Catalog Backup Process Works� on page 61

■ �Setting the Number of Automatic Siebel Analytics Web Catalog Backups� on page 62

■ �Setting the Number of Minutes Between Backups of the Siebel Analytics Web Catalog� on page 63

■ �Creating a New Siebel Analytics Web Catalog� on page 63

■ �Recovering From a Failure to Load the Siebel Analytics Web Catalog� on page 64

■ �Moving a Siebel Analytics Web Catalog to Another System� on page 65

■ �Migrating Changes to Siebel Analytics Requests and Filters� on page 66

■ �About Siebel Analytics Catalog Manager� on page 66

■ �Opening Siebel Analytics Catalog Manager� on page 67

■ �Viewing the Siebel Analytics Catalog Manager Workspace� on page 67

■ �Working with Siebel Analytics Catalog Manager Properties� on page 69

■ �Copying and Pasting Content Between Siebel Analytics Web Catalogs� on page 71

■ �Updating the Siebel Analytics Web Catalog to a Newer Version� on page 72

■ �Localizing Siebel Analytics Web Catalog Text Strings� on page 74

■ �Recommendations For Working with the Siebel Analytics Web Catalog� on page 76

■ �Viewing Information About Siebel Intelligence Dashboards� on page 76

■ �Using Analytics Catalog Manager to Rename Items in the Siebel Analytics Web Catalog� on page 77

■ �Administering Items in the Siebel Analytics Web Catalog� on page 78
Siebel Analytics Web Administration Guide Version 7.7.1, Rev. B ■ 59



Administering the Siebel Analytics Web Catalog ■  Changing the Name and Location of 
the Siebel Analytics Web Catalog
Changing the Name and Location of the 
Siebel Analytics Web Catalog
The installation process sets the name of the Web Catalog to default.webcat for Siebel Analytics 
stand-alone sites, and to SiebelAnalytics.webcat for organizations that have Siebel Analytics 
applications.

The following locations are the default locations for the Web Catalog:

■ In Windows

\SiebelAnalyticsData\Web\Catalog

■ In UNIX

INSTALLDIR/Data/web/catalog

where INSTALLDIR is the Siebel Analytics Web installation directory. The default installation 
directory is /usr/local/SiebelAnalytics.

If you move the Web Catalog or change its name, you need to update the Windows registry or the 
Siebel Analytics Web configuration file instanceconfig.xml to specify the new location or name.

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

CatalogPath c:\SiebelAnalyticsData\Web\Catalog\test.webcat

■ instanceconfig.xml example:

<CatalogPath>/usr/local/SiebelAnalyticsData/web/catalog/test.webcat</CatalogPath>

NOTE: There is a one-to-one relationship between a Siebel Analytics repository and a Siebel 
Analytics Web Catalog. Multiple Siebel Analytics Web servers may be configured to point to a single 
Siebel Analytics server, but each Web Catalog must point to a unique repository. You cannot, for 
example, configure two Siebel Analytics Web servers to use the same Web Catalog concurrently.
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How the Siebel Analytics Web Catalog 
Backup Process Works
Siebel Analytics Web maintains automatic Web Catalog backup files and version files in the location 
where the Web Catalog is stored. Web Catalog backup files are useful when the Siebel Analytics Web 
administrator is customizing or testing Siebel Analytics Web content. The version file is used to help 
maintain Web Catalog integrity.

This section contains the following topics:

■ �About Siebel Analytics Web Catalog Backup Files� on page 61

■ �About the Siebel Analytics Web Catalog Version File� on page 61

■ �When Changes Are Written to the Siebel Analytics Web Catalog� on page 62

About Siebel Analytics Web Catalog Backup Files
By default, Siebel Analytics Web performs a Web Catalog backup every five minutes. The backup files 
are saved into the same location as the in-use Web Catalog. Automatic backups are identified by 
nnn.autosave appended to the Web Catalog name, where nnn represents the sequential number 
assigned to the backup.

For example, in Windows, if the path to the Web Catalog is:

c:\SiebelAnalyticsData\Web\Catalog\SiebelAnalytics.webcat

then the third backup file is:

c:\SiebelAnalyticsData\Web\Catalog\SiebelAnalytics.webcat.03.autosave

The default number of Web Catalog backup files is 10. If the server crashes, it creates another set 
of 10 backup files. After ten sets of backup files have been created, the numbering goes back to 01-
10.

You can control the number of automatic Web Catalog backup files and the interval between them. 
For more information, see �Setting the Number of Automatic Siebel Analytics Web Catalog Backups� on 
page 62 and �Setting the Number of Minutes Between Backups of the Siebel Analytics Web Catalog� on 
page 63.

About the Siebel Analytics Web Catalog Version File
Information about the last known good Web Catalog backup is stored in a file ending in .version. 
For example, in Windows, using the example locations shown in �About Siebel Analytics Web Catalog 
Backup Files� on page 61, the current version of SiebelAnalytics.webcat would be tracked in:

c:\SiebelAnalyticsData\Web\Catalog\SiebelAnalytics.webcat.version

The version file is interrogated during Siebel Analytics Web startup:

■ If the version file does not exist, the Web Catalog is read from the original path specified in the 
CatalogPath registry key. (For more information about this key, see �Changing the Name and 
Location of the Siebel Analytics Web Catalog� on page 60.)
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■ If the path does not exist, the Web Catalog is created in the default location for the operating 
system, described in �Changing the Name and Location of the Siebel Analytics Web Catalog� on 
page 60.

■ If the version file exists, the backup file that it references (nnn.autosave) must also exist. If the 
backup file does not exist, Siebel Analytics Web will not start.

The version file is updated during Siebel Analytics Web shutdown. After a successful shutdown, the 
version file includes an entry indicating that the Web Catalog was successfully written to the original 
catalog path.

NOTE: The Siebel Analytics Web shutdown process does not create a Web Catalog backup file. 

When Changes Are Written to the Siebel Analytics Web Catalog
Changes made to the Web Catalog are written to the Web Catalog when the Analytics Web Server 
service is stopped. Until the service is stopped, changes are written to the current Web Catalog 
backup file.

When the Analytics Web Server service is started again, the Web Catalog is read, and any subsequent 
changes are written to the current backup file.

Setting the Number of Automatic Siebel 
Analytics Web Catalog Backups
Siebel Analytics Web automatically performs backups of the Web Catalog. The internal default is 10 
backups. You can override the default by modifying the Windows registry or the Siebel Analytics Web 
configuration file instanceconfig.xml to add the following entry. The minimum value is 3. 

Automatic backups are identified by nnn.autosave appended to the Web Catalog name, where nnn 
represents the sequential number assigned to the backup.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

CatalogMaxAutoSaves �20�

■ instanceconfig.xml example:

<CatalogMaxAutoSaves>20</CatalogMaxAutoSaves>

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

For more information about automatic Web Catalog backups, see �How the Siebel Analytics Web 
Catalog Backup Process Works� on page 61.
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Setting the Number of Minutes Between 
Backups of the Siebel Analytics Web 
Catalog
You can override the number of minutes that Siebel Analytics Web waits between creating automatic 
Web Catalog backups by modifying the Windows registry or the Siebel Analytics Web configuration 
file instanceconfig.xml to add the following entry. The internal default is 5 minutes. 

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

CatalogAutoSaveMinutes �10�

■ instanceconfig.xml example:

<CatalogAutoSaveMinutes>10</CatalogAutoSaveMinutes>

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.

Creating a New Siebel Analytics Web 
Catalog
The following procedure explains how to create a new Siebel Analytics Web Catalog.

To create a new Web Catalog

1 Stop the Analytics Web Server service.

NOTE: When Analytics Web is installed on a Microsoft IIS Web server, the IIS Web server creates 
temporary files for its Web caching capability in a location specified by the Microsoft IIS 
installation. If the Analytics Server is stopped before the Analytics Web Server, these temporary 
files usually remain, consuming disk space.

2 Stop these other services:

■ Siebel Analytics Server

■ Siebel Analytics Scheduler

■ Siebel Analytics Cluster Server

■ IIS Admin Service (Microsoft Internet Information Server), and any additional services that 
it wants to stop

3 Set the CatalogPath registry key or instanceconfig.xml entry to point to a new Web Catalog path 
that does not already exist.

For details, see �Changing the Name and Location of the Siebel Analytics Web Catalog� on page 60. 
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4 Make sure that there is no version file associated with the new Web Catalog and path and that 
the new target directory is empty.

5 Restart the services.

Recovering From a Failure to Load the 
Siebel Analytics Web Catalog
Siebel Analytics Web attempts to load the Web Catalog as part of its startup procedures. If it cannot 
load the Web Catalog, a failure message is logged in the operating system's application event log, 
and no one will be able to access Siebel Analytics Web. When possible, the system attempts to load 
the last saved Web Catalog, determined from the version file. (For information about the version file, 
see �How the Siebel Analytics Web Catalog Backup Process Works� on page 61.)

To recover from a failure to load the Web Catalog

1 Stop the Analytics Web Server service.

NOTE: When Analytics Web is installed on a Microsoft IIS Web server, the IIS Web server creates 
temporary files for its Web caching capability in a location specified by the Microsoft IIS 
installation. If the Analytics Server is stopped before the Analytics Web Server, these temporary 
files usually remain, consuming disk space.

2 Stop these other services:

■ Siebel Analytics Server

■ Siebel Analytics Scheduler

■ Siebel Analytics Cluster Server

■ IIS Admin Service (Microsoft Internet Information Server), and any additional services that 
it wants to stop

3 Make a backup of files related to the Web Catalog.

4 Rename the latest backup file (nnn.autosave) to the name of the original Web Catalog. 

For example, rename SiebelAnalytics.webcat.03.autosave to SiebelAnalytics.webcat.

5 Delete the associated version file (.version) file.

6 Restart the services.

If the Web Catalog still fails to load, repeat Step 3 through Step 6 with earlier backup files until 
Siebel Analytics Web starts successfully.
Siebel Analytics Web Administration Guide Version 7.7.1, Rev. B64 ■



Administering the Siebel Analytics Web Catalog ■  Moving a Siebel Analytics Web
Catalog to Another System
Moving a Siebel Analytics Web Catalog 
to Another System
This procedure explains how to move an existing Web Catalog to another Analytics installation. (For 
information about migrating a complete Siebel Analytics installation, see the Technical Notes section 
on SupportWeb.)

To move an existing Web Catalog to another system

1 Stop the Analytics Web Server service.

2 Stop these other services:

■ Siebel Analytics Server

■ Siebel Analytics Scheduler

■ Siebel Analytics Cluster Server

NOTE: When Analytics Web is installed on a Microsoft IIS Web server, the IIS Web server creates 
temporary files for its Web caching capability in a location specified by the Microsoft IIS 
installation. If Siebel Analytics Server is stopped before Siebel Analytics Web, these temporary 
files usually remain, consuming disk space.

When you stop the Analytics Web Server service, the Web Catalog is written to the path shown 
in the CatalogPath registry key or instanceconfig.xml entry. (For more information, see �Changing 
the Name and Location of the Siebel Analytics Web Catalog� on page 60.)

3 Verify successful shutdown by checking that the latest modified Web Catalog file is the original 
Web Catalog file with a .webcat extension, and not a backup file with an nnn.autosave extension. 

4 Copy the original Web Catalog file to the appropriate location on the new system. 

Optionally, you can also copy the version file (it has a .version extension).

NOTE: If you are migrating a Siebel Analytics environment to a new system, make sure you also 
migrate the Siebel Analytics Server repository file and the Scheduler tables. The Scheduler tables 
are required for iBots.

5 Restart the services.

NOTE: If you do not want to stop the services, you can copy the related Web Catalog files to the 
appropriate location on the new system. This includes the original Web Catalog file (.webcat 
extension), the Version file (.version extension), and the Web Catalog backup files (nnn.autosave 
extensions).
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Migrating Changes to Siebel Analytics 
Requests and Filters
When you create and save requests and filters in Siebel Analytics Web, the objects are saved in the 
Web Catalog. The requests and filters are saved with the logical object references as they exist in 
the Siebel Analytics metadata in the Presentation layer of the Siebel Analytics Server Administration 
Tool. 

If the Presentation layer metadata that affects these is changed through the renaming of objects, 
aliases are maintained for these objects that the Web Catalog can reference. 

However, if the Presentation layer metadata changes through the following ways, the link from the 
stored object in the Web Catalog to the metadata will be broken:

■ Aliases are deleted.

■ Objects are moved between Presentation Catalog Folders in the Presentation layer.

To repair those links within a stored request, you need to refresh the requests and filters.

To refresh requests and filters

1 Log on to Siebel Analytics Web and access Siebel Answers.

2 Open the broken request and click the Advanced tab.

3 Click the Enter SQL link.

4 Change the FROM clause to reference the new Subject Area (Catalog Folder in the Presentation 
layer) where the SELECT columns now reside. 

5 If the column names have been changed, those changes must also be applied.

6 Reapply any required filters using the new Presentation layer definitions.

7 Redefine any affected saved filters using the new Presentation layer definitions.

The changes are applied the next time that the Analytics Web Server service and the IIS Admin 
Service are started.

About Siebel Analytics Catalog Manager
Siebel Analytics Catalog Manager Siebel is a tool for Siebel Analytics Web administrators to perform 
offline management of the Siebel Analytics Web Catalog. It should be installed on a secure machine 
accessible only to Siebel Analytics Web administrators. Administrators can use Analytics Catalog 
Manager to perform the following functions:

■ Administrators can rename and delete content, and move and copy content within and between 
Web Catalogs. This is critical for installations that maintain distinct test and production systems, 
as well as those that are creating content on top of Siebel Analytics Stand-Alone. 

■ Administrators that have one or more Siebel Analytics applications installed can use Analytics 
Catalog Manager to generate a list of dashboard requests. The requests are distributed with 
Siebel Analytics applications.
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■ Analytics Catalog Manager allows administrators to upgrade their Siebel Analytics applications to 
new versions without losing any site-specific changes and enhancements.

■ Administrators that need to localize content can use Analytics Catalog Manager to export text 
strings for translation.

Opening Siebel Analytics Catalog 
Manager
Use only the procedure that follows to open Analytics Catalog Manager. Analytics Catalog Manager 
operates on the Web Catalog only when the Analytics Web Server service is stopped.

To open Analytics Catalog Manager

1 Stop the Analytics Web Server service.

NOTE: When Analytics Web is installed on a Microsoft IIS Web server, the IIS Web server creates 
temporary files for its Web caching capability in a location specified by the Microsoft IIS 
installation. If the Analytics Server is stopped before the Analytics Web Server service, these 
temporary files usually remain, consuming disk space.

2 Stop these other services:

■ Siebel Analytics Server

■ Siebel Analytics Scheduler

■ Siebel Analytics Cluster Server

■ IIS Admin Service (Microsoft Internet Information Server), and any additional services that 
it wants to stop. 

3 On the machine where Analytics Catalog Manager is installed, choose Start >Programs > Siebel 
Analytics > Siebel Analytics Catalog Manager.

The Analytics Catalog Manager window opens.

4 When you have finished working with Analytics Catalog Manager, restart the services.

Viewing the Siebel Analytics Catalog 
Manager Workspace
This section explains how to how to view items in the Analytics Catalog Manager workspace. It 
contains the following topics:

■ �How the Siebel Analytics Catalog Manager Workspace Appears� on page 68

■ �About Folders in the Siebel Analytics Catalog Manager Workspace� on page 68

■ �About Siebel Analytics Catalog Manager Columns in the Workspace� on page 68
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How the Siebel Analytics Catalog Manager Workspace Appears
Figure 2 shows how the Analytics Catalog Manager workspace appears after opening 
SiebelAnalytics.webcat and clicking the Web Catalog icon. (SiebelAnalytics.webcat is the Web 
Catalog distributed with Siebel Analytics applications.)

To view the Web Catalog tree structure
■ Do one of the following:

■ Double-click the Web Catalog icon.

■ Click a folder in the right pane.

About Folders in the Siebel Analytics Catalog Manager Workspace
The shared folder contains content that is shared among Analytics Web users. This includes the 
preconfigured dashboards and requests that are distributed with Siebel Analytics applications, and 
other items such as shared filters.

The system folder contains administrative elements of Siebel Analytics Web. Some of these elements 
are distributed with the product, and others are set up by the Siebel Analytics Web administrator, 
such as privileges.

The users folder contains content that Analytics Web users with the appropriate permissions have 
saved to their personal folders, such as individual requests.

About Siebel Analytics Catalog Manager Columns in the Workspace
The right pane of the Analytics Catalog Manager has four columns. One column, needing additional 
explanation, is described here.

Type. Identifies the type of item. Items that are identified as �unknown file� are generally internally-
used items, and their type is not exposed in Analytics Catalog Manager.

Figure 2. Analytics Catalog Manager Workspace

Web Catalog 
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Working with Siebel Analytics Catalog 
Manager Properties
Analytics Catalog Manager allows Siebel Analytics Web administrators to work with a subset of the 
administration functions available in Siebel Analytics Web. For example, you can modify an item�s 
properties, hide a request from display, and change user and group permissions to items in the Web 
Catalog.

For more information about setting permissions, see �Setting Siebel Analytics Web Permissions 
Through Analytics Catalog Manager� on page 97.

Other administration tasks, such as setting up new Web Groups, are performed using the 
administration features in Siebel Analytics Web. 

To view properties for an item
■ Double-click the item, or right-click the item in the Name list and choose Properties.

The Properties window for the item appears.

NOTE: The New button is used to create a new property. You should use it only if instructed to 
do so by Siebel Systems. The Read Only option is unused. The System option indicates that the 
item is maintained internally and should not be altered.
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Figure 3 is an example of the Properties window for a request named Top Partner Opportunities. This 
request is from the Overview page on the Channel Sales dashboard in the Siebel Partner Analytics 
application.

To hide an item from display in Siebel Analytics Web
■ Select the Hidden option.

Figure 3. Properties Window
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Copying and Pasting Content Between 
Siebel Analytics Web Catalogs
This section describes how to move content between Web Catalogs. 

Web Catalogs are structured in hierarchical folders. When copying or merging items, remember to 
also copy any items that are associated with them, such as dashboard folders, request links, and 
requests. URL paths may need to be re-established after a copy or merge operation if the entire 
folder path is not copied, for example, if added to the dashboard as a link or text.

NOTE: If you want to upgrade your existing Web Catalog with a newer version received from Siebel 
Systems, see �Updating the Siebel Analytics Web Catalog to a Newer Version� on page 72.

To copy and paste content between Web Catalogs

1 Make backup copies of both Web Catalogs.

2 Choose File > Open from the Analytics Catalog Manager toolbar and select the first Web Catalog 
to open.

This should be the Web Catalog that you want to change. The name of the Web Catalog that you 
opened appears in the title bar. 

TIP: It is recommended that you first open the Web Catalog that you want to change. If the 
catalogs have the same name, rename the second catalog before opening it.

3 Using the same instance of Analytics Catalog Manager, choose Choose File > Open from the 
Analytics Catalog Manager toolbar, and then select the second Web Catalog to open. 

This should be the Web Catalog that contains the content you want to copy. 

A second instance of Analytics Catalog Manager opens. The name of the second Web Catalog 
appears in the title bar of the second instance. 

4 If necessary, reposition both instances of Analytics Catalog Manager on your screen so you can 
clearly see the title bars of both Analytics Catalog Manager instances. 

5 To view the items that you can work with, expand the tree structure in the left pane, or double-
click an item in the right pane.

6 To copy content, highlight the source item in the source (second) Web Catalog and choose Edit 
> Copy. Then, highlight the corresponding target item in the target (first) Web Catalog and 
choose Edit > Paste.

You can also use drag-and-drop to copy and paste content.
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Updating the Siebel Analytics Web 
Catalog to a Newer Version
This section is for organizations that have Siebel Analytics applications and have customized Web 
Catalog content. It explains how to merge your current Web Catalog with a newer version received 
from Siebel Systems.

NOTE: If you made no changes to the Web Catalog distributed with version 7.5 or 7.7, this section 
does not apply to you. You can begin using the SiebelAnalytics.webcat Web Catalog distributed with 
version 7.7.1.

The update is done using Analytics Catalog Manager. The process compares the base Web Catalog 
distributed with the previous version with your customized Web Catalog to get a baseline of the 
changes, and then merges your existing Web Catalog content with the content from the previous 
version. This process preserves any site-specific changes that have been made to your Web Catalog, 
and allows Siebel Analytics Web administrators to accept or reject specific changes.

The update makes use of three Web Catalogs:

■ The Original Siebel Catalog, which is the Web Catalog that you received with your currently-
installed Siebel Analytics application. For most sites, this is the Web Catalog distributed with 
version 7.5 or 7.7 It is also distributed at the root level of the installation CD-ROM as the file 
SiebelAnalytics-n.n-GA.webcat, where n.n is the version number.

■ The Current Release Siebel Catalog, which is the Web Catalog that is installed with version 7.7.1 
as the file SiebelAnalytics.webcat.

■ The Modified Customer Catalog, which is the Web Catalog that you are currently using. In the 
following procedure, you will copy and rename this to SiebelAnalytics.webcat.old.

To update the Web Catalog to a newer version

1 Make a backup copy of your Modified Customer Catalog, rename it to SiebelAnalytics.webcat.old, 
and move it to a temporary location. 

This is to make sure that a copy of your current Web Catalog is available for use during the 
upgrade process. 

2 Install the new software version received from Siebel Systems according to the instructions given 
in Siebel Analytics Installation and Configuration Guide. 

This installs the Current Release Siebel Catalog, named SiebelAnalytics.webcat.

(If the software is already installed, you are prompted to uninstall it first. During the uninstall, 
if you select the option to keep your current Web Catalog, it is copied and renamed to 
SiebelAnalytics.webcat.old. You can use this Web Catalog, or the copy in the temporary location, 
during the upgrade process.)

3 Make sure that your current Siebel Analytics repository has been migrated to version 7.7.1.

For instructions, see Siebel Analytics Server Administration Guide.

4 Copy the Original Siebel Catalog from the installation CD-ROM into the location that holds your 
Modified Customer Catalog.
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5 Open Analytics Catalog Manager and open the Current Release Siebel Catalog, 
SiebelAnalytics.webcat.

6 Choose Tools > Upgrade Catalog.

The Upgrade Current Catalog window opens.

7 In the Initial Catalog area, browse to locate the Original Siebel Catalog, SiebelAnalytics-n.n-
GA.webcat.

8 In the Current Catalog area, browse to locate your Modified Customer Catalog, 
SiebelAnalytics.webcat.old.

9 Click OK.

Analytics Catalog Manager generates a baseline of the changes and compares your existing Web 
Catalog content with the content in the new version, merges in any changes, produces a request 
highlighting differences, and allows you to indicate how you want differences handled. If the Web 
Catalogs have conflicting content, you can choose which Web Catalog the content should be 
taken from.

The end result is a merged Web Catalog that contains the site-specific changes, as well as new 
Siebel metadata. When the merge process completes, the Current Release Siebel Catalog that is 
loaded into Analytics Catalog Manager contains the merged content. 

The merge process may take several minutes. A message alerts you when the merge is complete. 

NOTE: The log file SiebelAnalyticsMigrationLog.txt holds information about the merge process. 
This log file is written to the location that holds the Web Catalog. If you see an error logged in 
the file, this means that the path in question had a problem that did not allow the merge 
mechanism to resolve the merge. No action was taken. If you want to merge that particular item, 
go into your original Web Catalog and merge it manually.

10 Save the Current Release Siebel Catalog. 

This catalog contains the merged content.
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Text Strings
For organizations that need to localize text strings in the Web Catalog, this section explains how to 
export the text strings for translation, and then expose them when translation is complete. You and 
your localization team are responsible for escaping characters properly and resolving any errors in 
the translated text strings.

The export process is based on Extensible Markup Language (XML). The export process creates one 
XML file for every first-level subfolder in the shared folder, in the format foldernameCaptions.xml, 
where foldername is the name of the subfolder in the shared folder. Each XML file contains the text 
strings for all content in the corresponding first-level folder and its subfolders.

For example, if the shared folder in the Web Catalog contains the first-level folders Marketing, 
Service, and Sales, then the export process creates three XML files:

■ MarketingCaptions.xml

■ ServiceCaptions.xml

■ SalesCaptions.xml

After the content is translated, you will place these folders in the SiebelAnalyticsData directory. Their 
content is loaded when Siebel Analytics Web is started.

To export Web Catalog text strings

1 Stop the Analytics Web Server service.

2 Use Analytics Catalog Manager to open the Web Catalog that contains the text strings to be 
localized, and then choose Tools > Localization > Export.

3 Browse to select the location in which to write the output, and then click OK.

The export process may take several minutes.

4 Save the Web Catalog when prompted.

5 When the export process is complete, deliver the output file to your localization team.

You may need to make a copy of every output file for each language to be translated.

You can now restart the Analytics Web Server service and resume using Siebel Analytics Web.
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To expose Web Catalog text strings

1 Place the translated XML files into their corresponding location in the SiebelAnalyticsData 
directory:

SiebelAnalyticsData\Web\Res\l_xx\Captions

where xx is the language extension, as shown in the following table.

2 Restart the Analytics Web Server service to make the translated content available.

Language 
Extension Language

cs Czech

da Danish

de German

en English

es Spanish

fi Finnish

fr French

it Italian

ja Japanese

ko Korean

nl Dutch

pt Portuguese

pt-br Brazilian Portuguese

sv Swedish

zh Chinese (Simplified)

zh-tw Chinese (Traditional)
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Recommendations For Working with the 
Siebel Analytics Web Catalog
This section gives recommendations for working with Web Catalog content.

CAUTION: Make sure that the Analytics Catalog Manager is accessible only to Siebel Analytics Web 
administrators. As no login is required, full privileges for operations are granted to anyone who uses 
it.

■ Use Analytics Catalog Manager only when Siebel Analytics is not running. Never make 
modifications to an in-use Web Catalog.

■ Always make backups of the Web Catalogs that you are working with. Also back up the .version 
file.

■ When you want to work with two Web Catalogs, always open the second catalog from the 
Analytics Catalog Manager instance that you used to open the first catalog.

■ When you are copying or pasting content from one Web Catalog to another, you need to stay 
within the same relative structure. For example, you can copy a request from a User folder to 
another User folder, but not from a User folder to a Shared folder. 

■ Copying and pasting into email is not supported.

■ Do not attempt to reorder items in the Web Catalog using Analytics Catalog Manager.

Viewing Information About Siebel 
Intelligence Dashboards
This section explains how to use Analytics Catalog Manager to view information about dashboards. 
Organizations with Siebel Analytics applications can locate and view information about preconfigured 
dashboards.

This section contains the following topics:

■ �Exposing Dashboards and Requests in Siebel Analytics� on page 76

■ �Locating Dashboard and Page Names in Siebel Analytics� on page 77

Exposing Dashboards and Requests in Siebel Analytics
Depending on the Analytics options your organization purchased, the Siebel Analytics Web 
administrator may need to expose them before the associated dashboards and requests can be 
viewed in Siebel Analytics Web and in Analytics Catalog Manager. This applies to sites that have the 
following Siebel Analytics applications and options:

■ Siebel Sales Analytics, with the Forecasting and Incentive Compensation options.

■ Siebel Service Analytics, with the Universal Queuing, Email Response, and Agreements options.

■ Siebel Sales Analytics, with the Forecasting and Incentive Compensation options.

■ Siebel Partner Analytics, with the Partner Marketing, Partner ERM, and Partner ISS options.
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These options need to be exposed using the administration feature in Siebel Analytics Web. For 
instructions, see Siebel Analytics Installation and Configuration Guide.

Locating Dashboard and Page Names in Siebel Analytics
In Analytics Catalog Manager, the Web Catalog distributed with Siebel Analytics applications has the 
following structure:

Web Catalog > shared folder > Siebel Analytics application name > _Portal folder > dashboard name 
> dashboard page name

You can view the contents of a dashboard page in XML by clicking the Edit XML button when viewing 
the properties of a dashboard page. 

CAUTION: If you change the XML code, you are changing the representation of the object in the 
Web Catalog.

Using Analytics Catalog Manager to 
Rename Items in the Siebel Analytics 
Web Catalog
You can use Analytics Catalog Manager to rename items in the Web Catalog. This can be useful when 
you are migrating from a development environment to a production environment.

In production environments, you may prefer to use the Manage Catalog screen in the Siebel Analytics 
Web user interface to rename items. Doing so allows you to preserve references that other users 
might have to the prior name of the item. References are not preserved when you use Analytics 
Catalog Manager to rename items. For more information about the Manage Catalog screen, see 
�Administering Items in the Siebel Analytics Web Catalog� on page 78.

Example Procedure: Renaming a Shared Siebel Intelligence 
Dashboard Using Analytics Catalog Manager
The following procedure provides the steps to rename a shared dashboard using Analytics Catalog 
Manager.

CAUTION: Do not rename the �My Dashboard� dashboards in the Users folder.

To rename a shared dashboard using Analytics Catalog Manager

1 Stop the Siebel Analytics Web Server service.

2 Make backup copies of your Web Catalog and the version file.

For more information about the version file, see �How the Siebel Analytics Web Catalog Backup 
Process Works� on page 61.

3 Use Analytics Catalog Manager to open the Web Catalog and navigate to the dashboard you want 
to rename, for example, shared folder > _portal folder > dashboard name.
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4 Right-click the dashboard name, choose Rename, and type a new name for the dashboard.

5 Save the Web Catalog.

6 Restart the Analytics Web Server service.

Administering Items in the Siebel 
Analytics Web Catalog
You administer shared Web Catalog folders through the Manage Catalog screen of Siebel Analytics 
Web. You can view folders and contents including hidden items, and create, rename, copy, move, 
and delete folders and contents. You can also take ownership of an item. (Taking ownership of an 
item allows only you to make changes to it. This is useful if a user needs assistance with, for example, 
a request.)

For information about changing permissions to an item in the Web Catalog, see �About Setting Siebel 
Analytics Web Permissions� on page 94.

To display the shared Web Catalog folders

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the link Manage Analytics Catalog.

The Manage Catalog screen appears.

3 Click the Shared Folder link.

To show hidden items
■ Select the Show Hidden Items check box.

This allows you to see the following hidden items:

■ _Portal

■ _Filters

■ _Prefs

■ _Alerts

■ _iBots

■ _Delivers

NOTE: The availability of the Show Hidden Items check box is controlled by the See Hidden Items 
privilege. For more information, see �Default Siebel Analytics Web Privilege Assignments� on 
page 100.
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To create a new folder
■ Click the link Create New Folder and follow the instructions on the screen.

To view the contents of a folder
■ Click the name of the folder to see its content.

To take ownership of an item

1 Navigate to the item.

2 Click the Properties icon for the item.

The Item Properties screen appears.

3 If you have the appropriate authority, you can take ownership of the item or folder by clicking 
one of the following links:

■ Take Ownership of this item

■ Take Ownership of this item and all subitems

To rename a folder or an item

1 Navigate to the folder or item that you want to rename.

2 Click the Rename icon.

The Rename Item screen appears.

3 Type a new name for the item.

You can also type a description.

4 To preserve references that other users might have to the prior name of the item, select the 
following option:

Preserve references to the old name of this item

If you do not select this option, users referencing this item are no longer able to see it.

5 Click the Rename button.

To delete a folder or an item

1 Navigate to the folder that you want to delete.

2 Click the Delete icon for the folder.

The Confirm Item Deletion screen appears.

NOTE: When deleting shared folders or items, be aware that other users who have added shared 
items to their personal dashboards will no longer have access to them. 

3  To confirm the delete, click Yes.
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To copy or move an item

1 Navigate to the item.

2 Click Copy/Move icon for the item.

The Copy/Move Item Here screen appears.

3 Follow the instructions given on the screen.

■ To create a new folder, click the link Create New Folder and follow the instructions on the 
screen.

4 To show hidden items, select the Show Hidden Items check box.

This allows you to see the following hidden items:

■ _Portal

■ _Filters

■ _Prefs

■ _Alerts

■ _iBots

■ _Delivers

NOTE: The availability of the Show Hidden Items check box is controlled by the See Hidden Items 
privilege. For more information, see �Default Siebel Analytics Web Privilege Assignments� on 
page 100.

5 Click the Copy/Move Item Here button when you are done.
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This chapter explains how to set up Siebel Analytics Web security so that users have only:

■ Access to items in the Web Catalog that are appropriate to them.

■ The ability to perform actions that are appropriate to them.

Use this chapter if your organization uses Siebel Analytics Stand-Alone or if your organization uses 
Siebel Analytics applications, but has created additional content outside of the applications.

This chapter contains the following topics:

■ �Overview of Siebel Analytics Web Security� on page 82

■ �Types of Siebel Analytics Web Groups� on page 84

■ �Administering Siebel Analytics Web Groups� on page 85

■ �About Siebel Analytics Web User Authentication� on page 89

■ �About Siebel Analytics Web Groups and Siebel Analytics Session Variables� on page 90

■ �Inheritance of Siebel Analytics Web Permissions and Privileges� on page 91

■ �About Setting Siebel Analytics Web Permissions� on page 94

■ �Setting Siebel Analytics Web Permissions Through the Administration Screen� on page 96

■ �Setting Siebel Analytics Web Permissions Through Analytics Catalog Manager� on page 97

■ �About Setting Siebel Analytics Web Privileges� on page 99

■ �Setting Siebel Analytics Web Privileges� on page 99

■ �Default Siebel Analytics Web Privilege Assignments� on page 100

■ �Guidelines for Configuring Siebel Analytics Web Security for the Web Catalog and Dashboards� on 
page 102
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Overview of Siebel Analytics Web 
Security
This section provides an overview of Siebel Analytics Web security. It contains the following topics:

■ �Where Siebel Analytics Web Security Settings Are Made� on page 82

■ �Your Security Goals in Siebel Analytics Web� on page 82

■ �About Access Control and Permissions in Siebel Analytics Web� on page 83

■ �About User Rights and Privileges in Siebel Analytics Web� on page 83

■ �About User Authentication in Siebel Analytics Web� on page 84

Where Siebel Analytics Web Security Settings Are Made
Security settings that affect Siebel Analytics Web are made in the following Siebel Analytics 
components:

■ Server Administration Tool. This is where you perform the following tasks:

■ Set permissions for business models, tables, columns, and subject areas.

■ Specify database access for each user.

■ Specify filters to limit the data accessible by users.

■ Set authentication options.

For more information, see Siebel Analytics Server Administration Guide.

■ Siebel Analytics Web. This is where you set permissions to Web Catalog items, including 
dashboards, and the privilege to perform actions such as edit views, create iBots, and create 
prompts. 

■ Catalog Manager. This is where you set permissions to Web Catalog items, including 
dashboards.

Your Security Goals in Siebel Analytics Web
Your main security goals are to make sure that:

■ Only appropriate people can log on and access Siebel Analytics Web. This is achieved by 
assigning logon rights and authenticating users through the Siebel Analytics Server. For more 
information about authentication, see �About Siebel Analytics Web User Authentication� on 
page 89.

■ Employees can access only the data that is appropriate to them. This is achieved by applying 
access control in the form of permissions.

■ Employees have the ability to perform only actions that are appropriate to them. This is achieved 
by applying user rights in the form of privileges.
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About Access Control and Permissions in Siebel Analytics Web
Access control defines the ability of an account to access a shared Web Catalog item. Catalog items 
are folders and requests, where folders are application folders, dashboard folders, and dashboard 
page folders. 

An account is one of the following:

■ An individual user.

■ A Web Group that has one or more users as members.

Permissions describe the type of access to an object that an account is permitted. Examples are Read 
and Full Control.

Each Web Catalog item has an access control list that defines which accounts have which permissions 
to access the item. An access control list has the general form shown in Table 4.

For more information about permissions, see �About Setting Siebel Analytics Web Permissions� on 
page 94.

About User Rights and Privileges in Siebel Analytics Web
Privileges are the actions that users have the right to perform in Siebel Analytics Web. Example 
privileges are �Edit system-wide column formats� and �Create iBots.� 

Privileges are managed by associating them with accounts, that is, individual users or Web Groups. 
A specific account is either granted or denied a specific privilege. These associations are created in 
privilege assignment tables. 

Table 4. Access Control List For a Catalog Item

Account Permission

Web Group 1 Read

Web Group 3 Full Control

Web Group 8 Read

User 4 Read

User 9 Full Control

User 11 Full Control
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The general form of a privilege assignment table is shown in Table 5 on page 84. The Web Groups in 
the right column are granted the privileges in the left column.

For more information about privileges, see �About Setting Siebel Analytics Web Privileges� on page 99.

About User Authentication in Siebel Analytics Web
Authentication is the process of using a username and password to identify a someone who is logging 
on. Authenticated users are then given appropriate authorization to access a system, in this case 
Siebel Analytics Web. Siebel Analytics Web does not have its own authentication system; it relies on 
the authentication system built into the Siebel Analytics Server.

For more information about authentication, see �About Siebel Analytics Web User Authentication� on 
page 89.

Types of Siebel Analytics Web Groups
Web Groups are defined by the system or by a Siebel Analytics Web administrator. When a user is 
assigned to a Web Group, the user becomes a member of that group. Web Group membership is used 
to determine the permissions and privileges that are associated with a user, either by explicit 
assignment or inheritance. 

Web Groups can also be thought of as roles for users because they avoid ambiguity about which 
defaults, preferences, and so on, to assign directly to the user. 

This section contains the following topics:

■ �System-Defined Web Groups in Siebel Analytics Web� on page 84

■ �Administrator-Defined Web Groups in Siebel Analytics Web� on page 85

System-Defined Web Groups in Siebel Analytics Web
System-defined Web Groups are preconfigured and required for successful Siebel Analytics Web 
operations. There are three types of system-defined Web Groups:

Table 5. Privilege Assignment Table

Privilege Accounts That Have Been Granted the Privilege

Privilege 1 Web Group 2, Web Group 4

Privilege 2 Web Group1, Web Group 3

Privilege 3 Web Group 1, user 3

Privilege 4 Web Group 1, user 1, user 4, user 6 

Privilege 5 Web Group 2, Web Group 3, user 4
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■ Everyone. By default, all users belong to the Everyone group. This is why the group does not 
appear on the Groups and Users screen of the application.

■ Authenticated Users. When a user is authenticated by the Analytics server, the user 
automatically becomes a member of the Authenticated Users group. The Authenticated Users 
group is itself a member of the Everyone group.

■ Web Administrators. Members of the Web Administrators group are users who are Siebel 
Analytics Web administrators. The default member of this group is the Siebel Analytics Web 
administrator. By default, only members of the Web Administrators group have access to 
administrative functions, but this can be changed by changing privilege assignments.

Administrator-Defined Web Groups in Siebel Analytics Web
Administrator-defined Web Groups are created by the Siebel Analytics Web administrator. You can 
create an unlimited number of Web Groups in Siebel Analytics Web.

NOTE: For organizations that have Siebel Analytics applications, preconfigured groups are set up 
with preconfigured responsibilities. For more information, see Siebel Analytics Installation and 
Configuration Guide. 

The Web Groups that you define should be used to categorize users who require similar access to 
dashboards and content. You should plan your Web Catalog folder structure and Web Groups 
together to create a coherent security model. For more information about Web Catalog structure, 
see Chapter 6, �Administering the Siebel Analytics Web Catalog.� For more information about how Web 
Group membership can be passed from the Siebel Analytics Server, see �About Siebel Analytics Web 
User Authentication� on page 89.

Administering Siebel Analytics Web 
Groups
When you create a Web Group, a group folder is automatically created in the Web Catalog. All 
members of the Web Group are given Read permissions to this folder.

To create a Web Group

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the following link:

Manage Web Groups and Users

3 Under Existing Web Groups, scroll down and click the following link:

Create a new Web Group

The Create Web Group screen appears. 
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4 Enter a name for the group in the Group Name text box.

The name of the Web Group must not match the name of any user who will log on to Siebel 
Analytics Web. This match is not case sensitive. For example, the user name FOO2 matches the 
Web Group named foo2 or FoO2. If a user and a Web Group share the same name, the user 
receives an Invalid Account message when attempting to log on to Siebel Analytics Web.

NOTE: If the name of a Siebel Analytics Server group (which is set up in the Siebel Analytics 
Administration Tool) matches the name of a Web Group, members of the Siebel Analytics Server 
group automatically become members of the Web Group when they log on to Siebel Analytics 
Web. Their membership ceases when they log off. The name of the user never appears to a Siebel 
Analytics Web administrator as a member of the Web Group. The user appears only as a member 
of the Authenticated Users group. If you prefer to use Web Group names that match Siebel 
Analytics Server group names, but want users to be viewable as members of the group, with 
persistent group membership, you must explicitly add the users to the Web Group using the Web 
Security: Groups and Users screen.

5 (Optional.) Enter a password for the group in the Password text box, and type the password again 
in the Verify Password text box.

Users are prompted for the password when they attempt to join the group.

6 In the Dashboard Name text box, type a name for the dashboard.

You can assign an existing dashboard to the Web Group or create a new dashboard for the Web 
Group. Whichever option you choose, all members of the Web Group are granted Read access to 
the designated, default dashboard. If you do not want to create a dashboard now, you can create 
one later from the Manage Dashboards screen. 

If you do create a new, empty dashboard, it is created within a new, like-named shared folder. 
Group members will have Read permission to this folder. 

7 In the Dashboard Builder box, specify the name of the user or group that has permission to 
change the contents of the dashboard. Separate multiple entries with a comma, for example, 
user1,salesgroup.

8 Click Finished.

NOTE: Siebel Analytics Web automatically gives a newly created Web Group Read permission to the 
automatically created group folder. For manually created group folders, you should set the 
permissions to the Group folder for the appropriate groups to Read. 

To delete a Web Group

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the following link:

Manage Web Groups and Users
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3 Under Existing Web Groups, in the Web Groups table, locate the group you want to delete and 
click the Delete icon.

The Confirm Group Deletion screen appears. 

4 Click Yes to confirm the delete.

5 In the Web Security: Groups and Users screen, click Finished.

NOTE: The procedure for deleting a Web Group does not delete any group definitions in a Siebel 
Analytics Repository. 

To add a user or group to an existing group

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the following link:

Manage Web Groups and Users

3 Under Existing Web Groups, in the Web Groups table, locate the group whose membership you 
want to change.

4 Click the Edit icon.

The Edit Web Group screen appears. 

5 In the Group Membership area, click the link Add New Member.

The Add Member to Group screen appears.

6 In the Member Name text box, type the name of the user or group you want to add and click the 
Add Member button.

The Edit Web Group screen appears. 

The Group Membership area now shows the list of the current members of the group. 

7 Click Finished.

To delete a user or group from an existing group

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the following link:

Manage Web Groups and Users
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3 Under Existing Web Groups, in the Web Groups table, locate the group whose membership you 
want to change and click the Edit icon.

The Edit Web Group screen appears. 

4 Under Group Membership, in the Members table, locate the member you want to delete and click 
the Remove icon. 

5 (Optional.) At the Edit Web Group screen, change the password for the group. 

6 Click Finished.

NOTE: You cannot delete system-defined Web Groups or the user name Administrator.

To change the password for a group

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the following link:

Manage Web Groups and Users

3 Under Existing Web Groups, in the Web Groups table, locate the group whose password you want 
to change and click the Edit icon.

The Edit Web Group screen appears. 

The Password and Verify Password boxes are blank. 

4 Under Group Properties, in the Password box, type the new password. 

5 In the Verify Password box, type the password a second time to verify it. 

6 Click Finished.

To delete a user from Siebel Analytics Web

1 Under Authenticated Web Users, in the Web User and Group Membership table, locate the user 
you want to delete and click the Delete icon. 

The Confirm User Deletion screen appears. 

2 Click Yes to confirm the delete.

3 In the Web Security: Groups and Users screen, click Finished. 

NOTE: The procedure for deleting a user from Siebel Analytics Web does not delete any user 
definitions in a Siebel Analytics Repository. If the user logs on again, their Siebel Analytics Web entry 
is recreated.
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About Siebel Analytics Web User 
Authentication
When users log on, they are authenticated by the Siebel Analytics Server using the authentication 
method specified in the Siebel Analytics Server configuration file NQSConfig.INI. 

This section briefly describes the authentication methods that are relevant to Siebel Analytics Web 
users, in the context of Siebel Analytics Web. It contains the following topics:

■ �Siebel Analytics LDAP or ADSI Authentication� on page 89

■ �Siebel Analytics External Table Authentication� on page 89

■ �Siebel Analytics Database Authentication� on page 90

■ �Siebel Analytics Internal Authentication� on page 90

For detailed information about authentication options, see Siebel Analytics Server Administration 
Guide.

Siebel Analytics LDAP or ADSI Authentication
If you are using LDAP or ADSI authentication to provide Siebel Analytics Server access control, you 
may also configure your LDAP or ADSI server to provide other security information. For example, 
you could configure the name that is displayed in the Welcome text when the user logs on to Siebel 
Analytics Web, and is specific to the Web Groups to which the user belongs. This information is 
contained in LDAP variables, which are passed to the Analytics server session variables during the 
process of user authentication.

The variable USER is a system session variable that is used with LDAP or ADSI authentication. 
Whenever users log on to Siebel Analytics Web, their usernames and passwords are passed to the 
LDAP or ADSI server for authentication. After successful authentication, other system or non-system 
session variables for each user can be populated from information returned by the LDAP or ADSI 
server.

For more information about session variables, see �About Siebel Analytics Web Groups and Siebel 
Analytics Session Variables� on page 90.

Siebel Analytics External Table Authentication
If you are using an external database table for authentication, the table can contain additional access 
control information. This includes the name that is displayed in the Welcome text when the user logs 
on to Siebel Analytics Web, and the Web Groups to which the user belongs.

Whenever users log in, their usernames and passwords are authenticated through SQL that queries 
this database table for authentication. After successful authentication, the results of this SQL query 
can be used to populate other system and non-system session variables for each user.

For more information about session variables, see �About Siebel Analytics Web Groups and Siebel 
Analytics Session Variables� on page 90.
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Siebel Analytics Database Authentication
The Siebel Analytics Server can authenticate users through database logons. When a user attempts 
to log on to Siebel Analytics Web, the Analytics server attempts to use the logon name and password 
to connect to the authentication database, using the first connection pool associated with it. If this 
connection succeeds, the user is considered to be authenticated successfully.

Database authentication provides no mechanism to return additional access control information, 
such as the user�s display name or Web Group membership. If you are using database authentication, 
alone or in conjunction with external table authentication, you need to explicitly add users to the 
appropriate Web Group.

NOTE: Siebel Delivers does not work with database authentication. For more information, see �About 
Siebel Delivers iBots and Impersonation� on page 43.

Siebel Analytics Internal Authentication
The Siebel Analytics Server internal authentication method has no way to return additional access 
control information. If you are using Analytics server internal authentication, you need to explicitly 
add users to the appropriate Web Group, because the GROUP variable is not used with internal 
authentication.

About Siebel Analytics Web Groups and 
Siebel Analytics Session Variables
If the Siebel Analytics Server is using an external table or LDAP server for authentication, you must 
configure system session variables in the repository. 

A session variable block contains the SQL statement that is issued when each session begins. This 
block can contain system session variables with fixed meanings (such as USER, GROUP, 
DISPLAYNAME, and WEBGROUP) and other non-system session variables unique to your particular 
environment. See Siebel Analytics Server Administration Guide for additional information about 
using session variables.

You should also create a Web group to match each possible value returned in the GROUP or 
WEBGROUPS variable for which you want to control privileges and permissions to Siebel Analytics 
Web components and requests. 

This section contains the following topics:

■ �About the Siebel Analytics GROUP Session Variable� on page 91

■ �About the Siebel Analytics WEBGROUPS Session Variable� on page 91

■ �Setting Permissions and Privileges in Siebel Analytics Web� on page 91
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About the Siebel Analytics GROUP Session Variable
The GROUP variable contains one or more group names, separated by semicolons, that are also used 
by the Analytics server for security and content filtering. In many cases, these same groups are 
sufficient to control access to Siebel Analytics Web content. Siebel Analytics applications have been 
preconfigured to use this GROUP variable technique to inherit group memberships from the Analytics 
server.

About the Siebel Analytics WEBGROUPS Session Variable
The WEBGROUPS session variable allows greater flexibility because you can define Web Groups that 
categorize the roles, or classes, of Web users. For example, you might create the following groups:

■ A Basic group that can only access the dashboard.

■ A Standard group that has minimal access to Siebel Answers.

■ A Power Users group that has full access to Siebel Answers and minimal access to iBots (Siebel 
Delivers).

■ An Administrative group with full access to all features.

Setting Permissions and Privileges in Siebel Analytics Web
When you have set up the Web Groups, create a Web Catalog folder structure and assign appropriate 
privileges and permissions to each group. Keep in mind that each user can be associated with 
multiple roles by being a member of multiple Web Groups. Although WEBGROUPS can be used to 
control access to Web Catalog content (permissions), usually GROUP controls content and 
WEBGROUPS controls the ability to perform actions (privileges).

NOTE: Some GROUPs may not have corresponding Web content. In this case, when you create the 
group, you can delete the group folder created for the group in the 
/Shared folder, and give the group permission to the other group folders and subject area folders as 
appropriate (see Chapter 6, �Administering the Siebel Analytics Web Catalog� for more information).

For more information about the sequence in which to set up security, see �Guidelines for Configuring 
Siebel Analytics Web Security for the Web Catalog and Dashboards� on page 102.

For more information about permissions, see �About Setting Siebel Analytics Web Permissions� on 
page 94. 

For more information about privileges, see �About Setting Siebel Analytics Web Privileges� on page 99.

Inheritance of Siebel Analytics Web 
Permissions and Privileges
Permissions and privileges can be assigned to users directly or through membership in groups. From 
another perspective, permissions and privileges can be assigned explicitly or effectively. Effective 
permissions and privileges are assigned indirectly through Web Group inheritance, which is the 
recommended way to set up your security. Permissions and privilege inheritance occurs when one 
Web Group is a member of another Web Group.
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This section contains the following topics:

■ �Rules For Inheritance in Siebel Analytics Web� on page 92

■ �Example of Inherited Privileges in Siebel Analytics Web� on page 93

Rules For Inheritance in Siebel Analytics Web
■ Any permissions or privileges given explicitly to a user override any permissions or privileges 

inherited from the Web Group to which the user belongs.

As an example, All Authenticated Users have access to Dashboard X, except for George.

■ If a user belongs to two groups and both groups are assigned permissions the least restrictive 
permissions are given to the user. 

For example, if one group allows Read access and another allows Change access, the least 
restrictive access would be granted; in this example, Change access.

NOTE: The exception to this is if one of the two groups is explicitly denied the permissions, in 
which case the user is denied.

■ If a user belongs to Web Group X, and Web Group X belongs to Web Group Y, any rule assigned 
to group X overrides any rule assigned to group Y.

For example, if Marketing has Read permissions, Marketing Administrators, which is a member 
of Marketing, can have Full Control permissions.

■ Explicitly denying access takes precedence over any other permissions or privileges.

When assigning permissions or privileges it often useful to look at resolved permissions for users and 
groups at the bottom of the screen to make sure that everyone is inheriting correctly.
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Example of Inherited Privileges in Siebel Analytics Web
Figure 4 shows an example of how privileges are inherited through Web Groups.

In this example:

■ User1 is a direct member of Group 1 and Group 2, and is an indirect member of Group 3, Group 
4, and Group 5.

■ The permissions and privileges from Group 1 are no access to DashboardA, Read access to 
DashboardB, and Full Control over DashboardC.

■ If permissions and privileges are conflicting, the least restrictive level of authority is granted. 
Therefore, the inherited permissions and privileges from Group 2 include Change and Delete 
access to DashboardD.

■ Specifically prohibiting access always takes precedence over any other settings. Therefore, 
Group 1�s denial of access to DashboardA overrides Group 4�s Read access. The result is that 
Group 1 provides no access to DashboardA. Likewise, Group 5 provides no access to DashboardE 
because access to it is explicitly denied in Group2.

Figure 4. Example of Web Group Privilege Inheritance
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The total permissions and privileges granted to User1 are as follows:

■ No access to DashboardA and DashboardE because access is specifically denied.

■ Read access to DashboardB.

■ Full Control over DashboardC.

■ Change and Delete access to DashboardD.

TIP: It is recommended that you do not add the default Everyone or Authenticated Users Web 
Groups to any other Web Groups that you create. This makes sure that only the desired Web Groups 
(and users) have the specified permissions and privileges, by preventing users or authenticated 
users from unintentionally inheriting permissions and privileges from another Web Group.

About Setting Siebel Analytics Web 
Permissions
Permissions are used to control access to shared information contained in:

■ Siebel Analytics Web Catalog items

■ Siebel Intelligence Dashboards

Permissions, which may be explicitly set or inherited, are configured from:

■ Siebel Analytics Web Administration screen

■ Analytics Catalog Manager

To set permissions in the Web Catalog using Analytics Catalog Manager, Siebel Analytics Web 
must not be running. Use this option when you are working in a development environment or 
when you plan to make many changes. You can set permissions from the level of the application 
all the way down to individual requests in either Siebel Analytics Web or Siebel Analytics Web 
Catalog.

This section contains the following topics:

■ �Types of Permissions in Siebel Analytics Web� on page 94

■ �Recommendations For Setting Permissions in Siebel Analytics Web� on page 95

Types of Permissions in Siebel Analytics Web
Siebel Analytics Web supports four permissions:

■ No Access. Access is not allowed for this user or group. Explicitly denying access takes 
precedence over any other permission.

■ Read. Authority given to view the contents of the item, folder or dashboard, but cannot make 
any changes.
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■ Change/Delete. Authority given to view content, and make changes or delete the content.

■ Full Control. Authority given to view content, make changes or delete the content, set 
permissions, and delete the item, folder or dashboard.

Recommendations For Setting Permissions in Siebel Analytics Web
Follow these recommendations when setting permissions:

■ Assign permissions through Web Group membership, even if you want to assign permissions for 
a single user. For more information, see �Types of Siebel Analytics Web Groups� on page 84.

■ Set the permission to the Group folder for the appropriate groups to Read. 

■ For groups (or users, if necessary) that are going to be modifying the dashboards and dashboard 
content accessible to the group, set the permissions for the group to Full Control. This is often a 
dashboard or content builder group. While allowing change and delete control, Full Control also 
allows the specified group (or user) to set permissions, and to delete the item, folder, or 
dashboard.

■ For each Subject Area, grant Read permissions to the corresponding Subject Area folder within 
the Requests folder (and everything it contains). Make sure that the Authenticated Users and 
Everyone groups have no access effective permission to the Subject Area folder. 

■ For groups that should be able to save requests for public use against a given Subject Area, grant 
them Full Control to the Subject Area folder and everything it contains, and likewise for the 
Common folder. See the Change Item Permissions help for details on managing permissions for 
folders, items, and dashboards.

■ To make sure that only members of the designated Web Groups (or users) have access to Siebel 
Analytics Web Catalog folders, folder content, and Siebel Intelligence Dashboards, do not set 
explicit permissions for the default Web Groups Authenticated Users or Everyone.

NOTE: Siebel Analytics Web does not allow you to remove permissions for yourself or for the 
administrator. This prevents you from locking yourself out of an item, folder, or dashboard.

TIP: If you want to provide a place for all users within a group to share requests with each other, 
create a folder under the Subject Area folder called, for example, Share or Publish, and give the 
entire group Change/Delete permission to just that folder.
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Setting Siebel Analytics Web 
Permissions Through the Administration 
Screen
You can change permissions to Web Catalog items through the Administration screen of Siebel 
Analytics Web. 

To change permissions for a shared dashboard

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the link Manage Intelligence Dashboards.

3 In the row of the dashboard for which you want to change permissions, click the Permissions icon.

The Change Item Permissions screen appears. 

4 In the access control list, select a user or group, and click the corresponding link to toggle 
through the types of permissions.

5 Click the following link, if appropriate:

Replace permissions with parent folder�s permissions

6 Select one or both of the following options, as appropriate:

■ Apply permissions to subfolders

■ Apply permissions to items within folder

7 Click Finished. 

8 In the Manage Dashboards screen, click Finished.

To change permissions for a dashboard page

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the link Manage Intelligence Dashboards.

3 In the row of the dashboard for which you want to change permissions, click the Properties icon.

4 In the Existing Pages area, identify the page and click the associated Security icon.

5 In the access control list, select a user or group, and click the corresponding link to toggle 
through the types of permissions.
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6 Click the following link, if appropriate:

Replace permissions with parent folder�s permissions

7 Select one or both of the following options, as appropriate:

■ Apply permissions to subfolders

■ Apply permissions to items within folder

8 Click Finished, and then click either Yes or Yes All to confirm the override of permissions.

9 In the Dashboard Properties page, click Finished.

10 In the Manage Dashboards page, click Finished.

To change permissions for a shared Web Catalog item

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the link Manage Analytics Catalog.

3 Click the Shared Folder link to make sure you are working with shared folders.

4 Click a folder link and drill down to the relevant item.

5 In the row of the relevant Web Catalog item, click the Permissions icon.

The access control list for the item appears.

6 Identify the user or group that has explicit access to this item and whose permission you want 
to change.

7 Click the link next to the group or user until the permission that you want to assign appears.

8 Click Finished. 

9 In the Confirm Override of Permissions section, click Yes to confirm.

Setting Siebel Analytics Web 
Permissions Through Analytics Catalog 
Manager
You can change permissions to Web Catalog items through Analytics Catalog Manager. For general 
information about Analytics Catalog Manager, see Chapter 6, �Administering the Siebel Analytics Web 
Catalog.�
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To set permissions

1 Open Analytics Catalog Manager (see �About Siebel Analytics Catalog Manager� on page 66).

2 Navigate to an item.

3 To review permissions for the item, right-click the item in the Name list and select Permissions.

The Explicit Permissions list on the left side of the window shows the users and groups that have 
explicit permissions granted to this item. The Effective Permissions list on the right side of the 
window shows the users and groups that have access granted though group inheritance, and 
users and groups that have no access to the request.

4 If you need to move a user or group into the Explicit Permissions list, select the name in the 
Effective Permissions list and click the left arrow button ( < ). 

NOTE: To change a permission for user or group, it must be in the Explicit Permissions list. To 
view groups only, select the option Show groups only. 

5 Select a user or group in the Explicit Permissions list.

6 Select the new permission from the drop-down list following the Explicit Permissions list. 

7 Click OK to accept the changes.

Permission What It Means

R Read permission.

W Write permission

X Traverse Folder permission. You can view the folders within this folder.

D Delete permission.

P Change Permission authority. You can alter the permissions on the item.

O Owner permission, also known as Full Control. This includes the permissions 
in this table and means that you have full control over the item. This is the 
level of authority granted by default to the preconfigured Administrator user 
ID.
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8 Close the Permissions window. 

NOTE: If you move a user or group from the Explicit Permissions list to the Effective Permissions list, 
the user or group privileges are reset to No Access. To move users or groups from one window to 
another, highlight them and click the right or left arrow button as appropriate. 

About Setting Siebel Analytics Web 
Privileges
Privileges are the actions that users have the right to perform in Siebel Analytics Web. They are 
managed by associating them with accounts, that is, individual users or Web Groups. A specific 
account is either granted or denied a specific privilege. These associations are created in privilege 
assignment tables.

Like permissions, privileges are either explicitly set or inherited through group membership. 
Explicitly denying a privilege takes precedence over any granted, inherited privilege. For example, if 
a user is explicitly denied access to the privilege to edit column formulas in Siebel Answers, but is a 
member of a group that has inherited the privilege, the user cannot edit column formulas.

Unlike permissions, privileges are more commonly granted to the Everyone system Web Group. This 
allows users access to common Siebel Analytics Web features and functions.

For a list of some Siebel Analytics Web privileges, see �Default Siebel Analytics Web Privilege 
Assignments� on page 100.

Setting Siebel Analytics Web Privileges
The following procedures are used to administer privileges.

To assign a user or group to a privilege

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the Manage Privileges link.

3 Locate the privilege you want to change.

4 Click the user or Web Group name on the same row as the privilege.

The Privilege screen appears. 

The screen contains two tables. The top table lists Web Groups and users with explicitly assigned 
privileges. The bottom table lists Web groups with inherited access (effective permissions) to this 
privilege.
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5 (Optional.) To toggle the display to include users with inherited access, click the following link:

Show users and groups

6 In the bottom table, identify the group or user to allow explicit access and click the Add link on 
the same row. 

The Web group or user is added to the top table. 

NOTE: By default, a user who creates an item has the permission to change it. However, in some 
cases, this privilege should be disabled. Make the appropriate changes to deny the target user or 
group access to the Admin: Catalog Change Permissions privilege.

To change explicit access to a privilege

1 In Siebel Analytics Web, do one of the following:

■ If you are running Siebel Analytics stand-alone, click the Admin link.

■ If you are using a Siebel Analytics application, choose View > Site Map and access Analytics 
Administration.

2 Click the Manage Privileges link.

3 Locate the privilege you want to change in the upper table.

4 Do one of the following:

■ Click the link to toggle between Granted and Denied.

■ Click the Remove Permissions icon to delete explicit access to the privilege. In this case, the 
Web group or user moves to the bottom table, displaying inherited permissions. 

5 Click Finished.

Default Siebel Analytics Web Privilege 
Assignments
Table 6 lists some privileges that can be controlled, along with the Web Group that is granted access 
to that privilege by default.
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These privileges apply to Siebel Analytics Stand-Alone only. If you are using Siebel Analytics 
applications, see Siebel Analytics Installation and Configuration Guide for information about 
preconfigured privileges, called responsibilities.

Table 6. Privileges and Default Settings for Siebel Analytics Stand-Alone

Component Privilege Description
Web Group Granted 
Permission

Access Access to Siebel Answers Everyone

Access to Siebel Delivers and iBots Everyone

Access to Siebel Analytics Web Administration Web Administrators

Admin: Catalog Change Permissions Everyone

Admin: General Manage Sessions Web Administrator

Manage Dashboards Web Administrators

Admin: Security Manage Web Groups and Users Web Administrators

Manage Privileges Web Administrators

Take Ownership of Catalog Objects Web Administrators

Catalog Personal Storage (My Folders and My 
Dashboard)

Everyone

Formatting Edit system-wide column formats Web Administrators

Edit personal column formats No Access

Siebel Answers Create Views Everyone

Create Prompts Everyone

Access the Advanced tab Everyone

Edit Column formulas Everyone

Edit Column filters Everyone

Advanced SQL Everyone

Siebel Delivers and 
iBots

Retrieve delivery destinations for iBots 
(system call)

Web Administrators

Create iBots Everyone

Publish iBots for subscription Everyone

Deliver iBots to specific or dynamically 
determined users

Web Administrators

Chain iBots together Everyone

Chain iBots to custom scripts Web Administrators
Siebel Analytics Web Administration Guide Version 7.7.1, Rev. B ■ 101



Managing Siebel Analytics Web Security ■  Guidelines for Configuring Siebel Analytics 
Web Security for the Web Catalog and Dashboards
Guidelines for Configuring Siebel 
Analytics Web Security for the Web 
Catalog and Dashboards
To set up a secure Web Catalog and secure dashboards, you must understand the information 
presented in the previous chapters, because you will be working with Web Catalog, dashboards, and 
Web Groups.

This section contains the following topics:

■ �Creating Siebel Analytics Web Groups� on page 103

■ �Setting Up the Siebel Analytics Web Catalog Structure� on page 103

■ �Setting Permissions To Siebel Analytics Web Catalog Items� on page 104

■ �Creating Shared Siebel Intelligence Dashboards� on page 105

■ �Adding Shared Siebel Intelligence Dashboards Pages and Content� on page 105

■ �Adding Shared Siebel Analytics Content� on page 106

■ �Testing the Siebel Intelligence Dashboards� on page 106

Subject Area (by its 
name)

Access within Siebel Answers Everyone

View: Chart Add and Edit Chart View Everyone

View: Column Filter Add and Edit Column Filter View Everyone

View: Compound Add and Edit Compound View Everyone

View: Filters Add and Edit Filters View Everyone

View: Global Filters Add and Edit Global Filter View Everyone

View: Image Add and Edit Image View Everyone

View: Logical SQL Add and Edit Logical SQL View Everyone

View: Narrative Add and Edit Narrative View Everyone

View: Pivot Table Add and Edit Pivot Table Everyone

View: Question Add and Edit Question View Everyone

View: Static Text Add and Edit Static Text View Everyone

View: Table Add and Edit Table View Everyone

View: Ticker Add and Edit Ticker View Everyone

View: Title Add and Edit Title View Everyone

Table 6. Privileges and Default Settings for Siebel Analytics Stand-Alone

Component Privilege Description
Web Group Granted 
Permission
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■ �Setting Up a Virtual Directory For Shared Siebel Analytics Documents� on page 107

■ �Releasing Siebel Intelligence Dashboards To the User Community� on page 107

Creating Siebel Analytics Web Groups
When you create a Web Group, a shared Web Catalog group folder is automatically created. For more 
information about Web Groups, see �Types of Siebel Analytics Web Groups� on page 84. For more 
information about the group folder, see Setting Up the Siebel Analytics Web Catalog Structure.

Setting Up the Siebel Analytics Web Catalog Structure
The Web Catalog has two main folders:

■ /Shared. Contains the personal storage and My Dashboards for each user.

■ /User. Contains shared folders, shared dashboards, and shared dashboard content.

Figure 5 shows the recommended higher-level folder structure for the Web Catalog.

Figure 5. Recommended Catalog Folder Structure
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The Web Catalog structure shown in Figure 5 makes it easier for users and administrators to 
reorganize content and make shared dashboard sections available. This, in turn, facilitates My 
Dashboard creation by allowing users to select from shared content.

Items shown within brackets ( [ ] ) are optional. Items shown within angle brackets ( < ) should be 
replaced with the appropriate name.

Group Folder

When you create a Web Group, the system automatically creates a shared folder for the group. All 
members of the Web Group are automatically given Read permissions to this folder. These 
permissions are inherited by any subfolders that you create.

Group folders hold shared dashboard content that pertains to only members of the Web Group. The 
shared content can be further organized into subfolders under the Group folder.

NOTE: You may want to remove this folder and grant group permissions to other folders if there is 
no group-specific content.

Common Folder

Dashboard sections that are shared across groups are saved in a Common folder under the /Shared 
folder. Content can be organized into subfolders under the Common folder.

Requests Folder

When you create requests in Siebel Answers that you want to share, save them in a Requests folder 
in the /Shared folder. 

Create a folder for each subject area in the Requests folder for storing requests against that subject 
area. This allows you to manage permissions at the level of the subject area. If two or more subject 
areas are closely related, so that users with permission to one would almost always have permission 
to the other, you could create a single folder to store requests against both subject areas. 

NOTE: If a user is given permission to a request in the Web Catalog that references a Subject Area 
to which the user does not have permission, the Siebel Analytics Server still prevents the user from 
executing the request.

In cases where you have requests that span subject areas (requests that involve SQL subqueries), 
you can put them in the folder for any of the subject areas, or create a new folder for users that have 
permission to these subject areas.

For more information about working with the Web Catalog, see Chapter 6, �Administering the Siebel 
Analytics Web Catalog.�

Setting Permissions To Siebel Analytics Web Catalog Items
Before setting permissions to the Web Catalog items you have created, review the information in 
�About Setting Siebel Analytics Web Permissions� on page 94.
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Creating Shared Siebel Intelligence Dashboards
After setting up the Web Catalog structure and setting permissions, you can create shared 
dashboards and content for reuse by others. If you did not specify a dashboard when creating a 
group, you can create one now, selecting the appropriate group folder.

The advantage to creating shared dashboards is that sections that are created in the shared 
dashboard are actually shortcuts to folders in the /Shared folder. As such, you can remove them and 
add them again in a different column, page, or even a different dashboard. Users can create a My 
Dashboard from existing shared sections by clicking the Add Folder link and selecting the appropriate 
folder from the /Shared/Group or /Shared/Common folders in the Web Catalog.

If you plan to allow multiple users to modify the Web Group�s default dashboard, consider putting 
these users into another group. For example, suppose you create a Web Group called Sales and 
create a default dashboard called SalesHome. Of the 40 users that are members of the Sales group, 
suppose that there are three who need to have the ability to create and modify content for the 
SalesHome dashboard. It is recommended that you create a SalesAdmin group, with the same 
permissions of the primary Sales group. Add the three users who are allowed to make changes to 
the SalesHome dashboard and content to this new SalesAdmin group, and give this group the 
appropriate permissions to the Web Catalog. This allows them to create and modify content for the 
SalesHome dashboard. If a user no longer requires the ability to modify dashboard content, you can 
change the user�s group membership to Sales. If an existing Sales group member needs to have the 
ability to create dashboard content, the user�s group membership can be changed to SalesAdmin.

Dashboards are stored in a special folder, _Portal, that is hidden (unless the option to show hidden 
items is checked when working with the Web Catalog). The hidden _Portal folder is located directly 
underneath a group folder. Because the dashboard is contained in the Group folder, all the 
permissions you set to the group folder are inherited. 

You can create multiple dashboards within a group folder, each of which has its own folder in the /
_Portal folder, named from the dashboard name that you assign. 

Underneath the specific dashboard folder, for example, /_Portal/SalesGroup Dashboard, are the 
pages for the dashboard. 

For more information about creating shared dashboards, see �Creating and Deleting Shared Siebel 
Intelligence Dashboards� on page 49.

Adding Shared Siebel Intelligence Dashboards Pages and Content
After you have created dashboards, you can add pages and content.

Adding Pages and Content
For information about adding pages and columns, see Siebel Analytics User Guide.

Adding Sections
A section is a folder, or a shortcut to a folder, that appears within a dashboard. For the procedure for 
adding sections to a dashboard, see �Creating and Deleting Shared Siebel Intelligence Dashboards� on 
page 49.

When adding requests from Siebel Answers to a section, do one of the following:
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■ Include requests previously saved to the Subject Area folders.

■ Create a new request, save it in the appropriate Subject Area folder, and add it to the shared 
section using the Existing Request link.

This technique is preferred for several reasons. The permissions on the Subject Area folders 
automatically filter requests from the dashboard from users that might have dashboard 
permission, but not permission to certain subject areas. It is easy to reference the same request 
in multiple dashboard sections, you can change it once, and have it reflected in all sections.

If you are working with content that is specific to a number of group folders, you might want to create 
a new folder directly underneath the /Shared folder to use, and set permissions to the new folder to 
Read for the appropriate groups.

Adding Shared Siebel Analytics Content
You can create shared content that can be used within shared and My Dashboard sections. For 
example, you could create a library of images by creating a folder called Images in the /Shared/
Common folder. Add this folder as a section in a dashboard, perhaps the My Dashboard of the 
administrator (although it does not really matter because once you place the images in the section 
you can remove it from the dashboard). Remember, it is a shared section, so the folder still exists in 
the shared portion of the Web Catalog. Edit the section and click the Image link to add each image 
that you want in your library.

NOTE: If there are a number of libraries that you want to make available for sharing, you might want 
to create folders within the /Common folder called /Sections, and /Content or /Libraries, so it is 
easier distinguish when using the common sections and content in other dashboards. To use the 
shared content in a section of My Dashboard, the user can edit the desired section, click the link Item 
from Catalog, navigate to the /Shared/Common/Images folder, and click the image to include.

This same mechanism should be used for any logos, images, scripts, links, copyrights, and so on, 
that might be used in more than one dashboard or dashboard section. This allows you to change the 
item in one location and have it immediately reflected in all dashboards.

In this version of Siebel Analytics Web, the links Existing Request and Item from Catalog function 
identically. They allow you to choose any item, including existing requests, from the Web Catalog. 
This places a shortcut to the item you select in the section.

Testing the Siebel Intelligence Dashboards
Before releasing dashboards and content to the user community, perform some tests.

To test the dashboard

1 Verify that users with appropriate permissions can correctly access it and view the intended 
content. 

2 Verify that users without appropriate permissions cannot access the dashboard.

3 Verify that styles and skins are displayed as expected, and that other visual elements are as 
expected.
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4 Correct any problems you find and test again, repeating this process until you are satisfied with 
the results.

Setting Up a Virtual Directory For Shared Siebel Analytics Documents
It is recommended that you set up a virtual directory on the Web server for shared documents. Name 
the directory /DashboardFiles and map it to a shared network directory of the same name. 

This allows users with the appropriate permissions to publish files to this folder, and reference these 
files by their relative URL names rather than by their fully qualified network share names, for 
example, /DashboardFiles/AnnualReport.doc instead of 
\\SharedServer\CommonShare\DashboardFiles\AnnualReport.doc.

Releasing Siebel Intelligence Dashboards To the User Community
After testing is complete, notify the user community that the dashboard is available, providing the 
relevant network address.
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8 Customizing the Siebel 
Analytics Web User Interface
This chapter describes how to customize the appearance of the Siebel Analytics Web user interface.

NOTE: In Siebel Analytics Web, customization of user interface elements and appearance is 
accomplished by modifying registry entries, XML message files, and styles and skins, and not through 
the use of JavaScript. You should not modify JavaScript files located in the folder Web\App\Res in 
the Siebel Analytics Web installation directory. This is because the objects and methods in these 
scripts may change, and because these files may be replaced when upgrading. (In a dashboard, 
users with the appropriate permissions can customize an individual dashboard section by adding 
HTML to it. This HTML can include JavaScript. For more information, see Siebel Analytics User Guide.)

This chapter contains the following topics:

■ �Modifying Siebel Analytics Web User Interface Styles� on page 109

■ �Specifying Defaults for Siebel Analytics Web Styles and Skins� on page 111

■ �Customizing Siebel Analytics Web Non-Dashboard Components� on page 112

■ �Customizing the Siebel Analytics Web User Interface Using XML Message Files� on page 113

■ �Frequently Customized Siebel Analytics Web User Interface Messages� on page 118

■ �Customizing the Appearance of the Siebel Analytics Web Logon Screens� on page 119

Modifying Siebel Analytics Web User 
Interface Styles
You can modify the Siebel Cascading Style Sheets (CSS) files and the images stored in the default 
installation directory to create a custom user interface. The default images and style sheets are 
located the in the Web\App\Res\s_Siebel7 folder in the Siebel Analytics installation directory. 
Contained within this directory are of the relevant subdirectories (b_mozilla_4.0, b_nscp, Charts, 
Images, Maps, Meters, PopBin, Portal, and Views) for the current Siebel style.

Web developers who work with and understand style sheets can modify the default Siebel styles. 

NOTE: Modifications to the PopChart appearance files used in charting are not supported by Siebel 
Systems.

This section contains the following topics:

■ �Working with Cascading Style Sheets to Modify Default Siebel Analytics Web Styles� on page 110

■ �About Cascading Style Sheet Attributes and Siebel Analytics Web� on page 110

■ �Creating a New Dashboard Style for Siebel Analytics Web� on page 111

■ �Example: Customizing the Dashboard Banner Image in Siebel Analytics Web� on page 111
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Working with Cascading Style Sheets to Modify Default Siebel 
Analytics Web Styles
Web developers who work with and understand style sheets can modify the default Siebel styles. 
There are three files that affect most of the dashboard user interface:

■ PortalBanner.css. Influences the overall appearance of a dashboard�s top section. This includes 
the dashboard�s names, links, and so on.

■ PortalContent.css. Influences the overall appearance of a dashboard�s main content area.

■ Views.css. Corresponds to each of the Siebel Analytics request views (Title, Table, Pivot Table, 
Chart, Narrative, Ticker, and so on).

To see an example default Siebel 7 style sheet

1 Right-click the dashboard and select View Source to view the Web page within a text editor.

There are several CSS files referenced within the header of the Web page (<HEAD>. . .</
HEAD>). 

2 Perform a Find within the document and search for the keyword �class.� 

There is a class variable for each available attribute from within one of the CSS files.

The first class that appears is the PortalBody class (<body class="PortalBody">). If you open up 
the PortalContent.css file, you see a corresponding section for PortalBody. For example:

.PortalBody {
font-family:  Verdana, Arial, Sans-serif;
font-size: 9pt;
background-color: #FFFFFF;
margin: 0 0 2 0;

}

You could modify the background color of the dashboard page by changing, for example, the 
hexadecimal color from #FFFFFF (white) to the color of your choice. If you were to save this 
change, you could go back to the Web browser and click the Refresh button to see the change.

You can change the various CSS classes to adjust the overall look of any Siebel Analytics application. 
This can be a tedious process, but after you have a good understanding of the available or most 
commonly used classes, you can perform a find and replace within the text editor to make mass 
changes to a style. 

About Cascading Style Sheet Attributes and Siebel Analytics Web
Cascading style sheets allow Web developers to have control over any object within Siebel Analytics. 
You can change images, backgrounds, font colors and sizes, table cell gridlines and cell padding, and 
so on.

For more information about cascading style sheets, you can consult a resource such as the Microsoft 
Developer Network (MSDN).
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Creating a New Dashboard Style for Siebel Analytics Web
The easiest way to create a new style is to copy the s_Siebel7 style folder 
\\SiebelAnalytics\Web\App\Res\s_Siebel7 and paste it into the data directory at the location 
\\SiebelAnalyticsData\Web\Res. Copying to the data directory rather than to the main installation 
directory prevents any customized CSS files and images from being overwritten during a software 
upgrade.

After the style has been copied, rename the directory from s_Siebel7 to a name that has meaning 
to you (such as s_ProspectName).

The b_mozilla_4.0 directory contains the important files for making quick changes to the 
dashboards. 

NOTE: The Analytics Web Server service must be restarted before you can see the new style sheet 
from the Dashboard Properties screen.

To create a new style

1 Copy the s_Siebel7 directory.

2 Paste it to the Res directory in the SiebelAnalyticsData directory and give it a meaningful name.

3 Make and save your modifications.

The style sheet becomes available in the Dashboard Properties screen when the Analytics Web 
Server service is restarted.

Example: Customizing the Dashboard Banner Image in Siebel 
Analytics Web
The image bg_Banner.gif image is referenced on the top section of dashboards. Developers can open 
the bg_Banner.gif file and make changes, or delete and recreate a new bg_Banner.gif file.

Specifying Defaults for Siebel Analytics 
Web Styles and Skins
You can specify which style and skin to use when users choose the default style at the Dashboard 
Properties screen in Siebel Intelligence Dashboards by adding entries to the Windows registry or the 
Siebel Analytics Web configuration file instanceconfig.xml:

■ �Specifying Which Siebel Analytics Web Style Folder To Use� on page 112

■ �Specifying Which Siebel Analytics Web Skins Folder To Use� on page 112

If users do not make a choice, or if these entries are not present in the Windows registry or in the 
file instanceconfig.xml, the Siebel Systems styles and skins are used. These styles and skins are 
located in the s_Siebel7 and sk_Siebel7 folders in the \Web\App\Res folder in the Siebel Analytics 
Web installation directory.

For information about working in the Windows registry or the configuration file instanceconfig.xml, 
see �Making Siebel Analytics Web Configuration Changes� on page 14.
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Specifying Which Siebel Analytics Web Style Folder To Use
You can specify which style folder to use in the \Web\App\Res folder when users select the Default 
option from the Styles drop-down list at the Dashboard Properties screen in Siebel Intelligence 
Dashboards. If your style folder begins with the characters s_, such as s_TestStyle, omit those 
characters from the entry.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

DefaultStyle TestStyle

■ instanceconfig.xml example:

<DefaultStyle>TestStyle</DefaultStyle>

Specifying Which Siebel Analytics Web Skins Folder To Use
To specify the skins folder that is paired with the style folder you selected as described in �Specifying 
Which Siebel Analytics Web Style Folder To Use� on page 112, add the following entry. If your skins 
folder begins with the characters sk_, such as sk_TestSkin, omit those characters from the entry.

■ Windows registry example:

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.7

DefaultSkin TestSkin

■ instanceconfig.xml example:

<DefaultSkin>TestSkin</DefaultSkin>

Customizing Siebel Analytics Web Non-
Dashboard Components
Non-dashboard components include Siebel Answers, Siebel Delivers, and Siebel Analytics Web 
Administration. The CSS files for these components are stored in the sk_ directory within the main 
installation directory (\\SiebelAnalytics\Web\App\Res\sk_Siebel7). The location b_mozilla_4.0 
contains the relevant CSS files that correspond to Siebel Answers, Siebel Delivers, and Siebel 
Analytics Web Administration, and so on.

Use the same logic that is described in �Modifying Siebel Analytics Web User Interface Styles� on 
page 109 to make modifications to the non-dashboard components of the Siebel Analytics user 
interface. 

The non-dashboard components are controlled globally. Users cannot toggle between multiple user 
interfaces for the non-dashboard components. 
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Customizing the Siebel Analytics Web 
User Interface Using XML Message Files
This section explains how to customize text elements in message files to manage the default 
appearance and behavior of the Siebel Analytics Web user interface using XML strings.

NOTE: The intent of this section is to allow organizations that have XML expertise to perform 
additional customization. If you do not have this expertise, contact Siebel Systems� Services 
organization, or enlist the assistance of a third party, to help you with customization.

This section contains the following topics:

■ �About the Siebel Analytics Web User Interface XML Message Files� on page 113

■ �How Siebel Analytics Web XML Message Files Are Structured� on page 113

■ �Customizing Siebel Analytics Web XML Messages� on page 114

■ �Resolution of Siebel Analytics Web XML Message Name Tags� on page 115

■ �Sample Siebel Analytics Web XML Template� on page 115

■ �Sample Siebel Analytics Web CustomMessages.xml File� on page 116

About the Siebel Analytics Web User Interface XML Message Files
You can customize many of the text elements that appear in Siebel Answers, Siebel Delivers, and on 
dashboard pages. Examples of text elements include the content of text strings, the text for prompts 
such as the names of links and buttons, and the text of error and informational messages that are 
displayed to users as the result of an action. 

These text elements are contained in external message files that are distributed with Siebel Analytics 
Web. The message files are in XML format. Language-specific messages are located in the folder 
Web\App\Res\l_xx\Messages in the Siebel Analytics Web installation directory, where xx is the 
language identifier of the selected locale (for example, for english-usa, the identifier is en). 
Language-independent messages are located in the folder Web\App\Res\Messages in the Siebel 
Analytics Web installation directory.

You should not edit the message files directly because any changes would not be retained when you 
install newer versions or service releases. For more information, see �Customizing Siebel Analytics 
Web XML Messages� on page 114.

How Siebel Analytics Web XML Message Files Are Structured
The name of a particular message file indicates the kind of content that it holds. For example, 
messages in the file LogonMessages.xml hold message content related to the act of logging on and 
off the system. Within each XML file, the WebMessage name= tags define the names of the 
messages. These tags are called message identifiers.

A particular message may also reference the content of another message by using a MessageRef 
tag. For example, the following message in the file LogonMessages.xml references the value of 
another message:
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<WebMessage name="kmsgAuthenticateNotLoggedOnToLogOnClickHere">

<HTML>

You are not currently logged in to the

<MessageRef name="kmsgProductServer" /> 

The entry <MessageRef name="kmsgProductServer" /> in the previous message indicates that the 
name of the server is taken from the value of the kmsgProductServer message identifier. This 
message is located in the file ProductMessages.xml, and its value is Siebel Analytic Server:

<WebMessage name="kmsgProductServer" CRC="nnnnnnnnnnnnnnnnnnnn">

<TEXT>Siebel Analytic Server</TEXT> 

Some messages, such as those that contain copyright information and product names, are protected 
and cannot be changed. If you look in the file ProductMessages.xml, you see text preceding the 
WebMessage tags indicating that the associated names cannot be changed.

Customizing Siebel Analytics Web XML Messages
This section explains how to change the content of unprotected messages and provides several 
examples. The intent is to show you how to alter the text of messages, and not to teach you XML.

To customize messages

1 For the messages you want to customize, create like-named message identifiers and customize 
their text.

2 Create a custom messages folder named CustomMessages.

NOTE: Organizations that have Siebel Analytics applications may already have a file present in 
this folder. This file enables Analytics support for Siebel Analytics applications, and should not be 
modified, moved, or deleted.

3 Place the messages in one or more XML files in the CustomMessages folder, and then place the 
CustomMessages folder in this location:

\SiebelAnalyticsData\Web\Res\l_xx

where SiebelAnalyticsData is the name of the data folder created during the installation process, 
and xx is the language identifier of the selected locale (for example, for english-usa, the identifier 
is en). 

If you are not concerned with multiple languages, place the folder in the l_en folder. Messages 
default to l_en if a language-specific version is not found. You need to create the l_xx folder in 
the analyticsRes folder.

4 Restart Siebel Analytics Server.
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You can create as many XML files in the CustomMessages folder as you like, or you can create just 
one XML file that holds customized messages, for example, CustomMessages.xml. 

NOTE: If you plan to support multiple languages, it is recommended that you place control 
messages, which are messages that are not translated, into one file named 
CustomControlMessages.xml. Place messages that are translated into another file named, for 
example, CustomUIMessages.xml. This allows you to place localized versions of the 
CustomUIMessages.xml file in each language folder as appropriate, such as 
\SiebelAnalyticsData\Web\analyticsRes\l_de\CustomMessages, 
\SiebelAnalyticsData\Web\analyticsRes\l_fr\CustomMessages, and so on.

Resolution of Siebel Analytics Web XML Message Name Tags
During initialization, the Analytics Web Server replaces the WebMessage name default text with text 
from equivalently named tags in any customized XML file, based on the following precedence order, 
from highest to lowest:

■ XML in \SiebelAnalyticsData\Web\Res\l_xx\CustomMessages folder (language- specific folders).

■ XML in \SiebelAnalyticsData\Web\Res\l_en\CustomMessages folder (for language-specific user 
logons if WebMessage name tags reside here, but are not in language-specific files).

■ XML in \SiebelAnalyticsData\Web\Res\CustomMessages folder.

■ XML in \SiebelAnalytics\Web\App\Res\l_xx\Messages folder.

■ XML in \SiebelAnalytics\Web\App\Res\Messages folder.

As an example, when Siebel Analytics Web starts up, it first reads the messages in the folder 
Web\App\Res\l_xx\Messages in the installation directory, and then reads the messages in the folder 
\SiebelAnalyticsData\Web\Res\l_xx\CustomMessages. It replaces the default text for those 
messages with the customized text. If you attempt to alter the text of a protected message, a 
message is displayed in its place indicating that you attempted this.

Sample Siebel Analytics Web XML Template
The following is a sample template for a CustomMessages.xml file in the folder 
\SiebelAnalyticsData\Web\analyticsRes\l_xx\CustomMessages. An example CustomMessages.xml 
file follows the template. 

Every message begins with a <WebMessage name=> tag and ends with a
</WebMessage> tag. The message text that you can customize is contained between <TEXT> tags 
or <HTML> tags. To suppress the display, delete the text between the tags.

<?xml version="1.0" encoding="utf-8"?>

<WebMessageTables>

<WebMessageTable system="Custom Messages">

<!-- The name of a message must match the name of the message you are 
overriding. -->
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<WebMessage name="kmsgExampleOverrideMessage">

<!-- A message can have TEXT and/or HTML versions of it. It is not necessary 
to have both. (TEXT will be automatically converted to HTML when necessary). -->

<TEXT>Example message.</TEXT> <!-- Format used in a text only output --> 

<HTML><b>Example message with bold HTML tags.</b></HTML> <!-- Format used 
in an HTML output -->

</WebMessage>

</WebMessageTable>

</WebMessageTables>

To create a sample template

1 Replicate the sample template in a text editor.

2 Name the file CustomMessages.xml (or any name you choose).

3 Place the file into the CustomMessages folder you have created in the appropriate 
\SiebelAnalyticsData\Web\analyticsRes\l_xx folder.

Sample Siebel Analytics Web CustomMessages.xml File
The following example shows four customized messages placed in the CustomMessages.xml file.

<?xml version="1.0" encoding="utf-8"?>

<WebMessageTables>

<WebMessageTable system="Custom Messages">

<!-- First message -->

<WebMessage name="kmsgAuthenticateRemembermyIDandpassword">

<TEXT>Remember my signon name and password.</TEXT>

</WebMessage>

<!-- Second message -->

<WebMessage name="kkmsgPrivilegeDisplayerAccountUnknown">
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<TEXT>Unknown Account (<Param insert="1"/>). Call the Help Desk at 
extension 9999 to set up a new account.</TEXT> 

</WebMessage>

<!-- Third message --

<WebMessage name="kmsgWelcomeFrameCreateNewRequest">

<HTML>Create a <b>new request</b> by clicking on a Subject Area below. After 
creating the request, click on the <b>Done</b> button at the bottom of the page.</
HTML> 

</WebMessage>

<!-- Fourth message -->

<WebMessage name="kmsgUIAdmin"> 

<HTML></HTML>

</WebMessage>

</WebMessageTable>

</WebMessageTables>

■ The message identifier of the first message being customized is 
"kmsgAuthenticateRemembermyIDandpassword". The default text for this message is 
located in the file LogonMessages.xml in the folder Web\App\Res\l_xx\Messages in the 
installation directory.

■ The message identifier of the second message being customized is 
"kmsgPrivilegeDisplayerAccountUnknown". The default text for this message is located in the 
file ViewMessages.xml in the folder Web\App\Res\l_xx\Messages in the installation directory. 
This message contains a variable,
( <Param insert="1"/> ).

NOTE: If you are customizing a message that contains a variable, do not alter the variable. 
In the UNIX environment, be careful to preserve the case of the message name being 
customized. 

■ The message identifier for the third message being customized is 
"kmsgWelcomeFrameCreateNewRequest". The default text for this message is located in the 
file SearchSysMessages.xml in the folder Web\App\Res\l_xx\Messages in the installation 
directory. This message is in HTML format and uses an HTML tag ( <b> ) to display text in 
bold letters.
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■ The message identifier for the fourth message being customized is "kmsgUIADMIN". The 
default text for this message is located in the file UIMessages.xml in the folder 
Web\App\Res\l_xx\Messages in the installation directory. This message is in HTML format. 
This message identifier displays the Admin link at the top of each Siebel Answers, Siebel 
Delivers, or dashboard page. Deleting the Admin text between the <HTML> and </HTML> 
tags suppresses the display of the link.

Frequently Customized Siebel Analytics 
Web User Interface Messages
Messages that are frequently customized are located in the file UIMessages.xml. This file contain text 
strings for display elements and for links throughout the user interface. 

For example, the following messages contain the text for the links Admin, Alerts!, and Answers in 
the user interface. You can customize the text, or delete the text to suppress the display of the link.

<WebMessage name="kmsgUIAdmin"> 

<HTML>Admin</HTML>

</WebMessage> 

<WebMessage name="kmsgUIAlerts">

<HTML>Alerts!</HTML> 

</WebMessage> 

<WebMessage name="kmsgUIAnswers"> 

<HTML>Answers</HTML>

</WebMessage>

For example, users can export the data for a request to a Microsoft Excel file. If you do not want to 
support the download to Excel option, you can remove the link.

To remove the Download link

1 Open the ViewsControlMessages.xml file.

2 Copy the following message to the CustomMessages.xml file:

<WebMessage name="kmsgEVCDownloadLinks"> 

<HTML> 

<a insert="1"> 
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<MessageRef name="kmsgEVCLinkDownloadExcel" /> 

</a> 

<a insert="2"> 

<MessageRef name="kmsgEVCLinkDownloadData" /> 

</a> 

</HTML> 

3 Delete the first message identifier anchor:

 <a insert="1"> 

<MessageRef name="kmsgEVCLinkDownloadExcel" /> 

</a> 

4 Save the CustomMessages.xml file.

For more information about the CustomMessages.xml file, see �Sample Siebel Analytics Web 
CustomMessages.xml File� on page 116.

Customizing the Appearance of the 
Siebel Analytics Web Logon Screens
Users must log on to Siebel Analytics Web to gain access to Siebel Intelligence Dashboards, Siebel 
Answers, and other Siebel Analytics Web components. The logon process provides a user interface 
to the Analytics server authentication process.

When Siebel Analytics Web is accessed, the user is presented with the default Siebel Analytics Web 
logon screen. The user must enter an appropriate Siebel Analytics user name and password. When 
authentication is complete, the user gains access to the appropriate Siebel Analytics Web 
components, and the user�s default dashboard displays. For more information, see �About Siebel 
Analytics Web User Authentication� on page 89.

To customize the appearance of the logon screens
■ Override the relevant messages in the file LogonControlMessages.xml.

NOTE: The Not Logged On screen (kmsgAuthenticateNotLoggedOn), used for session timeout, 
appears only when users are not logged on and attempt to access a URL that does not support 
direct logon. For example, suppose a user accesses Siebel Answers and clicks the Log Off link. If 
the user clicks the browser�s Back button and then clicks the My Account link, the user receives 
the Not Logged On screen.
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For general information about customization the user interface with XML messages, see �Customizing 
the Siebel Analytics Web User Interface Using XML Message Files� on page 113.

NOTE: This feature does not allow the Siebel Analytics Web administrator to control how users are 
actually authenticated. For information about authentication options, see �About Siebel Analytics Web 
User Authentication� on page 89.
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9 Integrating Siebel Analytics 
Web Into Corporate 
Environments Using HTTP
This chapter explains the HTTP methods that you can use to integrate Siebel Analytics Web into your 
corporate environment. Siebel Analytics Web provides entry points for most functionality exposed in 
the system. Calls can be made through HTTP using a simple URL syntax or JavaScript commands. In 
UNIX, interfaces are exposed through a Java Servlet. This chapter contains the following topics:

■ �Incorporating Siebel Analytics Results Into External Portals or Applications Using the Go URL� on 
page 121

■ �Referencing Dashboard Content in External Portals or Applications Using the Siebel Analytics Web 
Dashboard URL� on page 125

■ �Using the Siebel Analytics Web Go URL To Issue SQL and Pass Filters� on page 126

■ �Example of a Siebel Analytics Third-Party SQL Tool Integration� on page 131

Incorporating Siebel Analytics Results 
Into External Portals or Applications 
Using the Go URL
This section describes how to use the Siebel Analytics Web Go URL to incorporate results into external 
portals or applications. It contains the following topics:

■ �About the Siebel Analytics Web GO URL� on page 121

■ �Structure of the Basic Siebel Analytics Web Dashboard URL� on page 125

■ �Optional Parameters for the Siebel Analytics Web Go URL� on page 122

About the Siebel Analytics Web GO URL
The Siebel Analytics Web Go URL command is for use in incorporating specific Siebel Analytics results 
into external portals or applications. The Go URL is used when you add a result to your favorites, or 
add a link to a request to your dashboard or an external Web site. It has a number of forms and 
optional arguments that can be used to control its behavior.

You can post the Go URL as a Form or issue it as a URL. If you are issuing parameters as part of a 
URL, they need to be escaped properly. You need to replace spaces with plus ( + ) signs, and so on. 
For example, to pass East Region as a value, type East+Region.

When called from within a Siebel Analytics Web screen, such as a dashboard or an HTML result view, 
the URL should begin with the following characters:

saw.dll?Go
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When called from another screen on the same Web server, the URL should begin with the following 
characters:

/Analytics/saw.dll?Go

When referenced from a screen on a different server (or sent through email, and so on), the URL 
should begin with the fully qualified server name or IP address:

http://server_name_or_ip_address/Analytics/saw.dll?Go

To test these commands, you can enter the fully qualified version into the Address field in Internet 
Explorer.

Structure of the Basic Siebel Analytics Web Go URL
The basic Go URL command needs the full Web Catalog path to the request you want to execute. It 
returns the default result view, as defined in the request.

For example, the following go URL command returns the default result view as defined in the request, 
where SB2 is the name of the request to execute.

saw.dll?Go&Path=/Shared/Test/SB2

Optional Parameters for the Siebel Analytics Web Go URL
You can modify the behavior of the Go URL command by adding one or more of the following 
parameters. If an invalid URL is specified (for example, you type a parameter incorrectly), the 
browser displays a �The page cannot be found� error with the detailed text of �HTTP 400 - Bad 
Request.�

NOTE: In parameter descriptions, SB2 is the name of the request to execute.

■ User ID and Password. If omitted, the user is prompted for user ID and password information, 
unless the user chose the option to have logon information remembered when last logged on. 

This is the format, where uuu is the user ID and ppp is the password:

&NQUser=uuu&NQPassword=ppp 

Example:

saw.dll?Go&Path=/Shared/Test/SB2&NQUser=user1&NQPassword=rock

This logs on as user1 with a password of rock, and executes the request.
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■ Link Options. The results will include links.

This is the format:

&Options=x 

The x can be one or more of the following letters:

Example:

saw.dll?Go&Path=/Shared/Test/SB2&Options=md

This displays results with the links Modify Request and Download.

■ Printer Friendly. Results are in a printer-friendly format, without the paging controls, hot links, 
and so on.

This is the format:

&Action=print

Example:

saw.dll?Go&Path=/Shared/Test/SB2&Action=Print

■ Application Friendly. Results are displayed in an application-friendly format, such as for 
Microsoft Excel, without the paging control, hot links, the Powered by Siebel Analytics phrase, 
and so on.

This is the format:

=&Action=Extract

Example:

saw.dll?Go&Path=/Shared/Test/SB2&Action=Extract

The Extract action also acts as a Navigate action (see �Passing Filters to the Siebel Analytics Web 
Go URL Through a URL (Navigation)� on page 127) so you can filter the results that are returned 
by the call.

Letter Link

m Modify Request

f Printer Friendly

d Download to Excel

r Refresh Results
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■ Specific View. This shows an individual result view rather than the default compound view. 

This is the format, where xx is the name of the view:

saw.dll?Go&Path=/Shared/Test/SB2&ViewName=xx

Example:

saw.dll?Go&Path=/Shared/Test/SB2&ViewName=Chart

Assuming that the request contains a Chart view named Chart, this displays just the Chart view.

■ Specific Style. This shows the results using a specified style. If the style does not exist, the 
default is used.

This is the format, where xx is the name of the style:

saw.dll?Go&Path=/Shared/Test/SB2&Style=xx

Example:

saw.dll?Go&Path=/Shared/Test/SB2&Style=Lime

This uses the style named Lime to show the results.

■ Result Format. This controls the format of the results.

This is the format, where xx is XML or HTML:

saw.dll?Go&Path=/Shared/Test/SB2&Format=xx

Example:

saw.dll?Go&Path=/Shared/Test/SB2&Format=XML

This shows results in XML.

Displaying All Records in a Table

There are two ways to display all the records in the table:

■ Set the Rows per Page property on the Table view to 10,000, and then use the basic Go. This is 
the easier of the two methods.

■ Issue the following URL, assuming the View you want to control is called Table.

saw.dll?Go&Path=/Shared/Test/SB2&Action=Scroll&P5=-1&ViewID=go~Table
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Referencing Dashboard Content in 
External Portals or Applications Using 
the Siebel Analytics Web Dashboard URL
This section describes how to use the Siebel Analytics Web Dashboard URL. It contains the following 
topics:

■ �About the Siebel Analytics Web Dashboard URL� on page 125

■ �Structure of the Basic Siebel Analytics Web Dashboard URL� on page 125

■ �Optional Parameters for the Siebel Analytics Web Dashboard URL� on page 126

About the Siebel Analytics Web Dashboard URL
The Siebel Analytics Web Dashboard URL is for use in incorporating or referencing the content of a 
specific Siebel Intelligence Dashboard in external portals or applications. It has a number of forms 
and optional arguments that can be used to control its behavior. 

You can post the Dashboard URL command as a Form or issue it as a URL. If you are issuing 
parameters as part of a URL, they need to be escaped properly. You need to replace spaces with plus 
( + ) signs, and so on. For example, to pass East Region as a value, type East+Region.

When called from within a Siebel Analytics Web screen, such as a dashboard or an HTML result view, 
the URL should begin with this:

saw.dll?Dashboard

When called from another screen on the same Web server, the URL should begin with this:

/Analytics/saw.dll?Dashboard

When referenced from a screen on a different server (or sent through email, and so on), the URL 
should begin with the fully qualified server name or IP address:

http://server_name_or_ip_address/Analytics/saw.dll?Dashboard 

To test these commands, you can enter the fully qualified version into the Address field in Internet 
Explorer.

Structure of the Basic Siebel Analytics Web Dashboard URL
The basic Dashboard URL command needs no parameters. It displays the user�s default portal, after 
authenticating the user.

This is the format:

saw.dll?Dashboard
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Optional Parameters for the Siebel Analytics Web Dashboard URL
You can modify the behavior of the dashboard URL command by adding one or more of the following 
parameters. If an invalid URL is specified (for example, you type a parameter incorrectly), the 
browser returns a �The page cannot be found� error with detailed text of �HTTP 400 - Bad Request.�

NOTE: In parameter descriptions, SB2 is the name of the request to execute.

User ID and Password. If omitted, the user is prompted for user ID and password information, 
unless the user chose the option to have logon information remembered when last logged on. If using 
a Session ID or Ticket, pass it as the NQUser parameter.

This is the format, where uuu is the user ID, and ppp is the password:

&NQUser=uuu&NQPassword=ppp 

Example:

saw.dll?Go&Path=/Shared/Test/SB2&NQUser=user1&NQPassword=rock

This logs on as user1 with a password of rock, and displays the dashboard.

PortalPath. This parameter allows you to direct the user to a specific dashboard. If the user does 
not have permission to the dashboard, an Access Denied error is returned.

This is the format, where ppp is the fully qualified path of the dashboard in the Web Catalog, and 
x+x is the name of the dashboard to display.

saw.dll?Dashboard&PortalPath=/Shared/Test/_Portal/x+x&NQUser=sessionid

Example:

saw.dll?Dashboard&PortalPath=/Shared/Test/_Portal/Sales+Dashboard&NQUser=sessionid

This authenticates the user using the provided session ID, and displays the Sales Dashboard. 

Using the Siebel Analytics Web Go URL 
To Issue SQL and Pass Filters
This section explains how to use the Go URL command to issue SQL, and how to pass filters to be 
used for navigation. It contains the following topics:

■ �Issuing SQL Using the Siebel Analytics Web Go URL� on page 126

■ �Passing Filters to the Siebel Analytics Web Go URL Through a URL (Navigation)� on page 127

Issuing SQL Using the Siebel Analytics Web Go URL
The Go URL command can be used to issue Siebel Analytics SQL. These forms of the Go URL return 
tabular results. The basic options from &Style= and &Options= can be used here as well.

To issue Siebel Analytics's simplified SQL, include the escaped SQL as a parameter to the Go URL. 
For example:
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saw.dll?Go&SQL=select+Region,Dollars+from+SupplierSales

where the FROM clause is the name of the Subject Area to query. 

Alternatively, the command IssueRawSQL can be used to bypass the Web processing and issue SQL 
directly against the Analytics Server.

Passing Filters to the Siebel Analytics Web Go URL Through a URL 
(Navigation)
The Go URL can also be used to pass context such as filters to a destination request. This is done by 
adding additional parameters to the call. You need to make sure that any columns you are passing 
are set up in the destination with Is Prompted filters, or specific default filters.

Navigation Parameters
The basic syntax of the navigation command is the same as presented in the section �Structure of 
the Basic Siebel Analytics Web Dashboard URL� on page 125, but with the addition of the 
Action=Navigate parameter, and then population of the P1 - Pn parameters, as necessary.
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&Action=Navigate

&P0=n where n is the number of columns you wish to filter, currently 1 - 6.

&P1=op where op is one of the following operators.

NOTE: The settings for &P1,&P2, and &P3 are repeated for &P4-P6, &P7-P9, &P8-P10, &P11-P13, 

Operator Meaning

eq Equal to or in.

neq Not equal to or not in.

lt Less than.

gt Greater than.

ge Greater than or equal to.

le Less than or equal to.

bwith Begins with.

ewith Ends with.

cany Contains any (of the values in &P3).

call Contains all (of the values in &P3).

like You need to type %25 in place of the usual % wildcard. See the 
examples that follow.

top &P3 should contain 1+n, where n is the number of top items 
you want to see.

bottom &P3 should contain 1+n, where n is the number of bottom 
items you want to see.

bet Between (&P3 must have two values).

null Is null (&P3 must be 0 or omitted).

nnul Is not null (&P3 must be 0 or omitted).

&P2=ttt.ccc In this parameter, ttt is the table name and ccc is the column 
name. If the table or column contains spaces, it must be 
quoted with double-quotes. Spaces should be escaped as %20, 
for example, Measures."Dollar%20Sales".

&P3=n+xxx+yyy+...+zzz In this parameter, n is the number of values, and xxx, yyy, and 
zzz are the actual values.

NOTE: If the value of P3 begins with a numeric character, the 
entire value must be enclosed in quotes. For example:

saw.dll?Go&Path=/Shared/Test/

SB2&Action=Navigate&P0=1&P1=top&P2=Customers.Region&P3

="7West"
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&P14-P16, and &P17-P19 as necessary, depending on the value of &P0.

Navigation Examples

This returns records for the East and Central regions:

Saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=1&P1=eq&P2=Customers.Region&P3=2+Central+East

This returns records for like Regions E....t:

saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=1&P1=like&P2=Customers.Region&P3=1+E%25t

This returns the top two regions by dollars sold:

saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=1&P1=top&P2="Sales%20Facts".Dollars&P3=1+2

This is an example where the number of arguments is not included in the syntax:

saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=1&P1=top&P2=Customers.Region&P3=Central

NOTE: You can omit the number of arguments only if just one argument value is included.

This returns records with between 2,000,000 and 2,500,000 in sales:

saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=1&P1=top&P2="Sales%20Facts".Dollars&P3=2+2000000+2500000

This returns records for Regions beginning with the letter E:

saw.dll?Go&Path=vate&P0=1&P1=bwith&P2=Customers.Region&P3=1+E 

This returns records for Regions containing the letter E and having more than 20 million in sales:

saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=2&P1=cany&P2=Customers.Region&P3=1+e&P4=gt&P5="Sales%20Fact
s".Dollars&P6=1+20000000

Siebel Analytics Web navigation is currently supported from charts, table and pivot table views, HTML 
views, and external applications and Web pages. The destination search should have filters defined 
on columns for which it wants to receive context. These can be specific filters or, usually, the Is 
Prompted filter. In addition to the Table.Column value specifically referenced in the navigation call, 
all filters from the source request that have corresponding table.columns in the destination, are 
applied to the destination. Therefore, the appropriate context from a source can be passed to the 
destination.

Navigation From Charts

From the chart properties screen, check the Navigate radio button and enter the full path to the 
saved search or portal that you are interested in the field provided, for example:

/shared/topaz/performance/transaction details
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Navigation Using JavaScript

Navigation can currently be accomplished using the custom text/date formatter for a column. The 
central concept is that you add a column you want to navigate from to your search. You then choose 
Custom Text Format from the properties for the column, and enter HTML that calls one of the two 
provided JavaScript functions. This technique can be used to perform many actions, including sorting 
columns, calling custom JavaScript functions, and so on.

Siebel Analytics Web includes two JavaScript functions that enable navigation from Table and Pivot 
views: GoNav and PortalNav. (These functions are located in /res/mozilla/viewhelper.js if you are 
interested in seeing what they do.) The former handles navigation to a specific search. The latter 
handles navigation to a specific dashboard. A description of their syntax follows, along with example 
Custom Text formats that you can use to accomplish navigation. 

NOTE: Siebel Analytics Web is standardized on the class=Nav, in order to control the look of the 
navigable text using the style sheet.

function GoNav(sPath,sTbl,sCol,sVal,sTarget) where

sPath = the catalog path of the destination search.

sTbl = the logical table name to filter.

sCol = the logical column name to filter.

sVal = the value to filter by.

sTarget (optional) = "_blank" to open a new browser window with the results.

Sample Custom Text Format for GoNav Call (include the quotes):

"<font class=nav onclick=\"JavaScript:GoNav('/shared/topaz/performance/transaction 
details','Transaction','Quality','"@"');\">"@"</font>";;@

function PortalNav(sPortal,sTbl,sCol,sVal)

sPortal = the catalog path of the destination portal.

sTbl = the logical table name to filter.

sCol = the logical column name to filter.

sVal = the value to filter by.

Sample Custom Text Format for PortalNav Call (include the quotes):

"<font class=nav onclick=\"JavaScript:PortalNav('/shared/topaz/_portal/transaction 
analysis','Transaction','Type','"@"');\">"@"</font>"

Navigation From HTML Results
This is the same as described in �Navigation Using JavaScript� on page 130, but rather than using a 
custom formatter, type in the HTML syntax with static values in place of the @ signs.
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Example of a Siebel Analytics Third-
Party SQL Tool Integration
This section illustrates the requirements for integrating a third-party SQL tool with Siebel Analytics 
by describing an example integration, using Microsoft Access. Because Siebel Analytics is designed 
as a middleware platform for enterprise data access and integration, common report writers and 
business intelligence tools can communicate natively with the Siebel Analytics Server.

Most third-party SQL tools require the user to include join conditions within queries, in order to avoid 
cross-joins. A cross-join occurs when a request does not have a WHERE clause, which, in turn creates 
a Cartesian product of the tables involved in the join. The size of a Cartesian product is the number 
of rows in the first table multiplied by the number of rows in the second table.

To integrate Microsoft Access with the Siebel Analytics Server, the Siebel Analytics Server 
administrator must expose the keys within the Presentation layer of the Siebel Analytics 
Administration Tool.

Example of integrating a third-party SQL tool

1 Drag and drop the keys from the Business Model and Mapping layer to the Presentation layer and 
save the repository.

2 Open Microsoft Access, select the option Blank Access Database, type the name siebel-
analytics.mdb when prompted, and click the Create button. 

3 After creating the new Microsoft Access database, right-click in the white section of the screen 
and select Link Tables. 

4 From the Files of Type drop-down list box, select ODBC Databases.

The Select a Source Dialog appears, and prompts you for a Data Source Name.

5 Click the Machine Data Source tab, locate the Analytics_Web DNS, and click OK.

The Siebel Analytics Server requires a login. 

6 Type your user ID and password. 

The Import Objects dialog box appears.

7 Click the Select All button, or highlight the desired logical tables from Siebel Analytics. 

The import may take a while to complete.

8 When the import completes, right-click in the white section of the screen and select 
Relationships.

a Add the desired tables and drag and drop the keys from the dimension tables (Period, Market, 
Product) to the fact table (Sales Measures). 

b Drag and drop Period Key over perkey, and repeat for each corresponding key, to create the 
joins.

Now, you can test and run a request. 
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9 Select Create query in Design view from the Queries button:

a Select Markets, Products and Sales Facts.

b Add Region, Brand, Units and Dollars, respectively, then click the Run button. 
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This chapter describes the Siebel Analytics Web implementation of the Simple Object Access Protocol 
(SOAP) application programming interface to extract and deliver data and manage content in the 
Siebel Analytics Web Catalog.

This chapter contains the following topics:

■ �Overview of the Siebel Analytics Web SOAP API� on page 133

■ �Summary of Web Services and Methods Supported by the Siebel Analytics Web SOAP API� on 
page 135

■ �Using Item Signatures in the Siebel Analytics Web SOAP API� on page 138

■ �Overview of the Siebel Analytics Web HtmlViewService Service� on page 139

■ �Accessing the Siebel Analytics Web SOAP Services Interface� on page 140

■ �Description of Structures in the Siebel Analytics Web SOAP API� on page 141

■ �Description of Methods in the Siebel Analytics Web SOAP API� on page 148

■ �Format of Returned Recordsets in the Siebel Analytics Web SOAP API� on page 177

■ �Code Example for Writing Web Catalog Information To XML Files Using the Siebel Analytics Web 
SOAP API� on page 178

Overview of the Siebel Analytics Web 
SOAP API
SOAP (Simple Object Access Protocol) is a World Wide Web Consortium (W3C) recommendation for 
an XML protocol for exchanging information on the Web. The Siebel Analytics Web implementation 
of SOAP allows you to perform two types of functions:

■ Extract results from Siebel Analytics Web and deliver them to external applications.

■ Perform some Web Catalog management functions.

NOTE: Security information management is not supported in the Siebel Analytics Web SOAP API. 
For information about managing security, see �Managing Siebel Analytics Web Security� on 
page 81.
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The Siebel Analytics Web SOAP API allows external applications such as J2EE and .NET to use Siebel 
Analytics as an analytical calculation and data integration engine. It provides a set of Web services 
that allow external applications to communicate with the Siebel Analytics Web server. You can use 
the Siebel Analytics Web SOAP API to extract results from Siebel Analytics Web and deliver them to 
external applications and Web application environments. You can reference a saved report or send 
the criteria for the report to Siebel Analytics Web. You can also use the Siebel Analytics Web SOAP 
API to incorporate third-party application content on a Siebel Intelligence Dashboard.

NOTE: Spaces within paths must be substituted with the HTML attribute %20. 

The formal definition of Siebel Analytics Web SOAP services can be retrieved in WSDL (Web Services 
Definition Language) format. Proxy classes for the services are generated automatically. 

The XML Schema Definition (XSD) file for the services is the file SawServices.xsd is located in the 
\Web\App\Wsdl\Schema directory in the Siebel Analytics installation directory. The XSD file is used 
internally and cannot be used separately. You can access the WSDL document through the following 
Siebel Analytics Web SAW URL:

http://somehost/analytics/saw.dll?WSDL

The Siebel Analytics Web SOAP API has been tested with Apache Axis and the Microsoft .NET 
framework.

For more information about the SOAP recommendation, consult a reference such as the Microsoft 
Developer Network or the W3C Web site.
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Summary of Web Services and Methods 
Supported by the Siebel Analytics Web 
SOAP API
This section provides a summary of the Web Services and the methods supported by each service.

■ SAWSessionService. Defines authentication services such as logon and logoff, and other 
session-related services. Supported methods include:

■ logon() 

Authenticates the user.

■ logoff()

Logs the user off Siebel Analytics Web.

■ getCurUser()

Gets the current user ID for the session.

■ keepAlive()

Instructs Siebel Analytics Web not to end particular sessions due to inactivity.

■ impersonate()

Logs on and then impersonates the user.

■ HtmlViewService. Allows the embedding of Siebel Analytics Web results in third-party dynamic 
Web pages and portal frameworks. Supported methods include:

■ startPage()

Creates a new page object and returns its ID. 

■ endPage()

Destroys a server page object and all data associated with it.

■ addReportToPage()

Adds results to an HTML page.

■ getHeadersHTML()

Gets HTML to include in the <HEAD> section.

■ getCommonBodyHTML()

Gets HTML to include in the <BODY> section.

■ getHTMLForReport()

Gets HTML to display a particular set of results.
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■ setBridge()

Specifies a bridge URL to receive communications. Can be useful when the Siebel Analytics 
Web server and the user�s Web server reside on different machines or when you want to 
modify the results in your application development environment.

For more information, see �Overview of the Siebel Analytics Web HtmlViewService Service� on 
page 139.

■ XMLView Service. Retrieves results from Siebel Analytics Web in XML format. One method is 
supported:

■ getResults()

Returns the report results, in XML format.

■ ReportEditingService. Merges parameters and Siebel Analytics Web data to create and return 
the results. Supported methods include:

■ applyReportParams()

Applies report parameters to the report object and returns the results.

■ generateReportSQL()

Retrieves the SQL query a given report.

■ WebCatalogService. Provides methods for navigating and managing the Web Catalog, and 
reading and writing Web Catalog objects in XML format. Supported methods include:

■ copyItem()

Copies an object from one location to another in the Web Catalog.

■ createFolder()

Creates a new folder in the Web Catalog.

■ createLink()

Creates a link to the Web Catalog.

■ deleteItem()

Deletes an object from the Web Catalog.

■ getItemInfo()

Gets Web Catalog information for an object.

■ getSubItems()

Gets the collection of child subitems for an object in the Web Catalog.

■ moveItem()

Moves an object in the Web Catalog to a different location in the catalog.

■ writeSavedFilter()

Writes a filter to the Web Catalog.
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■ readObject()

Reads an object from the Web Catalog.

■ removeFolder()

Deletes a folder from the Web Catalog.

■ setItemProperty()

Sets a property for an object in the Web Catalog.

■ writeObject()

Writes an object to the Web Catalog.

■ writeReport()

Writes a set of results to the Web Catalog.

■ writeDashboard()

Writes a dashboard object to the Web Catalog.

■ writeDashboardPrompt()

Writes a dashboard prompt to the Web Catalog.

■ writeDashboardPage()

Writes a dashboard page to the Web Catalog.

■ writeSavedFilter()

Writes a filter to the Web Catalog.

NOTE: Access rights to Web Catalog content are enforced when using the Siebel Analytics Web 
SOAP API. For example, if the user name used to establish the SOAP session does not have 
access to certain Siebel Answers content in the Web Catalog, the content is not accessible using 
the Siebel Analytics Web SOAP API.
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Using Item Signatures in the Siebel 
Analytics Web SOAP API
Each object has its own signature. Signatures are used in conjunction with writing objects. You need 
to use the appropriate signature when writing objects. The signatures used by the various methods 
are provided in the method descriptions given in this chapter. 

The following example code writes a generic object to set the signatures.

If (signature == "queryitem1")

{

ws.writeReport(o,name,true,true,session);

} 

else if (signature == "dashboarditem1")

{

ws.writeDashboard(o,name,true,true,session);

}

else if (signature == "dashboardpageitem1")

{

ws.writeDashboardPage(o,name,true,true,session);

}

else if (signature == "globalfilteritem1")

{

ws.writeDashboardPrompt(o,name,true,true,session);

}

else if (signature == "filteritem1")

{

ws.writeSavedFilter(o,name,true,true,session);

}

else if (signature == "COXmlDocument1")

{

ws.writeObject(o,name,true,true,session);

}
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else

{

ws.writeObject(o,name,true,true,session);

}

Overview of the Siebel Analytics Web 
HtmlViewService Service
The HtmlViewService service allows the embedding of Siebel Analytics Web HTML results in third-
party dynamic Web pages, such as Active Server Pages (ASP) or JavaServer Pages (JSP), and portal 
frameworks. The embed process merges Siebel Analytics Web content with the content of third-party 
Web pages.

HTML methods extract fragments of HTML code that can be inserted in third-party Web pages. The 
HTML code excerpts and desired page locations are described in Table 7.

For each returned report object, the HTML code fragment contains a callback link that is followed 
automatically when the Web page is loaded by the browser. The code fragment does not contain the 
full user interface definition of the report. While the report is being constructed by Siebel Analytics 
Web, the user sees the Siebel Analytics Web �Searching...� image (the default image is a spinning 
arrow) embedded on the third-party Web page.

For smooth report transitioning, Siebel Analytics Web tracks the Analytics reports that have been 
added to a third-party Web page by maintaining information in an internal logical page object during 
the construction of the third-party Web page. The HtmlViewService service methods explicitly refer 
to the internal logical page by its ID.

Table 7. HTML Code Fragments and Page Locations for the HtmlViewService Service

HTML Code Fragment Desired Page Location

Header Should be inserted in the <HEAD> section of an HTML page. The code 
contains links to common JavaScript files and style sheets.

Report Objects Can be inserted anywhere in the <BODY> section.

Common Body Should be inserted in the <BODY> tag after all report links. The code 
contains hidden HTML elements that are used to implement drilldown 
links.
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About HtmlViewService Bridging and Callback URLs
To embed a report with active drilldown links, the HtmlViewService service allows the Web browser 
to issue callback requests from embedded reports to the Siebel Analytics Web server. Although it is 
possible to route requests directly to the Siebel Analytics Web server, in many cases it is preferable 
to route requests through the Web server that originally serviced the third-party page. Also, in 
situations where Siebel Analytics Web and the third-party Web server do not belong to the same 
Domain Name Service (DNS) domain, users may see JavaScript errors related to browser security 
constraints for cross-domain scripting.

To avoid these issues, you can use the setBridge() method to modify callback URLs to point to the 
third-party Web server. Be aware that a Web component executed by the third-party Web server to 
reroute requests to Siebel Analytics Web is not provided. This function would need to be fulfilled by 
the third-party application. For more information about the setBridge() method, see �Specifying an 
Bridge URL Using the setBridge() Method in the Siebel Analytics Web SOAP API� on page 158.

Accessing the Siebel Analytics Web 
SOAP Services Interface
You can access the Siebel Analytics Web SOAP services interface on any platform on which a SOAP 
client library and tools are available. The steps to access the SOAP services depend on your 
programming environment.

Example of Accessing the Siebel Analytics Web SOAP API From 
Microsoft Visual Studio
The following procedure provides the steps to access the SOAP services from Microsoft Visual Studio.

To access the SOAP services from Microsoft Visual Studio

1 Open your project in Microsoft Visual Studio.

2 In the Solution Explorer, expand the solution node, right-click References, and choose Add Web 
Reference.

The Add Web Reference dialog box appears.

3 In the URL field, type the URL to access the Siebel Analytics Web (SAW) WSDL document.

The following URL is an example URL to access the SAW WSDL document:

http://localhost/analytics/saw.dll?WSDL

4 Click Go.

The found services and methods appear in the Add Web Reference dialog box window.

5 Click the Add Reference button.

The Add Web Reference dialog box closes, and the node that represents the added Web reference 
appears in the Solution Explorer pane.
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6 To see the added classes and methods, right-click the node and choose the following option:

View in Object Browser

The classes and methods appear in the Object Browser window.

7 Begin using the classes in your program.

For a code example, see �Code Example for Writing Web Catalog Information To XML Files Using the 
Siebel Analytics Web SOAP API� on page 178.

Description of Structures in the Siebel 
Analytics Web SOAP API
This section describes the structures in the Siebel Analytics Web SOAP API. There are three kinds of 
structures:

■ Structures that are common to all services in the Siebel Analytics Web SOAP API.

■ Structures in the HtmlViewService service.

■ Structures in the WebCatalogService service.

NOTE: This document uses JavaScript-like syntax to describes structures. The exact syntax and 
implementation depends on the SOAP code generation tool and the target language used by your 
application development environment.

This section contains the following topics:

■ �Performing Operations on Columns in Results Using the Expression Structure in the Siebel Analytics 
Web SOAP API� on page 142

■ �Referencing a Report Using the ReportRef Structure in the Siebel Analytics Web SOAP API� on 
page 142

■ �Referencing a Variable in a Report Using the Variable Structure in the Siebel Analytics Web SOAP 
API� on page 143

■ �Replacing Filters and Variables in a Report Using the ReportParams Structure in the Siebel Analytics 
Web SOAP API� on page 143

■ �Defining HTML Display Options for Results Using the ReportHTMLOptions Structure in the Siebel 
Analytics Web SOAP API� on page 145

■ �Storing Web Catalog Information About an Object Using the ItemInfo Structure in the Siebel 
Analytics Web SOAP API� on page 146

■ �Denoting Named Properties Using the NameValuePair Structure in the Siebel Analytics Web SOAP 
API� on page 147

■ �Specifying Information for a Web Catalog Object Using the CatalogObject Structure in the Siebel 
Analytics Web SOAP API� on page 147
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Performing Operations on Columns in Results Using the 
Expression Structure in the Siebel Analytics Web SOAP 
API
The Expression structure performs operations on columns in results returned in XML format. The 
Expression structure holds arithmetic and logical expressions in results. Each expression operates 
on a column in the results and produces one of the standard SQL data types as the result, such as 
numeric, character string, or Boolean.

The Expression structure is common to all services in the Siebel Analytics Web SOAP API. 
Expression() is an object reference and has no members.

Referencing a Report Using the ReportRef Structure in 
the Siebel Analytics Web SOAP API
The ReportRef structure references a report, in one of the following ways:

■ The location of the report in the Web Catalog.

■ The ReportDef object that defines the report. This field should always be null.

■ The XML that defines the report.

NOTE: Only one of the fields in the ReportRef fields should be populated.

The ReportRef structure is common to all services in the Siebel Analytics Web SOAP API.

Fields in the ReportRef Structure

Field Description

String reportPath A string value that provides the path to the report in the Web 
Catalog.

ReportDef reportDef Should be set to NULL.

String reportXML A string value that contains the XML that defines the report.
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Referencing a Variable in a Report Using the Variable 
Structure in the Siebel Analytics Web SOAP API
The Variable structure references a variable in the report and replaces it with another variable.

The Variable structure is common to all services in the Siebel Analytics Web SOAP API.

Fields in the Variable Structure

Replacing Filters and Variables in a Report Using the 
ReportParams Structure in the Siebel Analytics Web 
SOAP API
The ReportParams structure replaces existing filters and variables in a report.

The ReportParams structure is common to all services in the Siebel Analytics Web SOAP API.

Fields in the ReportParams Structure

Field Description

String name A character string that contains the name of the variable to replace.

String valueXml The data type of the new variable, such as string, integer, or 
Boolean, or an Expression structure.

String value The XML representation of the new variable, encoded as a character 
string. 

NOTE: If name or valueXml is populated, this field must be null.

Field Description

Object[] filterExpressions An array of Siebel Analytics Web filter expressions or their character 
string representations, in the form Object[] filter_expression, 
filter_expression ...

Variable [] variables An array of Siebel Analytics Web variables represented as character 
strings, in the form Variable [] variable, variable ...

NameValuePair[] 
nameValues

Should be set to NULL. This field is for internal use only.

TemplateInfo[] 
templateInfos

Should be set to NULL. This field is for internal use only.
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Table 8 shows how filter expressions are applied to a report.

Table 9 shows how variables are applied to a report.

Table 8. How Filter Expressions Are Applied to a Report in the Siebel Analytics Web SOAP API

Step Internal Processing

1 Obtains XML representations of the report and each filter expression.

2 For each expression element, locates the child node of the type sqlExpression (the type 
is determined by the value of the xsi:type attribute), and references its inner text.

3 In the report XML, locates all nodes that also have a child node of type sqlExpression 
where the inner text matches that located in the preceding step.

4 Replaces all nodes found in Step 3 with the expression from Step 2.

Table 9. How Variables Are Applied to a Report in the Siebel Analytics Web SOAP API

Step Internal Processing

1 Obtains XML representations of the report.

2 For each variable, locates all nodes in the report XML that have a type of variable, 
attribute scope equal to report, and inner text that matches the variable name.

3 Replaces each node located in Step 2 with the new variable value.
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Defining HTML Display Options for Results Using the 
ReportHTMLOptions Structure in the Siebel Analytics 
Web SOAP API
The ReportHTMLOptions structure defines options for displaying results on an HTML page. 

The ReportHTMLOptions structure is used in the HtmlViewService service. For information about the 
HtmlViewService service, see �Overview of the Siebel Analytics Web HtmlViewService Service� on 
page 139.

Fields in the ReportHTMLOptions Structure

Field Description

Boolean enableDelayLoading A Boolean value, 1 (true) or 0 (false). 

When set to true, the Siebel Analytics Web server is not required to 
provide results immediately, and may display a message indicating 
that it is waiting for results.

NOTE: The value is always assumed to be true, even when set to 
false.

Using enableDelayLoading can be useful when results may take 
some time to obtain but you want to provide immediate feedback.
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Storing Web Catalog Information About an Object Using 
the ItemInfo Structure in the Siebel Analytics Web 
SOAP API
The ItemInfo structure contains Web Catalog information about an object.

The ItemInfo structure is used in the WebCatalogService service.

Fields in the ItemInfo Structure

Field Description

String path The path to the object in the Web Catalog.

String type A character string that indicates the type. Valid values are:

■ Folder

■ Link

■ Object

■ Missing

■ NoAccess

DateTime lastModified The date and time that the object was last modified, in DateTime 
format.

DateTime created The date and time that the object was created (saved) in the Web 
Catalog, in DateTime format.

DateTime accessed The data and time that the object was last accessed by a user, in 
DateTime format.

String signature The signature of the Web Catalog object. For more information 
about signatures, see �Using Item Signatures in the Siebel Analytics 
Web SOAP API� on page 138.

NameValuePair[] 
itemProperties

An array of object properties.
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Denoting Named Properties Using the NameValuePair 
Structure in the Siebel Analytics Web SOAP API
The NameValuePair structure denotes named properties such as COLOR=RED.

The NameValuePair structure is used in the WebCatalogService service.

Fields in the NameValuePair Structure

Specifying Information for a Web Catalog Object Using 
the CatalogObject Structure in the Siebel Analytics Web 
SOAP API
The CatalogObject structure retrieves or specifies all information for a particular Web Catalog object 
in a single call.

The CatalogObject structure is used in the WebCatalogService service.

Fields in the CatalogObject Structure

Field Description

String name A character string that contains the name of the property, such as 
COLOR.

String value A character string that contains the value, such as RED.

Field Description

ItemInfo itemInfo Web Catalog information about the object, supplied in the ItemInfo 
common structure.

For information about the ItemInfo structure, see �Storing Web 
Catalog Information About an Object Using the ItemInfo Structure in 
the Siebel Analytics Web SOAP API� on page 146.

Object catalogObject A character string that contains an XML representation of the 
object, or the object itself. 

When this field is the object itself, the SOAP engine you are using 
should be able to provide automatic serialization to and 
deserialization from the XML.
Siebel Analytics Web Administration Guide Version 7.7.1, Rev. B ■ 147



Working with Data and Managing the Web Catalog Using Siebel Analytics Web SOAP 
API ■  Description of Methods in the Siebel Analytics Web SOAP API
Description of Methods in the Siebel 
Analytics Web SOAP API
This section describes the methods in the Siebel Analytics Web SOAP API. Methods are described 
using JavaScript-like syntax and standard types. The exact signature of generated classes and 
methods depends on the SOAP code generation tool and the target language used by your application 
development environment.

For an overview of services and methods, see �Overview of the Siebel Analytics Web SOAP API� on 
page 133.

This section contains the following topics:

■ SawSessionService Methods

■ �Authenticating a User Using the logon() Method in the Siebel Analytics Web SOAP API� on 
page 150

■ �Logging a User Off Using the logoff() Method in the Siebel Analytics Web SOAP API� on page 150

■ �Getting the Current User Name Using the getCurUser() Method in the Siebel Analytics Web 
SOAP API� on page 151

■ �Keeping Inactive Sessions Alive Using the keepAlive() Method in the Siebel Analytics Web SOAP 
API� on page 151

■ HtmlViewService Methods

■ �Creating a New Page Object Using the startPage() Method in the Siebel Analytics Web SOAP API� 
on page 152

■ �Destroying a Page Object Using the endPage() Method in the Siebel Analytics Web SOAP API� 
on page 153

■ �Adding Results to an HTML Page Using the addReportToPage() Method in the Siebel Analytics 
Web SOAP API� on page 153

■ �Getting HTML to Include in the <HEAD> Section Using the getHeadersHTML() Method in the 
Siebel Analytics Web SOAP API� on page 155

■ �Getting HTML to Include in the <BODY> Section Using the getCommonBodyHTML() Method in 
the Siebel Analytics Web SOAP API� on page 156

■ �Getting an HTML Excerpt to Display in Results Using the getHTMLForReport() Method in the 
Siebel Analytics Web SOAP API� on page 157

■ �Specifying an Bridge URL Using the setBridge() Method in the Siebel Analytics Web SOAP API� 
on page 158

■ XmlViewService Methods

■ �Getting the Results of a Report Using the getResults() Method in the Siebel Analytics Web SOAP 
API� on page 159
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■ ReportEditingService Methods

■ �Applying Parameters to a Report Using the applyReportParams() Method in the Siebel Analytics 
Web SOAP API� on page 160

■ �Retrieving the SQL for a Report Using the generateReportSQL() Method in the Siebel Analytics 
Web SOAP API� on page 161

■ WebCatalogService Methods

■ �Copying an Object in the Web Catalog Using the copyItem() Method in the Siebel Analytics Web 
SOAP API� on page 162

■ �Creating a Folder in the Web Catalog Using the createFolder() Method in the Siebel Analytics 
Web SOAP API� on page 163

■ �Creating a Link to the Web Catalog Using the createLink() Method in the Siebel Analytics Web 
SOAP API� on page 164

■ �Deleting an Object From the Web Catalog Using the deleteItem() Method in the Siebel Analytics 
Web SOAP API� on page 165

■ �Getting Web Catalog Information for an Object Using the getItemInfo() Method in the Siebel 
Analytics Web SOAP API� on page 166

■ �Getting Child Subitems for a Web Catalog Object Using the getSubItems() Method in the Siebel 
Analytics Web SOAP API� on page 167

■ �Moving a Web Catalog Object Using the moveItem() Method in the Siebel Analytics Web SOAP 
API� on page 168

■ �Reading a Web Catalog Object Using the readObject() Method in the Siebel Analytics Web SOAP 
API� on page 169

■ �Deleting a Web Catalog Folder Using the removeFolder() Method in the Siebel Analytics Web 
SOAP API� on page 170

■ �Setting a Property for a Web Catalog Object Using the setItemProperty() Method in the Siebel 
Analytics Web SOAP API� on page 170

■ �Writing an Object to the Web Catalog Using the writeObject() Method in the Siebel Analytics 
Web SOAP API� on page 171

■ �Writing Results to the Web Catalog Using the writeReport() Method in the Siebel Analytics Web 
SOAP API� on page 172

■ �Writing a Dashboard Object to the Web Catalog Using the writeDashboard() Method in the 
Siebel Analytics Web SOAP API� on page 173

■ �Writing a Dashboard Prompt to the Web Catalog Using the writeDashboardPrompt() Method in 
the Siebel Analytics Web SOAP API� on page 174

■ �Writing a Dashboard Page to the Web Catalog Using the writeDashboardPage() Method in the 
Siebel Analytics Web SOAP API� on page 175

■ �Writing a Filter to the Web Catalog Using the writeSavedFilter() Method in the Siebel Analytics 
Web SOAP API� on page 176
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Authenticating a User Using the logon() Method in the 
Siebel Analytics Web SOAP API
The logon() method in the SAWSessionService service authenticates the user. If authentication fails, 

an exception is thrown. The logon method returns the session ID and sets an HTTP session cookie. 
The session ID is used in other SOAP API calls to identify your SOAP session.

Description of Parameters in the logon() Method
The logon() method parameters are described in the following table.

Logging a User Off Using the logoff() Method in the 
Siebel Analytics Web SOAP API
The logoff() method in the SAWSessionService service logs the user off Siebel Analytics Web. 

Description of Parameters in the logoff() Method
The logoff() method parameters are described in the following table.

Parameter Description

String username A character string that contains the user name to authenticate.

String password A character string that contains the password for the user. If there 
is no password, leave this field empty (void).

Parameter Description

String sessionID A string value that contains the session ID to log off from the SOAP 
session.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null. 
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Getting the Current User Name Using the getCurUser() 
Method in the Siebel Analytics Web SOAP API
The getCurUser() method in the SAWSessionService service gets the current user name for the 
session.

Description of Parameters in the getCurUser() Method
The getCurUser() method parameters are described in the following table.

Keeping Inactive Sessions Alive Using the keepAlive() 
Method in the Siebel Analytics Web SOAP API
The keepAlive() method in the SAWSessionService service instructs Siebel Analytics Web not to end 
particular Siebel Analytics Web user sessions due to inactivity. The effect of this call on session 
lifetime is the same as if those users performed an activity in the browser such as clicking a report, 
or invoking a SOAP call.

For more information about ending Siebel Analytics Web user sessions due to inactivity, see �Setting 
the Time to Log Users Off Siebel Analytics Web Automatically� on page 23.

Description of Parameters in the keepAlive() Method
The keepAlive() method parameters are described in the following table.

Parameter Description

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.

Parameter Description

String [] sessionID An array of character strings that contains the session IDs to 
remain logged on.
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Impersonating a User Using the impersonate() Method 
in the Siebel Analytics Web SOAP API
The impersonate() method in the SAWSessionService service logs on and impersonates the user. This 
method is useful when you need to create sessions for multiple users and have only the 
administrator�s name and password. You do not need to use the (logon) method if you use the 
impersonate() method.

This method returns the session ID and sets an HTTP session cookie. If user authentication or 
impersonation fails, an exception is thrown. 

Description of Parameters in the impersonate() Method
The impersonate() method parameters are described in the following table.

Creating a New Page Object Using the startPage() 
Method in the Siebel Analytics Web SOAP API
The startPage() method in the HtmlViewService service creates a new page object and returns its ID.

For information about the HtmlViewService service, see �Overview of the Siebel Analytics Web 
HtmlViewService Service� on page 139.

Description of Parameters in the startPage() Method
The startPage() method parameters are described in the following table.

Parameter Description

String name A character string that contains the user name to log on and 
authenticate.

String A character string that contains the password for the user. If there 
is no password for the user, leave this field empty (void).

String A character string that contains the user name to impersonate the 
authenticated user.

Parameter Description

String clientIP A character string that contains the IP address of the client running 
the browser. 

NOTE: This parameter is not used.

String sessionID A character string that contains the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Destroying a Page Object Using the endPage() Method 
in the Siebel Analytics Web SOAP API
The endPage() method in the HtmlViewService service destroys the Siebel Analytics Web server page 
object and all data associated with it.

For information about the HtmlViewService service, see �Overview of the Siebel Analytics Web 
HtmlViewService Service� on page 139.

Description of Parameters in the endPage() Method
The endPage() method parameters are described in the following table.

Adding Results to an HTML Page Using the 
addReportToPage() Method in the Siebel Analytics Web 
SOAP API
The addReportToPage() method in the HtmlViewService service adds results to an HTML page.

For information about the HtmlViewService service, see �Overview of the Siebel Analytics Web 
HtmlViewService Service� on page 139.

Description of Parameters in the addReportToPage() Method
The addReportToPage() method parameters are described in the following table.

Parameter Description

String pageID A character string that contains the name of the page.

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.

Parameter Description

String pageID A character string page ID returned by the startPage() method.

For information about the startPage () method, see �Creating a New 
Page Object Using the startPage() Method in the Siebel Analytics Web 
SOAP API� on page 152.

String reportID A character string that identifies the report containing the results to 
add to the page. It should be used to reference this report in 
subsequent SOAP calls; for example, corresponding user interface 
elements generated by the Siebel Analytics Web server would 
reference the same ID.
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ReportRef report The report definition, supplied in the ReportRef common structure.

For more information, see �Referencing a Report Using the ReportRef 
Structure in the Siebel Analytics Web SOAP API� on page 142.

ReportParams reportParams The filters or variables to apply to the report before execution, 
supplied in the ReportParams common structure. 

For more information, see �Replacing Filters and Variables in a Report 
Using the ReportParams Structure in the Siebel Analytics Web SOAP 
API� on page 143.

This parameter is optional.

ReportHTMLOptions options The display options to apply to the report after execution, supplied 
in the ReportHTMLOptions structure. 

For more information, see �Defining HTML Display Options for Results 
Using the ReportHTMLOptions Structure in the Siebel Analytics Web 
SOAP API� on page 145.

This parameter is optional.

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.

Parameter Description
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Getting HTML to Include in the <HEAD> Section Using 
the getHeadersHTML() Method in the Siebel Analytics 
Web SOAP API
The getHeadersHTML() method in the HtmlViewService service gets HTML to include in the <HEAD> 
section.

For information about the HtmlViewService service, see �Overview of the Siebel Analytics Web 
HtmlViewService Service� on page 139.

Description of Parameters in the getHeadersHTML() Method
The getHeadersHTML() method parameters are described in the following table.

Parameter Description

String pageID A character string page ID returned by the createPage() method.

For information about the startPage () method, see �Creating a New 
Page Object Using the startPage() Method in the Siebel Analytics Web 
SOAP API� on page 152.

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Getting HTML to Include in the <BODY> Section Using 
the getCommonBodyHTML() Method in the Siebel 
Analytics Web SOAP API
The getCommonBodyHTML() in the HtmlViewService service method gets HTML to include in the 
<BODY> section.

For information about the HtmlViewService service, see �Overview of the Siebel Analytics Web 
HtmlViewService Service� on page 139.

Description of Parameters in the getCommonBodyHTML() Method
The getCommonBodyHTML() method parameters are described in the following table.

Parameter Description

String pageID A character string page ID returned by the createPage() method.

For information about the startPage () method, see �Creating a New 
Page Object Using the startPage() Method in the Siebel Analytics Web 
SOAP API� on page 152

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Getting an HTML Excerpt to Display in Results Using the 
getHTMLForReport() Method in the Siebel Analytics 
Web SOAP API
The getHTMLForReport() method in the HtmlViewService service gets an HTML excerpt to display the 
results for a particular report. Before issuing this call, use the addReportToPage method to add the 
results to an HTML page. 

For more information about the addReportToPage method, see �Adding Results to an HTML Page Using 
the addReportToPage() Method in the Siebel Analytics Web SOAP API� on page 153.

For information about the HtmlViewService service, see �Overview of the Siebel Analytics Web 
HtmlViewService Service� on page 139.

Description of Parameters in the getHTMLForReport() Method
The getHTMLForReport() method parameters are described in the following table.

Parameter Description

String pageID A character string page ID returned by the createPage() method.

For information about the startPage () method, see �Creating a New 
Page Object Using the startPage() Method in the Siebel Analytics Web 
SOAP API� on page 152

String pageReportID A character string ID returned by the addReportToPage() method.

For information about the addReportToPage method, see �Adding 
Results to an HTML Page Using the addReportToPage() Method in the 
Siebel Analytics Web SOAP API� on page 153.

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Specifying an Bridge URL Using the setBridge() Method 
in the Siebel Analytics Web SOAP API
The setBridge() method in the HtmlViewService service specifies a bridge URL to receive 
communications. Specifying a bridge URL can be useful when the Siebel Analytics Web server and 
the user�s Web server reside on different machines, or when you want to modify the results in your 
application development environment.

After the setBridge() method is called, all requests from the client browser to the Siebel Analytics 
Web server are sent to the bridge URL, which then forwards requests to the Siebel Analytics Web 
server.

For information about the HtmlViewService service, see �Overview of the Siebel Analytics Web 
HtmlViewService Service� on page 139.

Description of Parameters in the setBridge () Method
The setBridge() method parameters are described in the following table.

Usage Notes for the setBridge () Method
It is your responsibility to make sure that the client browser provides a handler to the bridge URL in 
the form of a Java servlet, an Active Server Pages (ASP) page, a Common Gateway Interface (CGI), 
an Internet Server application programming interface (ISAPI), or an equivalent application.

You must also perform the following tasks:

■ Decode the path of the requested Siebel Analytics Web resource in the RedirectURL parameter 
of the request character string. For information about the RedirectURL parameter, see �How 
Callback URLs Are Replaced Using the Setbridge () Method� on page 158.

■ Forward all other request parameters, together with all headers and the request body, to the 
bridge URL. 

■ Copy the response from the Siebel Analytics Web server to the response stream.

How Callback URLs Are Replaced Using the Setbridge () Method
The new callback URL is based on the bridge URL, with the addition of a RedirectURL parameter. The 
value of the RedirectURL parameter should be the original value of the URL, encoded using standard 
URL encoding rules.

Parameter Description

String bridgeURL The bridge URL.

String sessionID A character string that contains the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Internally, Siebel Analytics Web usually uses relative URLs for callback links. For example, if the 
original callback link is saw.dll?Go and the bridge URL is http://myserver/myapplication/sawbridge, 
the new callback URL is http://myserver/myapplication/sawbridge?RedirectURL=saw.dll%3fGo.

Getting the Results of a Report Using the getResults() 
Method in the Siebel Analytics Web SOAP API
The getResults method in the XmlViewService service returns the report results, in XML format.

Description of Parameters in the getResults Method()
The getResults() method parameters are described in the following table.

Parameter Description

ReportRef report The report definition, supplied in the ReportRef common structure. 

For more information, see �Referencing a Report Using the ReportRef 
Structure in the Siebel Analytics Web SOAP API� on page 142.

String outputFormat A character string that identifies the output format of the returned 
report object. Valid values are:

■ �urn: SAWRowset/data�

This value returns rows without metadata.

■ �urn: SAWRowset/schema�

This value returns metadata only.

■ �urn: SAWRowset/both� 

This value returns both rows and metadata.

Boolean encodeInString A Boolean value, 1 (true) or 0 (false). When set to true (the usual 
value), it indicates that the returned report object is encoded as a 
character string. 

ReportParams reportParams The filters or variables to apply to the report before execution, 
supplied in the ReportParams common structure. For information 
about the ReportParams structure, see �Replacing Filters and 
Variables in a Report Using the ReportParams Structure in the Siebel 
Analytics Web SOAP API� on page 143.

This parameter is optional.

String sessionID A character string that contains the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Applying Parameters to a Report Using the 
applyReportParams() Method in the Siebel Analytics 
Web SOAP API
The applyReportParams() method in the ReportEditingService service applies report parameters to 
the report and returns the results.

Description of Parameters in the applyReportParams Method()
The applyReportParams() method parameters are described in the following table.

Parameter Description

ReportRef object The path to the report definition, supplied in the ReportRef common 
structure. For information about the ReportRef structure, see 
�Referencing a Report Using the ReportRef Structure in the Siebel 
Analytics Web SOAP API� on page 142.

ReportParams reportParams The filters or variables to apply to the report before execution, 
supplied in the ReportParams common structure. For more 
information, see �Replacing Filters and Variables in a Report Using the 
ReportParams Structure in the Siebel Analytics Web SOAP API� on 
page 143.

This parameter is optional.

Boolean encodeInString A Boolean value, 1 (true) or 0 (false). 

When set to true, it indicates that the returned report object is 
encoded as a character string.

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Retrieving the SQL for a Report Using the 
generateReportSQL() Method in the Siebel Analytics 
Web SOAP API
The generateReportSQL() method in the ReportEditingService service retrieves the logical SQL query 
for a given report.

Description of Parameters in the generateReportSQL Method()
The generateReportSQL() method parameters are described in the following table.

Parameter Description

ReportRef reportRef The path to the report definition supplied in the ReportRef common 
structure. For more information, see �Referencing a Report Using the 
ReportRef Structure in the Siebel Analytics Web SOAP API� on 
page 142.

ReportParams reportParams The path to the filters or variables to apply to the report before 
execution, supplied in the ReportParams common structure. For 
more information, see �Replacing Filters and Variables in a Report 
Using the ReportParams Structure in the Siebel Analytics Web SOAP 
API� on page 143.

This parameter is optional.

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Copying an Object in the Web Catalog Using the 
copyItem() Method in the Siebel Analytics Web SOAP 
API
The copyItem() method in the WebCatalogService service copies an object from one location in the 
Web Catalog to another location in the Web Catalog.

Description of Parameters in the copyItem() Method
The copyItem() method parameters are described in the following table.

Parameter Description

String pathSrc The current path to the object in the Web Catalog.

String pathDest The location in the Web Catalog where the object should be copied.

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
Siebel Analytics Web Administration Guide Version 7.7.1, Rev. B162 ■



Working with Data and Managing the Web Catalog Using Siebel Analytics Web SOAP
API ■  Description of Methods in the Siebel Analytics Web SOAP API
Creating a Folder in the Web Catalog Using the 
createFolder() Method in the Siebel Analytics Web SOAP 
API
The createFolder() method in the WebCatalogService service creates a new folder in the Web 
Catalog.

Description of Parameters in the createFolder() Method
The createFolder() method parameters are described in the following table.

Parameter Description

String path The location in the Web Catalog where the folder should be created, 
including the name of the new folder.

Boolean createIfNotExists A Boolean value, 1 (true) or 0 (false). 

When set to true, the folder object is created in the Web Catalog if 
it does not already exist. 

When set to false, the folder object is not recreated if it already 
exists. 

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Creating a Link to the Web Catalog Using the 
createLink() Method in the Siebel Analytics Web SOAP 
API
The createLink() method in the WebCatalogService service creates a link to the Web Catalog.

Description of Parameters in the createLink() Method
The createLink() method parameters are described in the following table.

Parameter Description

String sPath The path to the parent object in the Web Catalog.

String sTargetPath The location in the Web Catalog to which the link being created 
should refer.

Boolean overwriteIfExists A Boolean value, 1 (true) or 0 (false). 

When set to true, the link is overwritten if it already exists in the 
Web Catalog. 

When set to false, the link is not overwritten if it already exists in 
the Web Catalog.

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Deleting an Object From the Web Catalog Using the 
deleteItem() Method in the Siebel Analytics Web SOAP 
API
The deleteItem() method in the WebCatalogService service deletes an object from the Web Catalog.

To delete a folder, see �Deleting a Web Catalog Folder Using the removeFolder() Method in the Siebel 
Analytics Web SOAP API� on page 170.

Description of Parameters in the deleteItem() Method
The deleteItem() method parameters are described in the following table.

Parameter Description

String path The path to the object in the Web Catalog.

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Getting Web Catalog Information for an Object Using 
the getItemInfo() Method in the Siebel Analytics Web 
SOAP API
The getItemInfo() method in the WebCatalogService service gets Web Catalog information for an 
object. 

Description of Parameters in the getItemInfo() Method
The getItemInfo() method parameters are described in the following table. 

Parameter Description

String path The path to the object in the Web Catalog.

Boolean resolveLinks A Boolean value, 1 (true) or 0 (false). 

When set to true, and the path in the Web Catalog refers to a link, 
information is retrieved for the object pointed to by the link.

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Getting Child Subitems for a Web Catalog Object Using 
the getSubItems() Method in the Siebel Analytics Web 
SOAP API
The getSubItems() method in the WebCatalogService service gets the collection of child subitems for 
an object in the Web Catalog.

Description of Parameters in the getSubItems() Method
The getSubItems() method parameters are described in the following table.

Parameter Description

String path The path to the parent object in the Web Catalog.

String mask The mask that indicates the child subitems to retrieve. The mask 
character must be an asterisk (*). 

If you specify a single asterisk, all child subitems are retrieved.

Boolean resolveLinks A Boolean value, 1 (true) or 0 (false). 

When set to true, and the path in the Web Catalog refers to a link, 
information is retrieved for the child subitems of the object pointed 
to by the link.

NameValuePair[] 
itemInfoFilters

This parameter is for internal use only and should be set to 
NULL.gftb

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Moving a Web Catalog Object Using the moveItem() 
Method in the Siebel Analytics Web SOAP API
The moveItem() method in the WebCatalogService service moves an object in the Web Catalog to a 
different location in the Web Catalog.

Description of Parameters in the moveItem() Method
The moveItem() method parameters are described in the following table.

Parameter Description

String pathSrc The current path to the object in the Web Catalog.

String pathDest The location in the Web Catalog where the object should be moved.

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Reading a Web Catalog Object Using the readObject() 
Method in the Siebel Analytics Web SOAP API
The readObject() method in the WebCatalogService service reads an object from the Web Catalog 
and returns CatalogObject structure. 

For a description of the CatalogObject structure, see �Specifying Information for a Web Catalog Object 
Using the CatalogObject Structure in the Siebel Analytics Web SOAP API� on page 147

Description of Parameters in the readObject() Method
The readObject() method parameters are described in the following table.

Parameter Description

String path The location where the retrieved object should be placed.

Boolean returnXmlString A Boolean value, 1 (true) or 0 (false). 

When set to true, the catalogObject field returned in the 
CatalogObject structure is a character string that contains the XML 
representation of the object stored in the Web Catalog.

When set to false, the SOAP client needs to analyze the xsi:type 
attribute of the root node of the returned XML to determine the type 
of object to create. If the xsi:type attribute is unknown, an 
exception may be thrown depending on the SOAP client�s 
implementation.

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Deleting a Web Catalog Folder Using the 
removeFolder() Method in the Siebel Analytics Web 
SOAP API
The removeFolder() method in the WebCatalogService service deletes a folder and its contents from 
the Web Catalog.

To delete an object other than a folder and its contents, see �Deleting an Object From the Web Catalog 
Using the deleteItem() Method in the Siebel Analytics Web SOAP API� on page 165.

Description of Parameters in the removeFolder() Method
The removeFolder() method parameters are described in the following table.

Setting a Property for a Web Catalog Object Using the 
setItemProperty() Method in the Siebel Analytics Web 
SOAP API
The setItemProperty() method in the WebCatalogService service sets a property for an object in the 
Web Catalog.

Description of Parameters in the setItemProperty() Method
The setItemProperty() method parameters are described in the following table.

Parameter Description

String path The path to the folder in the Web Catalog.

String sessionID A character string that identifies the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.

Parameter Description

String path The path to the object in the Web Catalog.

String name A character string that contains the name of the property to set.

String value A character string that contains the new setting for the property.

String sessionID A character string that contains the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Writing an Object to the Web Catalog Using the 
writeObject() Method in the Siebel Analytics Web SOAP 
API
The writeObject() method in the WebCatalogService service writes an object to the Web Catalog in 
XML format.

Description of Parameters in the writeObject() Method
The writeObject() method parameters are described in the following table.

Parameter Description

CatalogObject object The object to write to the Web Catalog, supplied in the 
CatalogObject structure. For information about the CatalogObject 
structure, see �Specifying Information for a Web Catalog Object Using 
the CatalogObject Structure in the Siebel Analytics Web SOAP API� on 
page 147.

All fields of object.itemInfo are ignored, except for the array of item 
properties, which are applied to the object. The signature of the 
resulting document is always COXmlDocument1.

String path The location in the Web Catalog where the object should be written. 

Boolean resolveLinks A Boolean value, 1 (true) or 0 (false). 

When set to true, and the path in the Web Catalog refers to a link, 
the object is written to the location pointed to by the link.

Boolean allowOverwrite A Boolean value, 1 (true) or 0 (false).

When set to true, if the object already exists in the Web Catalog, it 
will be overwritten.

When set to false, if the object already exists in the Web Catalog, 
it will not be overwritten.

String sessionID A character string that contains the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Writing Results to the Web Catalog Using the 
writeReport() Method in the Siebel Analytics Web SOAP 
API
The writeReport() method in the WebCatalogService service writes a set of results to the Web 
Catalog.

Description of Parameters in the writeReport() Method
The writeReport() method parameters are described in the following table.

Parameter Description

CatalogObject object The object to write to the Web Catalog, supplied in the 
CatalogObject structure. For information about the CatalogObject 
structure, see �Specifying Information for a Web Catalog Object Using 
the CatalogObject Structure in the Siebel Analytics Web SOAP API� on 
page 147.

All fields of object.itemInfo are ignored, except for the array of item 
properties, which are applied to the object. The signature of the 
resulting document is always queryitem1.

String path The location in the Web Catalog where the results should be written. 

Boolean resolveLinks A Boolean value, 1 (true) or 0 (false). 

When set to true, and the path in the Web Catalog refers to a link, 
the results are written to the location pointed to by the link.

Boolean allowOverwrite A Boolean value, 1 (true) or 0 (false).

When set to true, if the results already exist in the Web Catalog, 
they will be overwritten.

When set to false, if the results already exist in the Web Catalog, 
they will not be overwritten.

String sessionID A character string that contains the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Writing a Dashboard Object to the Web Catalog Using 
the writeDashboard() Method in the Siebel Analytics 
Web SOAP API
The writeDashboard() method in the WebCatalogService service writes a dashboard object to the 
Web Catalog.

Description of Parameters in the writeDashboard() Method
The writeDashboard() method parameters are described in the following table.

Parameter Description

CatalogObject object The dashboard object to write to the Web Catalog, supplied in the 
CatalogObject structure. For information about the CatalogObject 
structure, see �Specifying Information for a Web Catalog Object Using 
the CatalogObject Structure in the Siebel Analytics Web SOAP API� on 
page 147.

All fields of object.itemInfo are ignored, except for the array of item 
properties, which are applied to the object. The signature of the 
resulting document is always dashboarditem1.

String path The location in the Web Catalog where the dashboard object should 
be written. 

Boolean resolveLinks A Boolean value, 1 (true) or 0 (false). 

When set to true, and the path in the Web Catalog refers to a link, 
the dashboard object is written to the location pointed to by the 
link.

Boolean allowOverwrite A Boolean value, 1 (true) or 0 (false).

When set to true, if the dashboard object already exists in the Web 
Catalog, it will be overwritten.

When set to false, if the dashboard object already exists in the Web 
Catalog, it will not be overwritten.

String sessionID A character string that contains the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Writing a Dashboard Prompt to the Web Catalog Using 
the writeDashboardPrompt() Method in the Siebel 
Analytics Web SOAP API
The writeDashboardPrompt() method in the WebCatalogService service writes a dashboard prompt 
to the Web Catalog.

Description of Parameters in the writeDashboardPrompt() Method
The writeDashboardPrompt() method parameters are described in the following table.

Parameter Description

CatalogObject object The dashboard prompt object to write to the Web Catalog, supplied 
in the CatalogObject structure. For information about the 
CatalogObject structure, see �Specifying Information for a Web 
Catalog Object Using the CatalogObject Structure in the Siebel 
Analytics Web SOAP API� on page 147.

All fields of object.itemInfo are ignored, except for the array of item 
properties, which are applied to the object. The signature of the 
resulting document is always globalfilteritem1.

String path The location in the Web Catalog where the dashboard prompt 
should be written. 

Boolean resolveLinks A Boolean value, 1 (true) or 0 (false). 

When set to true, and the path in the Web Catalog refers to a link, 
the dashboard prompt is written to the location pointed to by the 
link.

Boolean allowOverwrite A Boolean value, 1 (true) or 0 (false).

When set to true, if the dashboard prompt already exists in the Web 
Catalog, it will be overwritten.

When set to false, if the dashboard prompt already exists in the 
Web Catalog, it will not be overwritten.

String sessionID A character string that contains the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Writing a Dashboard Page to the Web Catalog Using the 
writeDashboardPage() Method in the Siebel Analytics 
Web SOAP API
The writeDashboardPage() method in the WebCatalogService service writes a dashboard page to the 
Web Catalog.

Description of Parameters in the writeDashboardPage() Method
The writeDashboardPage() method parameters are described in the following table.

Parameter Description

CatalogObject object The dashboard page object to write to the Web Catalog, supplied in 
the CatalogObject structure. For information about the 
CatalogObject structure, see �Specifying Information for a Web 
Catalog Object Using the CatalogObject Structure in the Siebel 
Analytics Web SOAP API� on page 147.

All fields of object.itemInfo are ignored, except for the array of item 
properties, which are applied to the object. The signature of the 
resulting document is always dashboardpageitem1.

String path The location in the Web Catalog where the dashboard page should 
be written. 

Boolean resolveLinks A Boolean value, 1 (true) or 0 (false). 

When set to true, and the path in the Web Catalog refers to a link, 
the dashboard page is written to the location pointed to by the link.

Boolean allowOverwrite A Boolean value, 1 (true) or 0 (false).

When set to true, if the dashboard page already exists in the Web 
Catalog, it will be overwritten.

When set to false, if the dashboard page already exists in the Web 
Catalog, it will not be overwritten.

String sessionID A character string that contains the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Writing a Filter to the Web Catalog Using the 
writeSavedFilter() Method in the Siebel Analytics Web 
SOAP API
The writeSavedFilter() method in the WebCatalogService service writes a filter to the Web Catalog.

Description of Parameters in the writeSavedFilter() Method
The writeSavedFilter() method parameters are described in the following table.

Parameter Description

CatalogObject object The filter object to write to the Web Catalog, supplied in the 
CatalogObject structure. For information about the CatalogObject 
structure, see �Specifying Information for a Web Catalog Object Using 
the CatalogObject Structure in the Siebel Analytics Web SOAP API� on 
page 147.

All fields of object.itemInfo are ignored, except for the array of item 
properties, which are applied to the object. The signature of the 
resulting document is always savedfilteritem1.

String path The location in the Web Catalog where the filter should be written. 

Boolean resolveLinks A Boolean value, 1 (true) or 0 (false). 

When set to true, and the path in the Web Catalog refers to a link, 
the filter is written to the location pointed to by the link.

Boolean allowOverwrite A Boolean value, 1 (true) or 0 (false).

When set to true, if the filter already exists in the Web Catalog, it 
will be overwritten.

When set to false, if the filter already exists in the Web Catalog, it 
will not be overwritten.

String sessionID A character string that contains the session ID.

The session ID is usually returned by the logon call. If the SOAP 
client engine can handle HTTP cookies, you can omit the session ID 
or set it to null.
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Format of Returned Recordsets in the 
Siebel Analytics Web SOAP API
The following is the basic structure for Siebel Analytics Web rowset XML output:

<Recordset xmls="Siebel Analytics NS" >

<xsd::schema xsd = ...>
.
.
.

<xsd::schema>

<row>

<column1>value1</column1>

<column2>value2</column2>

</row>

<row>...</row>

<row>...</row>

</Recordset>

Each row element holds the contents of one SQL record. Child elements of the row contain values of 
record fields. 

The recordset XML may optionally include XSD schema that describe the format of row elements.
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Code Example for Writing Web Catalog 
Information To XML Files Using the 
Siebel Analytics Web SOAP API
This section provides an example of C# code that uses the Siebel Analytics Web SOAP API. The code 
extracts Web Catalog information and writes it to XML files. 

NOTE: Some code that appears on a single line in an application development environment may 
appear on more than one line when the code is printed or viewed online because of page or window 
size limitations.

using System;
using System.IO;
using System.Web;

using CatalogExport.SAWServices;

namespace CatalogExport
{

/// <summary>
/// Summary description for Class1.
/// </summary>
class CatalogExport
{

static private System.Net.CookieContainer cookies = new 
System.Net.CookieContainer ();

static private SAWSessionService m_session = new SAWSessionService ();
static private WebCatalogService m_WebCatalogService = new WebCatalogService();
static int m_nCurFileIndex=0;
static StreamWriter m_curFile = null;
static int m_nFileMaxlen=1024*1024*5;
static String m_strExportDir=null;
static String m_strFilePrefix="catalog";

static void openFile()
{

if (m_curFile== null || m_curFile.BaseStream.Length > m_nFileMaxlen)
{

if (m_curFile != null )
{

m_curFile.WriteLine("</CatalogRoot>");
m_curFile.Close();

}
String strNewPath = m_strExportDir + "\\" + m_strFilePrefix + 

(++m_nCurFileIndex) + ".xml";
m_curFile = new StreamWriter(strNewPath);
m_curFile.WriteLine("<CatalogRoot>");

}
}
/// <summary>
/// The main entry point for the application.
/// </summary>
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[STAThread]
static void Main(string[] args)
{

String strURL="http://localhost/analytics/saw.dll";
String strUser="Administrator";

String strPWD="";

for (int i=0;i<args.Length;++i)
{

if (args[i].Equals("/URL"))
strURL = args[++i];

else if (args[i].Equals("/USER"))
strUser =  args[++i];

else if (args[i].Equals("/PWD"))
strPWD =  args[++i];

else if (args[i].Equals("/DIR"))
m_strExportDir =  args[++i];

else if (args[i].Equals("/?"))
{

printUsage();
return;

}
}

if (m_strExportDir == null)
{

printUsage();
return;

}
Directory.CreateDirectory(m_strExportDir);
//let all services  use the same cookie container - so all of them
//would have access to Session cookie
m_WebCatalogService.CookieContainer  = cookies;
m_session.CookieContainer  = cookies;
m_session.Url = strURL + "?SoapImpl=nQSessionService";
m_WebCatalogService.Url = strURL + "?SoapImpl=webCatalogService";
String sessionID = m_session.logon(strUser,strPWD);
try
{

processCatalogFolder("/",sessionID);
}
finally
{

if (m_curFile != null )
{

m_curFile.WriteLine("</CatalogRoot>");
m_curFile.Close();

}
}

}

static void processCatalogFolder(string path,string sessionID)
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{
ItemInfo[] arrChilds = 

m_WebCatalogService.getSubItems(path,"*",false,null,sessionID);
foreach (ItemInfo info in arrChilds)
{

switch (info.type)
{

case ItemInfoType.Folder:
try
{

processCatalogFolder(info.path,sessionID);
}
catch (Exception e)
{

Console.WriteLine(e.Message);
}

continue;
case ItemInfoType.Object:
{

if (!isKnownSignature(info.signature))
continue;

openFile();
CatalogObject co = 

m_WebCatalogService.readObject(info.path,true,sessionID);
m_curFile.WriteLine("<CatalogObj path=\"" + 

HttpUtility.HtmlEncode(info.path) + "\" signature=\"" + info.signature +"\">");
m_curFile.WriteLine(co.catalogObject.ToString());
m_curFile.WriteLine("</CatalogObj>");
break;

}
}

}

}

static bool isKnownSignature(string strSignature)
{

return strSignature=="dashboardpageitem1" ||
strSignature=="dashboarditem1" ||
strSignature=="queryitem1"  ||
strSignature=="dashboarditem1"  ||

strSignature=="globalfilteritem1"  ||
strSignature=="filteritem1" ||
strSignature=="COXmlDocument1";

}
static void printUsage()
{

Console.WriteLine("CatalogExport /DIR exportdir [/USER usename] [/PWD 
password] [/URL serverurl]");

}
}

}
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